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1.1 INTRODUCTION 

A computer is an automatic, electronic, data-processing machine that takes in facts and figures 
known as data, and then processes or organizes it in some useful way. Afterwards it outputs, or 
displays, the results for you to see as information. Keep in mind that data is not information. 
Rather, information is the knowledge that you, the end-user, derive from accurate data that are 
entered into a computer. Only after processing, is data transformed into information which is 
then used for decision making. (Almost) each part of a computer can be classified as either 
hardware or software.  
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Technology influences different areas of society and business, whether it is a particular age 
group or gender, or the entire population. We may be resistant to its influences, whether in the 
long or short term, until we are more aware on how this change impacts our lives, families, 
work, entertainment, or daily living.  

 
The chapter also discussed about the Property Management System. The PMS front office 
application is discussed in detail along with the PMS interfaces with the stand alone 
automated systems like Point of sales, energy management system, call accounting system 
and electronic locking system. 
 

1.2 OBJECTIVES 

After reading this unit, learner will be able to:  

• Describe the major developments in each generation of computer development.  

• Evaluate the need for different types of computer systems.  

• Distinguish between different hardware components of a computer.  

• Explain the functions/uses of the different components.  

• Distinguish between a computer and a computer system.  

• Explain the term general computer system.  

• Explain the term embedded system.  

• Show diagrammatically the components of a computer system.  

• Describe a central processing unit (CPU).  

• Explain arithmetic and logic unit (ALU).  

• Define primary memory and how it functions.  

• Property Management System  

• PMS application in Front Office  

• Back office applications  

• PMS interfaces  

1.3 TYPES OF COMPUTER SYSTEMS  

In the past computers were classified as microcomputers, minicomputers, or main‐frame 

computers, based on their size. Today these distinctions are rapidly disappearing as the 
capabilities of even the smallest units rival that of their earlier big brothers. Today‘s 
microcomputers are faster, more powerful and more versatile than the minicomputers and the 

main‐frame computers were a few years ago. Table below describes the terms used to classify 

today‘s of computers and computing devices. 
 

Type of 

Computer 

System 
 

Brief Description 
 

Desktop 
Computer  
 

A PC that is expected to be placed on the top of a computer or other 
desk. Desktops usually are powerful and have reasonably large 
secondary storage. Desktops require a number of input and out 
devices to make them useful.  
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Laptop  
 

Compared to the desktop, laptops are portable computers that have 
their monitor, keyboard, and other memory and storage devices all 
included in a packages that is up 17 inches in size and is powered 
by a special battery. Laptops are also called notebooks.  
 

Mainframe  
 

Mainly associated with large companies, that process millions of 
transactions calculations from multiple sources at one time, 
mainframes previously filled large rooms, but today consist of a 
number of linked components that allow the different processors to 
communicate with one another and share their total computing 
power.  
 

Minicomputer  
 

Minicomputers are powerful and can support many users at once. 
Their size is between microcomputers (PCs) and mainframes.  
 

Palmtop  
 

More commonly called Personal Digital Assistants (PDAs). They 
are compact computers that often use special secondary flash 
memory instead of a typical hard drive for storage. Palmtops 
usually have optional keyboards but mainly use touch screens for 
input. They are typically the size of a paperback novel or even 
smaller and are very lightweight and use battery power.  
 

Personal 
Computer  
 

Personal Computers (PC) was designed to be used by individuals 
for general use. The PC is not usually associated with the Apple 
Mac although it is a PC. Often the term desktop and PC are used 
interchangeably  
 

Server  
 

A computer that has been optimized to provide services to other 
computers over a network. Servers usually have powerful 
processors, lots of memory and large hard drives. They often 

provide custom services such as an e‐mail server, a backup server, a 
database server, etc.  
 

Supercomputer  
 

Supercomputers have the world‘s fastest processors and are able to 
perform millions of computations a minute. Supercomputers are 
normally comprised of multiple high performance computers 
working in parallel as a single system. The best known 
supercomputers are built by Cray Supercomputers.  
 
 

Wearable 
Computer  
 

This is the latest trend in computing where common computer 
applications such as electronic mail, are integrated into watches, 
cell phones, visors and even clothing.  
 

Workstation  
 

A workstation is a desktop computer with a more powerful  
processor, and more memory for performing a special functions, 
such as 3D Graphics  
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1.4 GENERATIONS OF COMPUTERS 

Today many jobs mainly depend on the either the creation or collection, and distribution of 
information. This topic addresses the different advancements in computer technology and the 
various types of computers and their critical components. As each new computer generation 
improves on its previous generation, there have been a corresponding reduction in size (or 
miniaturization) of computer circuitry. In contrast to this miniaturization, the speed, power, 
and memory of computers have proportionally increased. Although this Topic will describe the 
major developments of each computer generation, it is more important to consider how the 
technology has influenced the development of current computer systems. 

 

1.4.1 The First Generation Computer (1940S‐1950S)  

These early computers comprised huge vacuum tubes (similar to light bulbs) whose main 
purpose was to strengthen weak signals for transmission. The vacuum tubes acted as switches 
to start and stop the instant flow of electricity. The concept underlying the on/off switch was 
the idea of ones and zeros. The combination of ones and zeros or on and off created a type of 
machine language that could be used to process information.  
 
The first computer, the Mark 1, was so huge that it filled a typical stadium field and was said to 
have used more than 500 miles of wire. Its success however was its processing power, such as 
a mathematical problem that normally took 40 hours to solve, only took the Mark 1, 20 
seconds to produce a result. It was used by the U.S. Navy during World War II, to help solve 
strategic military mathematical problems such as cracking secret codes and creating complex 
fire tables for naval guns and artillery. Scientists used the computer to predict weather patterns 
and for analyzing problems in airplane design. As noted earlier the language of this first 
generation was called machine language, which comprised zeros and ones for programming 
the computer.  
 
The next computer, the ENIAC (Electronic Numerical Integrator and Computer) was an 
improvement on the Mark 1, since its processing power was about 1,000 times faster. The 
ENIAC was about 80 feet (24.4 m) long by 3 feet (0.9 m) wide, and used about 18,000 vacuum 
tubes. Unfortunately, the tubes were very hot, had to be replaced frequently, and were costly in 
using much electricity to keep them cool. The UNIVAC (Universal Automatic Computer) soon 
replaced the ENIAC by containing a compact 5000 tubes, a reduction from the 18,000 used in 
the ENIAC.  
 

1.4.2  The Second Generation Computer (Mid 1950s – early 1960s)  

During this generation the significantly smaller transistors (a new technology) eventually 
replaced vacuum tubes as the processing component of the computer. This allowed engineers 
todramatically reduce the size and space needed to house a computer. Transistors proved to be 
cheaper to produce and emitted no heat, thus reducing the costs of manufacturing and making 
the technology more reliable since they conducted electricity faster vacuum tubes and failed 
less often.  
 
This generation was noted for making space travel possible, and for the development of more 
sophisticated programming languages that allowed programmers to use short specific terms 
(e.g. ADD) to represent certain computer processing instructions. Higher level programming 
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languages such as FORTRAN, ALGOL and COBOL, which use short English‐like words, 

were developed during this generation. During this generation computer hardware and 
software was created that allowed users to store and retrieve programming instructions.  
 

1.4.3 The Third Generation Computer (Early 1960s – Early 1970s)  

This generation improved on the previous one by miniaturizing the transistor and building 
several onto a single chip of silicon. This compacting of millions of transistors in a small 
space, also called an integrated circuit, greatly increased the power of computer, the processing 
speed, lowered its production costs even more and reduced the size of the computer.  
 
During this generation the creation of new input and output devices were created. Keyboards, 
monitors, and the mouse made the computer a more user friendly environment and eliminated 
the need for huge stacks of punch cards to input data into a main frame computer. Output of 
the computer calculations could be read on screen vice printing out large amounts of paper 
with graphic symbols on them  
 

1.4.4 The Fourth Generation Computer (Early 1970s – Mid 1980s)  

Again an improvement on the previous generation, this generation continued to reduce the size 
of the silicon chip comparable to the size of a pencil eraser while vastly increasing 
itscomputational speeds. This single chip with the components and processing speeds of a 

computer was called a micro‐processor and was initially intended for use in calculators, not 

computers.  
 
During this generation the silicon chip technology was harnessed by the chip manufacturer 
Intel. Intel in partnership with IBM created the first microcomputer, or personal computer. A 
few years later Apple in partnership with Motorola introduced the Macintosh to compete 
against the IBM personal computer. Only recently has Apple recognized the need for 
standardization and has embraced the Pentium technologies currently supported by Intel. 
During this periods new and more powerful programming languages developed. This included 
Pascal, C and compilers which converted the program to a lower level language that the 
machine could process. The UNIX operating system was also developed during this time to 
manage system resources.  
 

1.4.5 The Fifth Computer Generation Computer (Mid 1980s – Early 1990s)  

The goal of this generation is to develop devices that are capable of responding sensibly to a 

user‘s natural language and also capable of learning and self‐organization. It is characterized 

by the introduction of computers with hundreds of processors that could be assigned to work 
on different sections of a single program. This is called parallel processing, and is being used 
to develop communication between a computer in natural spoken language and its user, 
through access to a vast knowledge database to make intelligent inferences and draw logical 
conclusions in the way that humans do.  
 
Several programming languages known as artificial intelligence (AI) languages have been 
developed simply because they are used almost exclusively for AI applications. The two most 
commonly used languages are LISP and Prolog. The linking of computers together, called 
computer networks, and the increasing use of workstations were also developed during this 
generation. 
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1.4.6 The Sixth Generation (Mid 1990s to Present)  

This era refers to the generation of computer and video games which became popular around 
1998. The Nintendo Game Cube, Sony PlayStation 2, and Microsoft's Xbox are noted to have 
dominated game playing in all age groups.  

 
Figure 1: General Timelines of Generations of Computer 

 

 

CHECK YOUR PROGRESS-I 

 
1. What are the different types of computers? Describe mainframe computer. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
 

2. Write a note on ‘Generations of Computer’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
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1.5 COMPUTER HARDWARE AND PERIPHERALS  

The computer hardware and peripherals devices are studied under following heads: 
Input Devices 
Output Devices 
Process and Storage Devices 
Storage Devices 
 

1.5.1 Input Devices  

You use input devices to provide information to a computer, such as typing a letter or giving 
instructions to a computer to perform a task. Some examples of input devices are described in 
the following list.  

• Mouse: A device that you use to interact with items displayed on the computer screen. 
A standard mouse has a left and a right button.  

• Trackball: This is an alternative to the traditional mouse and is favoured by graphic 
designers. It gives a much finer control over the movement of items on the screen. 
Other screen pointing devices are pointing stick, touch pad, joystick, light pen, 
digitizing table.  

• Keyboard: A set of keys that resembles a typewriter keyboard. You use the keyboard 
to type text, such as letters or numbers into the computer.  

• Scanner: A device that is similar to a photocopy machine. You can use this device to 
transfer an exact copy of a photograph or document into a computer. A scanner reads 
the page and translates it into a digital format, which a computer can read. For 
example, you can scan photographs of your family using a scanner.  
 

• Barcode Readers: When used in a business barcodes provide a lot of information. 
Made up of columns of thick and thin lines, at the bottom of which a string of numbers 
is printed.  

• Multimedia Devices:This is the combination of sound and images with text and 
graphics. To capture sound and image data, special input devices are required.  

o Microphone: Voice input, for instance, can be recorded via a microphone. A 
device that you can use to talk to people in different parts of the world. You 
can record sound into the computer by using a microphone. You can also use a 
microphone to record your speech and let the computer convert it into text.  

o Webcam: A device that is similar to a video camera. It allows you to capture 
and send the live pictures to the other user. For example, a webcam allows your 
friends and family to see you when communicating with them.  

o Digital Cameras: record photographs in the form of digital data that can be 
stored on a computer. These are often used to record photographs on identity 
cards.  
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Figure 3 Impact Printer 

 

1.5.2 Output Devices  

Output devices in the computer system 
are the equipment whereby the result 
of a computer operation can be 
viewed, heard or printed. You use 
output devices to get feedback from a 
computer after it performs a task.  

 

Monitor: A device that is similar to a 
television. It is used to display 
information, such as text and graphics, 
on the computer.  

 
Printer: A device that you use to 

 

 

B. Non-Impact Printers: Inkjet printers work by shooting a jet of ink in the shape of the 

character required, they provide good, low

 

 

 

 

 

 

 

 

Figure 4 Non
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Figure 2 Monitor 

 

Output devices in the computer system 
are the equipment whereby the result 
of a computer operation can be 
viewed, heard or printed. You use 
output devices to get feedback from a 

device that is similar to a 
television. It is used to display 
information, such as text and graphics, 

A device that you use to 

transfer text and images from a computer 
to a paper or to another medium, such as 
a transparency film. You can use a 
printer to create a paper copy of 
whatever you see on your monitor. 
 
A. Impact Printers:Dot matrix printers 
are an example of impact printers. They 
form characters from patterns of dots. 
They are inexpensive, but the output can 
be difficult to read. 

 

 

Inkjet printers work by shooting a jet of ink in the shape of the 

character required, they provide good, low‐cost colour printing.  

Figure 4 Non-Impact Printer 
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C. Laser Printer: a laser beam is directed a
template of the page to be printed. This template is then used to transfer the ink to the page. 
Toner sticks to the light images and is transferred to paper. 

 

3. Plotter: A plotter is an output device similar to a printer, but normally allows you to print 
larger images. It is used for printing house plans and maps. 
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a laser beam is directed at an electro‐statically charged surface, creating a 
template of the page to be printed. This template is then used to transfer the ink to the page. 
Toner sticks to the light images and is transferred to paper.  

Figure 5: Laser Printer 
ter is an output device similar to a printer, but normally allows you to print 

larger images. It is used for printing house plans and maps.  

 

Figure 6: Plotter 
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statically charged surface, creating a 
template of the page to be printed. This template is then used to transfer the ink to the page. 

 

ter is an output device similar to a printer, but normally allows you to print 
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4. Multimedia Output Device: The most common multimedia output is sound, including 
music. The audio output device on a computer is a speaker. Headphones can also be used to 
receive audio output.  

Figure 7: Multimedia Output Device

1.5.3  Process and Storage Devices 

The system unit is the name given to the main computer box that houses the vari
as illustrated in the picture below. How do we get the different computer parts to work together 
so that your computer can work? Let‘s start of our discussion with the process devices. 

Figure 8: System 
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audio output device on a computer is a speaker. Headphones can also be used to 
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Process and Storage Devices  

The system unit is the name given to the main computer box that houses the various elements 
as illustrated in the picture below. How do we get the different computer parts to work together 
so that your computer can work? Let‘s start of our discussion with the process devices.  

 

Figure 8: System Device 
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The most common multimedia output is sound, including 
audio output device on a computer is a speaker. Headphones can also be used to 

ous elements 
as illustrated in the picture below. How do we get the different computer parts to work together 
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Mother Board: Inside the syste
other components which is called a mother board. It is sometimes called a system board. The 
motherboard connects input (keyboard, mouse and scanner), output (monitor, speakers, and 

printer), processing (CPU, RAM and ROM) and storage (hard drive, CD
and flash drives) components together and tells the CPU how to run (Lubbe and Benson, 
2010:18). Other components on the motherboard include the video card, the sound card, and 
the circuits that allow the computer to communicate with devices like the printer. 

 

Expansion Cards: Yes you can play music and video files on your computer. But how is it 

possible? Inside the computer system box you also find an expansion card 
circuit board that can be attached to the motherboard to add features such as video display and 
audio capability to your computer. Expansion cards are also called expansion boards that 
enable your computer to use the multimedia devices. An
performance of your computer or enhances its features. Examples of expansion cards that can 
be added include:  

 

Video Card: 

information on the monitor. 

Network Interface Card (NIC): 

other computers so that information can be exchanged between them. 

Sound Card: 

other source to digital signals, which
cards also convert computer audio files to electrical signals, which you can play 
through a speaker or a headphone. The microphone and 
headphones connect to the sound card. 

 

1.5.4  Storage Devices 

All computers need to store and retrieve data for processing. The CPU is constantly using 
memory from the time that it is switched on until the time you shut it down. There are two 
types of storage devices as illustrated in the flow chart below. 
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Inside the systems unit is a circuit board with tiny electronic circuits and 
other components which is called a mother board. It is sometimes called a system board. The 
motherboard connects input (keyboard, mouse and scanner), output (monitor, speakers, and 

essing (CPU, RAM and ROM) and storage (hard drive, CD
and flash drives) components together and tells the CPU how to run (Lubbe and Benson, 
2010:18). Other components on the motherboard include the video card, the sound card, and 

hat allow the computer to communicate with devices like the printer. 

Figure 9: Motherboard 

Yes you can play music and video files on your computer. But how is it 

Inside the computer system box you also find an expansion card 
can be attached to the motherboard to add features such as video display and 

audio capability to your computer. Expansion cards are also called expansion boards that 
enable your computer to use the multimedia devices. An expansion card either improves the 
performance of your computer or enhances its features. Examples of expansion cards that can 

Video Card: It is connected to the computer monitor and is used to display 
information on the monitor.  

ork Interface Card (NIC): The NIC allows the computer to be connected to 
other computers so that information can be exchanged between them. 

Sound Card: It converts audio signals from a microphone, audio tape, or some 
other source to digital signals, which can be stored as a computer audio file. Sound 
cards also convert computer audio files to electrical signals, which you can play 
through a speaker or a headphone. The microphone and 
headphones connect to the sound card.  

Devices  

All computers need to store and retrieve data for processing. The CPU is constantly using 
memory from the time that it is switched on until the time you shut it down. There are two 
types of storage devices as illustrated in the flow chart below.  
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ms unit is a circuit board with tiny electronic circuits and 
other components which is called a mother board. It is sometimes called a system board. The 
motherboard connects input (keyboard, mouse and scanner), output (monitor, speakers, and 

essing (CPU, RAM and ROM) and storage (hard drive, CD‐ROM/DVD‐ROM 
and flash drives) components together and tells the CPU how to run (Lubbe and Benson, 
2010:18). Other components on the motherboard include the video card, the sound card, and 

hat allow the computer to communicate with devices like the printer.  

 

Yes you can play music and video files on your computer. But how is it 
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can be attached to the motherboard to add features such as video display and 

audio capability to your computer. Expansion cards are also called expansion boards that 
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performance of your computer or enhances its features. Examples of expansion cards that can 

It is connected to the computer monitor and is used to display 

The NIC allows the computer to be connected to 
other computers so that information can be exchanged between them.  

It converts audio signals from a microphone, audio tape, or some 
can be stored as a computer audio file. Sound 

cards also convert computer audio files to electrical signals, which you can play 
through a speaker or a headphone. The microphone and the speakers or the 

All computers need to store and retrieve data for processing. The CPU is constantly using 
memory from the time that it is switched on until the time you shut it down. There are two 
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Figure 10: Types of storage devices
 

PRIMARY STORAGE is also called main memory or immediate access store (IMAS). This 

is necessary since the processing unit can only act on data and instructions that are held in 
primary storage. Primary storage consist

• Random Access Memory (RAM) 

• Read Only Memory (ROM) 
 

Random Access Memory (RAM) is the main working memory. RAM is only filled after 
computer has been turned on and is given something to do. It holds data and instructions 
temporarily while processing takes place. RAM is volatile 
turned off or the computer reboots (start up again) all the information held in RAM will be 
lost. RAM is measured in MB (megabytes) and most entry level computers wi
MB RAM but you also find some computers having up to 3 GB RAM. RAM chips are 
expensive and the price of a computer is determined by the amount of RAM space in the 
chip.  

Figure 11: RAM
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also called main memory or immediate access store (IMAS). This 

is necessary since the processing unit can only act on data and instructions that are held in 
primary storage. Primary storage consists of two types of memory chips:  

Random Access Memory (RAM)  

Read Only Memory (ROM)  

is the main working memory. RAM is only filled after 
computer has been turned on and is given something to do. It holds data and instructions 
emporarily while processing takes place. RAM is volatile – this means that if the power is 

turned off or the computer reboots (start up again) all the information held in RAM will be 
lost. RAM is measured in MB (megabytes) and most entry level computers will have 1024 
MB RAM but you also find some computers having up to 3 GB RAM. RAM chips are 
expensive and the price of a computer is determined by the amount of RAM space in the 
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Read Only Memory (ROM) 

computer when it is switched on. These instructions are hard
manufacture. ROM is permanent and cannot be deleted but can
hence the name Read Only Memory. Data stored in ROM is non
memory will not be lost when power is turned off.
 

 

Units of Storage: The memory of all digital computers is two
Computers operate using a 
Bits have only two values by 0 and 1. 
The amount of data and instructions that can be stored in the memory of a computer or 
secondary storage is measured in bytes. 

 

A byte is made up of a com
one character (a character is a letter or symbol or punctuation mark or blank space). 
 

 

1.5.5  Secondary Storage Devices 

PCs use a simple method of designating disk drives to store data.
letters of the alphabet.Data and information stored on a permanent basis for later use. 
Secondary storage is cheaper to purchase and access. Hard disks, Zip drives, Optical disks 
(CD‘s and DVD‘s) are all examples of secondary sto
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Read Only Memory (ROM) holds data and instructions necessary for starting up the 

computer when it is switched on. These instructions are hard‐wired at the time of 
manufacture. ROM is permanent and cannot be deleted but can only be accessed or read, 

hence the name Read Only Memory. Data stored in ROM is non‐vol
memory will not be lost when power is turned off. 

Figure 12: ROM 

The memory of all digital computers is two‐state (bi
Computers operate using a binary number system – and therefore use 
Bits have only two values by 0 and 1. A bit is the smallest unit of storage in a computer. 
The amount of data and instructions that can be stored in the memory of a computer or 
secondary storage is measured in bytes.  

is made up of a combination of eight (8) bits and has the storage power to represent 
one character (a character is a letter or symbol or punctuation mark or blank space). 

Secondary Storage Devices  

PCs use a simple method of designating disk drives to store data. These drives are assigned 
letters of the alphabet.Data and information stored on a permanent basis for later use. 
Secondary storage is cheaper to purchase and access. Hard disks, Zip drives, Optical disks 
(CD‘s and DVD‘s) are all examples of secondary storage.  
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ssary for starting up the 

wired at the time of 
only be accessed or read, 

volatile – meaning that 

 

state (bi‐stable) devices. 
and therefore use binary digits (bits). 

is the smallest unit of storage in a computer. 
The amount of data and instructions that can be stored in the memory of a computer or 

and has the storage power to represent 
one character (a character is a letter or symbol or punctuation mark or blank space).  

 

These drives are assigned 
letters of the alphabet.Data and information stored on a permanent basis for later use. 
Secondary storage is cheaper to purchase and access. Hard disks, Zip drives, Optical disks 
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Internal Hard Disks are rigid inflexible disks made of highly polished metal. Data is 
stored magnetically. They can contain a single disk or two or disks stacked on a single 
spindle. They come in a variety of sizes but all have a very high storage

to floppy disks. An average computer has a hard disk of about 80 
direct access to information.  
 

Figure 13: Internal hard disc

External hard Disks/Drive ‐ same features as the internal hard disks, but are external 
the system unit and therefore can be carried around. 

Figure 14: External hard Disc
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are rigid inflexible disks made of highly polished metal. Data is 
stored magnetically. They can contain a single disk or two or disks stacked on a single 
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USB flash drive consists of a flash memory data storage device integrated with a USB 
(Universal Serial Bus) interface. USB flash drives are typically removable and re
They come in a variety of sizes to include 128MB, 256MB, 512MB, 1G, 2G, 8G etc. 

 

Memory Card ‐ Use mainly with digital cameras, cellular phones and music players 

(MP3, MP4 and iPods). They offer high
Data can be access by linking the card to a computer using a USB cable or a memory card 
reader.  
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Figure 15: USB flash drive 

Use mainly with digital cameras, cellular phones and music players 

(MP3, MP4 and iPods). They offer high‐re‐record ability and fast and power
Data can be access by linking the card to a computer using a USB cable or a memory card 

Figure 16: Memory Card 
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consists of a flash memory data storage device integrated with a USB 
(Universal Serial Bus) interface. USB flash drives are typically removable and rewritable. 
They come in a variety of sizes to include 128MB, 256MB, 512MB, 1G, 2G, 8G etc.  

 

Use mainly with digital cameras, cellular phones and music players 

record ability and fast and power‐free storage. 
Data can be access by linking the card to a computer using a USB cable or a memory card 
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Optical Disks are disks that are read by laser beams of lights. The three main types are 

CD‐R, CD‐RW and DVD.  

Figure 17 Optical Disc

 

a. CD‐R 

are so called because you can only red the in

CD‐ROM. They are particularly useful for storing 
multimedia (texts, graphics, sound and videos), application 
software packages. 

b. CD‐R 

information onto the disk only once using a CD recordable 
burner. 

c. CD‐RW 

and erase information from the disk many times. They are 
used to store large volumes of information such as texts, 
graphics, sound and video. 

d. DVD disks or Digital Versatile Disks are specific
to store movies. A typical DVD disk can hold between 
4.7GB and 17GB of information. 
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R or CD‐ROM (Compact Disk – Read Only Memory) 
are so called because you can only red the information on the 

ROM. They are particularly useful for storing 
multimedia (texts, graphics, sound and videos), application 
software packages.  

R or Compact Disk Recordable allows you to write 
information onto the disk only once using a CD recordable 
burner.  

RW or Compact Disk Rewriteable, allows you to write 
and erase information from the disk many times. They are 
used to store large volumes of information such as texts, 
graphics, sound and video.  
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CHECK YOUR PROGRESS-II 

 
1. Write a note on ‘Input Devices’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
 

2. Write a note on ‘Storage Devices’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
_________________________________________________________________________ 

 

1.6 GENERAL PURPOSE COMPUTER SYSTEM  

When you look at a desktop computer, it comprises a monitor, keyboard, mouse, and a vertical 
or horizontal box called a system unit. It is acceptable to refer to all of these components as a 
computer. Technically the systems unit houses the actual ‗ computer‘ or programmable 
machine (hardware, firmware and software), which executes (carries out) or responds to a 
sequence of program instructions. A computer system then is a collective term for a computer 
(housed within the system unit), as well as these other components that are attached to it to 
allow the user to input data and view output using different devices. Some of these components 
include a monitor, keyboard, mouse, printer, disk drives, scanners, microphones, and speakers, 
which are also referred to as peripherals. The peripherals work together to help the user 
accomplish a given task effectively. Therefore, as an example, when you perform a calculation, 

the keyboard – a peripheral device‐ is used to input the data.  
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It is the system unit that accepts and processes the data, and generates the results. Other 
peripheral devices such as the hard drive store the data and results, which can be viewed on the 
monitor. 

Figure 18: General Purpose Computer System

 
The peripheral devices mentioned above are collectively called hardware devices, since they 
can be physically attached to the computer.
or programs that are integral in the functioning of some of these peripheral devices and are 
necessary to make the computer operate. Every computer system, for example, requires an 
operating system. An operating system is a program that establishes communications with the 
various peripherals and acts as a bridge to other application specific software programs. An 
operating system is like the command centre of the ship. It makes all of the decisions about 
how the computer will function and work with others. 

1.7 EMBEDDED COMPUTER SYSTEMS 

The typical personal computer or laptop described in the last discussion is categorized as a 

general‐purpose computer system. This section will explore a special type of computer system 

called an embedded system. Embedded systems are designed to perform a very small number 
of very specific functions. For example a GPS computer in a car only provides driv
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instructions. It cannot perform any other computing function. A typical embedded system also 
uses certain types of hardware, and limited resources, such as small keyboards, screen and 
reduced memory. These systems are also actually built into the device they are controlling. 
 
Compared to a typical computer, embedded systems are often smaller in size, tend to be 

cheaper, and as a result many are mass‐produced. Embedded systems range from small 

portable devices to large complex systems. The major difference is that they are single purpose 
devices with only one form of input or output. Some may also have simple user interfaces or 
displays which include buttons, or touch screens, while others have none at all.  
 

Table 2: Examples of systems and devices which comprise embedded systems 

 

Mobile (cellular) phones and handheld computers may be categorized as embedded systems, 
but since these devices can be enhanced with the addition of other applications and peripherals, 
they are better suited to the category of general purpose computer systems and not really 
embedded systems.  

 

1.8 COMPUTER SYSTEM- HOW IT WORKS  

The major components of a computer system include input and output devices as well the 
important processor or central processing unit (CPU). The CPU comprises a set of electronic 
circuits kept within the system unit. The CPU is the brain of a computer system and is 
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responsible for processing the data that is input from a peripheral device and output to another 
peripheral device. Figure 19 illustrates the major components of a system unit that is attached 
to an input and output device.  

Figure 19: Central Processing Unit

 
The Central Processing Unit (CPU), also known as the processor or microprocessor has 
components that control the operating system and other software installed on the computer. 
The CPU also sends commands and data to the peripherals attached to the computer, such as 
the monitor or printer.  
 
Therefore the speed (how fast the electrons move around the chip) at which the CPU executes 
its tasks (or commands) determines how quickly you can view or hear the output from the 
command; such as printing a page or allowing you to view a letter on t
is called ‗clock speed‘, and is measured in megahertz (MHz). A computer system that 
responds to commands quicker means that its clock speed is working faster to execute these 
commands. Table 2 compares some common CPUs and their cloc
different silicon chips to execute the commands and process data. Different types of chips have 
different clock speeds based on the technology that was used to create them. Some examples 
are provided below.  
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Table 3: Typical CPU Speeds Based on Chip Type 

 

 
Now let‘s look deeper into the operation of the CPU. All computer systems have a CPU which 
comprises (1) a control unit and (2) arithmetic and logic unit (ALU).  

 

The Control Unit (CU) :The control unit is similar to an efficient manager. It is 
responsible for directing other parts of the computer system in order to carry out the 
instructions for the task required. The control unit (CU) must interact with the arithmetic 
and logic unit (ALU) and memory to complete its tasks. As instructions are fetched from 
memory, the CU interprets the instruction. The CU then sends commands to other 
components to gather data that may be needed to complete the instruction, even if it 
involves a transfer of data from other components and devices. The CU than determines 
where to send the result. This may include activating the printer, showing the result on the 
monitor or playing a sound on the speakers.  

 

Arithmetic and Logic Unit (ALU): The Arithmetic and Logic Unit (ALU) is the part of 
the CPU which performs all arithmetic and logic operations this involves arithmetic 
calculations including addition, subtraction and multiplication. As calculations are 
required, the Control Unit sends them to be performed in the ALU which sends the result 
back to the Control Unit. It also performs logic operations such as comparisons of numbers 

or letters to test for, such as equal‐to (=), less‐than (<),greater‐than (>) and other 

combinations, such as less‐than or equal‐to (<=).  
 

Memory: Primary memory is necessary to store instructions and data for processing, but 
they are not part of the CPU. Memory is a separate chips stored on a mother board which 
connects all the hardware together. Program instructions or data are kept in primary 
memory for only as long as the program currently using them. In human terms this would 
be considered ―short term memoryǁ. The original instructions and data are lost once the 
computer is turned off; therefore primary memory is deemed volatile. In later units we 
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discuss those non‐volatile devices which allow data and instructions to be permanently 
stored in a computer system for use later on. Primary memory is also as – memory, main 
memory, primary storage, main storage, internal storage, computer memory and RAM 
(Random Access Memory). 

 

Processing Data: Processing data is the most important activity in the computer, and so 
the task of the processor is to interpret and execute program instructions, in order to 
transform data into information. The processor is also responsible for interacting with the 
input, output and storage devices. Keeping instructions and data in primary memory when 
a program is not in use is not feasible for three reasons:  

• The processed data may be too much to be held in primary memory.  

• Generally primary memory only stores data and instructions while the computer is 
turned on, but once the computer is turned off, the data and instructions are lost.  

• If more than one program or application is opened at the same time, then, a single 
program should not exclusively use all the memory; some memory should be 
available for the other programs to use.  

 
The amount of memory available to hold the data and instruction is measured in megabytes 

or MB. A personal computer with a minimal amount of memory of say less than 512 MB 
may not be able to perform efficiently and may be rather slow in executing the 
applications. Memory is also loosely known as RAM which is an acronym for Random 
Access Memory. It should be noted there that the word random implies that data can be 
retrieved quickly, and in the same length of time, regardless of where the data is located 
(that is, the address of the data).  

 

Read Only Memory (ROM): Read‐only memory or ROM is an integrated circuit, 
programmed with specific data when it is manufactured. It is used in computer systems and 
other electronic devices. RAM and ROM are different since data stored in ROM cannot be 
modified easily. In other words, ROM is ideally suitable for storing a set of data for the life 
of the device, and is therefore non volatile. Modern types of ROM include such as 
Programmable ROM (PROM), Erasable Programmable ROM (EPROM), Electrically 
Erasable Programmable ROM (EEPROM) and flash memory can be erased and 

re‐programmed many times, although they are still called ROM because the 
reprogramming process is usually rarely done. Many ROM chips are often identified by 
the prominent circular ‗window‘ which allows ultraviolet (UV) light to enter and erase its 
contents. 
 
Flash memory (or simply flash) is a modern type of EEPROM which can be erased and 
rewritten faster than EEPROM. Flash memory is mainly used in memory cards, USB flash 
drives, memory stick, flash stick and jump drive), which are used for general storage and 
transfer of data between computers and other digital products.  

 

Function of the Machine Cycle: Consider a user who needs to add two numbers, 10 and 
15. These numbers may be input at the keyboard and the results shown on a screen. The 
processing of this simple addition is carried out in the CPU.  
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Let us examine how a single instruction is executed or carried out in the central processing 
unit. Of course, computers today generally execute one instruction at a time, although as 
quickly as a fraction of a 
 
In order to carry out an instruction, the program instructions and data must be moved into 
memory from either an input device or a secondary storage device. Once in memory, the 
control unit and ALU in the CPU work together to perform the followin
decode, execute, and store) for each instruction. These steps are collectively known as the 
machine cycle or the processing cycle. This machine cycle has two phases, the instruction 

cycle (instruction time, or I
us examine these cycles in more detail.
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Let us examine how a single instruction is executed or carried out in the central processing 
unit. Of course, computers today generally execute one instruction at a time, although as 
quickly as a fraction of a second.  

In order to carry out an instruction, the program instructions and data must be moved into 
memory from either an input device or a secondary storage device. Once in memory, the 
control unit and ALU in the CPU work together to perform the followin
decode, execute, and store) for each instruction. These steps are collectively known as the 
machine cycle or the processing cycle. This machine cycle has two phases, the instruction 

cycle (instruction time, or I‐Time) and the execution cycle (execution time or E
us examine these cycles in more detail. 

Figure 20: Machine Cycle 

Phase A: Instruction Cycle  
Fetch Instruction: The control unit fetches (gets) the program instruction from 

Decode Instruction: The control unit decodes the instruction (decides what it means) 
and then moves the necessary data from memory to the ALU.  

Phase B: Execution Cycle  
Execute Instruction: The ALU performs the requested action, by executing the 

arithmetic or logical instructions on the data.  
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4. Store (write) Result: The ALU writes or stores the result of this operation in memory 
or in a temporary register.  
 
Once these two phases are complete, the control unit instructs memory to send the result to 
an output device or a secondary storage device. The figure below illustrates how these 
cycles interact to produce a result.  
 
We have already noted that the Control Unit is ideally the brain of the CPU, and must be 
very organized. For all instructions to be processed the Control unit must have the data 
ready and the cycles working like, well, like clock work! If the control unit is regarded as 
the brain, then the clock is regarded the heart of the computer. Every operation in the 

processor takes place like the ticking of a typical old‐fashioned mechanical clock. Each 
‗tick‘ may indicate the beginning and each ‗tock‘ the end of a basic interval of time in the 
processor during a clock period. During this beginning and end phase, data moves as 
directed from the CU.  
 
We have discussed instructions, data, and memory, as well as the machine cycle functions 
in two phases. Let us now briefly mention how the control unit is able to retrieve the 
correct data and instructions from memory. This is done by giving each instruction and 
each piece of data an address, just as persons have an address for their home. So the 
addresses say the same, but just as people move to new addresses, different instructions 
and data are moved to new addresses or locations when the old data is no longer needed in 
memory. Just like a mailbox for an address can hold so many letters and packages, 
similarly each memory location can also only contain a fixed amount of data. Finally as 
mailboxes may have a label or number affixed to it, so do memory addresses have 
representative address names such as Hours, Age, or Name. 
 

1.9 APPLICATION OF COMPUTERS IN HOTEL 

Computer is an electronic device that is used for calculations, logical operations, and 
creation of database that can be utilized for future requirement. Computer has penetrated in 
all fields of business operations and hotel is not an exception to that. The computerization 
of hotel started after a considerable time from its invention. Computers have been invented 
to help people. The use of computers provides advantage over manual operations in many 
areas. Computer is capable of doing arithmetic calculations much faster than any manual 
method. Naturally, in any job involving volumes of calculations, computers are more 
useful. We can cite many examples of this advantage of using computers. Financial 
accounting, payroll, share accounting etc. Involve consideration and clerical work. 
Computers do the calculations without errors. Even when the computer is making 
thousands of calculations every second, not a single one will go wrong. Computers can 
store large volumes of data on magnetic media. The present chapter is aimed to provide 
basic knowledge of computer along with the property management system and its 
applications related with the front office operations. 
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1.9.1  Property Management System 

A property management system is a computer based management system. There are 
different modules which are utilized to manage the particular operational area of the hotel. 
There is large number of venders that provides the PMS solution as per the requirement of 
the hotel. Every hotel opting for computerization should assess their need and level of 
automation depending upon he size, location, volume of business operations etc. A 
property management system consists of modules like front office module, housekeeping 
module, restaurant management system, back office module etc. The property management 
system should also be able to interface with individual interfaces like call accounting 
system, energy management system, point of sales, electronic door locking system etc.  
 
The property management system works on networking of the hotel computers. The 
networking may be Local Area Network (LAN), Wide Area Network (WAN) or 
Metropolitan Area Network (MAN) depending upon the establishment. The terminals to 
access the property management system is located at the front desk, housekeeping, point of 
sales, stores etc. The each individual user is assigned a pre set assess to different modules 
depending upon the area of their work and level in the hierarchy of the hotel. The general 
manager and the system administrator have the full access to all modules of the property 
management system. 

 

1.9.2  PMS Application in Front Office 

The PMS front office applications have different modules for the efficient functioning of 
the department. The some of the common modules used in front office are as under:  

• Reservation module  

• Front Desk module  

• Rooms module  

• Cashier module  

• Night Audit Module  

• Setup Module  

• Report generation  

• Back office module  

 
The Reservations module is used to create and manage guest reservations, both making 
the reservations and maintaining the reservations for individuals as well as groups. The 
Reservations module includes the following features:  

• Help the reservationists to handle the reservation query by providing the room 
status records when the date of arrival, date of departure, and type of guest room is 
entered in the computer.  

• The module should be able to code the sold out days and days on which any room 
types are sold out in different colors.  

• The module should be able to help in quick location of an existing guest 
reservation, with the ability to search by:  

o Guest Name  
o Company  
o Group ID  
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o IATA Number  
o Confirmation Number  
o Starting and Ending Dates.  

• The module should quickly display Room Availability up to 14 days of information 
at a time, by simply selecting a date.  

• The ability to attach guest messages to each reservation to be delivered to the guest 
upon arrival.  

• The automatic calculation of rates based on room type, rate code, arrival date, and 
the number of adults and children.  

• The ability to create group blocks and rooming lists for standard groups, tour series 
and allotments.  

• The ability to create special group rates.  

• The ability to use the Rooming List feature for rapid reservation pick-up.  

• The ability to pre-assign rooms to guests when making a reservation or at any time, 
using a graphical tape chart.  

• The ability to define a "share with" reservation in group bookings.  

• The automatic transmission of confirmation of a reservation via e-mail, fax or 
internet.  

• The ability to post an advance deposit on a room.  

• The ability to enter "remarks" which are visible upon reservation retrieval.  

• The ability to reserve and track availability of service items such as rollaways, cribs 
and refrigerators.  

 
The Front Desk Module provides the ability to manage guest registration. The following 
features/functions are included in the Front Desk module:  

• The simple location of guest information for viewing, modification, or check-in 
procedures.  

• The ability to edit the record of a checked-in guest with the in-house option, or 
search, view, and modify the guest profile.  

• The use of a graphical room layout to see detailed location and status information.  

• The ability to track all guest activity for the length of their stay.  

• The ability to print registration cards on the fly.  

• The attachment of individual, group, company or travel agent information to each 
folio.  

• The attachment of guest messages to an in-house guest.  

• The ability to automatically transfer to city ledger at check-out.  

• The ability to create an incidentals folio.  

• The ability to easily perform room moves.  

 
The Rooms module allows you to manage the hotel's rooms and floor plan. Following are 
some of the functions performed by this module:  

• The display of hotel floor plan layout a single floor/wing at a time.  

• Changing the display of the floor plan to show housekeeping, front desk, or specific 
room status.  
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• Providing real-time room status information for both housekeeping and front desk 
for all modules.  

• The definition of status text and color codes by the user.  

• Quickly changes floors/wings using scroll buttons.  

• Reducing or enlarging the floor plan using Zoom buttons.  

• The scheduling of rooms for future maintenance.  

• The automatic adjustment of room inventory.  

• The ability to schedule linen change in long term stayovers.  

• The ability to track discrepant room status.  

 
The Cashier module is used to manage guest folios and perform check-out procedures. 
Following are some of the functions that can be performed with the Cashier module:  

• The ability to quickly add incidental folios and move charges between folios with 
one touch.  

• The location of any guest by room number or name.  

• The management of all aspects of the guest folio from the Cashier Window, 
including debits, credits, adjustments, transfers and voids.  

• The viewing or printing of folio detail or summary information, adding incidental 
folios, and performing the check-out function.  

• The ability to quickly perform a check-out.  

• The attachment of unlimited folios to each guest.  

• The assignment of revenue types by user,  

• The combination of any or all revenue types on one folio, or the creation of a 
different folio for each.  

• Viewing only the departments to which the folio applies on the posting screen.  

• Viewing transfer to and from folios side-by-side on the same screen.  

• Printing folios at any time before, during or after check-out with four print options  
o detail  
o summary  
o department summary  
o department date/summary.  

• Providing fully customizable folios using Microsoft Word.  

• The direct posting to individual or group folios, or house accounts.  

• The addition of memos or comments to posting, adjustments, and voids.  

• The ability to perform a Fast group check-out.  

• The adjustment of previous day postings on active folios.  

• Voiding current day postings on active folios, with appropriate privileges.  

• Checking out guest folios individually or all at once.  

• Setting up posting keys for preset amounts.  

• Performing postings, adjustment voids, and transfers on closed folios, without 
checking the guest back in.  

• The ability to post and track sales of miscellaneous items such as stamps, sundries, 
t-shirts, etc.  

• The ability to exchange foreign currency  
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The Night Audit module is used to balance the day's activity and complete the hotel's 
accounting functions for the day. Following are some of the features/functions included in 
the Night Audit module:  

• The ability to perform routine tasks of posting room charges, changing non-
guaranteed rooms reservations to no-shows, and changing the status of guaranteed 
no-shows with one touch.  

• The automatic backup of data to optical disk.  

• The ability to rebuild room availability in the event of a system failure.  

• Direct access to the Reports module from Night Audit.  

• The ability for the auditor to view a scrolled display of processing steps.  

• The automatic posting of service charges like garage fees, crib fees, etc.  

• The automatic posting of finance and recurring charges  

• The automatic change of room status to out of order, if scheduled.  

• The ability to automatically set the housekeeping status of occupied rooms to dirty.  

• The batch printing of registration cards.  

• The ability to process no show reservations with deposit payments.  

• The ability to print customized reports automatically.  

• The ability to archive permanent history.  

• The ability to perform close out without a system shut down - other users may 
perform any task while the audit is running.  

 

The Setup module is used to define the system settings. These settings allow for 
customization. Following are some of the key features/functions of this module:  

• The ability to specify mandatory fields for required information and add custom 
information and forms.  

• The customization of the market, source and rate codes and the definition of text 
for field selections.  

• The customization of color codes.  

• The designation of system access in relation to job function using unique user ID's 
and passwords for each employee.  

• The inclusion of all software key codes in this module, including Foundation level, 
the ID codes for each software interface being used.  

• The ability to set up system accounting to include departments, payment/currency 
types, tax rates, and house accounts.  

• The ability to use house accounts to charge items that cannot be charged to the 
guest or for which no folio is required.  

• The ability to specify rate codes, room rates, and rate availability.  

• Complete multiple language support, with translations completed into German, 
Spanish, Italian and French.  

• The restriction of rate availability by date range, date of the week, or minimum 
stay.  

• The creation and maintenance of profiles for individuals, groups, companies, or 
travel agents.  
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• The ability to define phone extensions for each room, including multiple phone 
extensions for a single room.  

• The ability to display all message prompts and screen text in the local language.  

• The definition of foreign currency exchange rates.  

• The creation of a list of all room features available throughout the hotel and 
attachment to specific room types and rooms.  

• The ability to customize the reservations calendar with user-defined text for 
holidays, special events and reminders.  

• The ability to set the length of time to retain guest folios and profiles for history.  

• The ability to define request codes to anticipate the special needs of your guests. 
The codes can represent requests that are either chargeable or complimentary.  

• The ability to create an inventory of service items, such as rollaways, cribs and 
refrigerators. The availability of these items is also tracked.  

• The ability to use a mix of standard and user defined housekeeping codes.  

• The ability to set up your printing environment and send specific reports to specific 
printers.  

 
The Reporting module allows access to all system reports. Reports can be customized 
through the use of filters. Reporting is available in the following modules:  

• Front desk  

• Reservations  

• Groups  

• Deposits  

• System Setups  

• Rates  

• Audit  

• Housekeeping  

• Back Office  

• Travel Agent  
 
The Reporting module allows for the creation and customization of multiple Marketing 
Letters and Mailing Labels. 

 
The Back Office module provides an integrated system for managing the hotel's financial 
and statistical information. The Back Office module can perform the following functions:  

• Receivables  

• Posting/Transfers  

• Billing  

• Close Period  

• Aging Report  

• Statements  

• Daily Journal  

• Reminder Letters (Dunning Letters)  

• Account Setup  
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• History  

• Guest stays listed by guest, company, group, travel agent and room number.  

• Revenue totals shown by guest, company, group, travel agent, and room number.  

• Guest stay may be selected and a folio reprinted.  

• Folios are archived to optical disk after 90 days.  

• Travel Agent  

• Payable accounts may be setup for travel agents  

• The night Audit process automatically posts commissions to payable accounts.  

• This version of the software accommodates checks to be posted as manual checks. 
In a future version, the system will support printing travel agent checks and 
managing the payables system.  

 

1.9.3 PMS Interfaces 

The property management system should be able to interface the other stand alone 
automated system such as:  

• Point of Sales  

• Call Accounting System  

• Energy Management System  

• Electronic Locking System  
 

1.9.4 Point of Sale 

The point of sales in hotel includes all restaurants, bars, discotheque, night club, health 
center, etc from where hotels sales its products and services other than accommodation. 
Each point of sales is equipped with the NCR, a standalone automated support for billings. 
The same can be networked with the property management system. When such integration 
is achieved the data is immediately transferred to other modules where it requires further 
processing. E.g. A credit sales in a restaurant to a resident guest will be immediately 
transferred to the cashier module where it will be posted in to their respective guest folio. 
The hotel provides the telephone facility to the guest.  
 

1.9.5 Call Accounting System 

The hotel guest can make local as well as long distance call from their rooms. The call 
accounting system is a standalone automated system which tracks all out going and in-
coming call. When it is integrated with the PMS interface the posting of each call can be 
made automatically to the respective terminals accounts from where the call has been 
made. The call accounting system has following features:  

• Identification of outward dialing  

• Automatic route selection  

• Call rating programme  

1.9.6  Energy Management System 

An energy management system is a standalone system that is designed to manage the 
operations of equipments responsible for maintenance of the comforts levels throughout 
the property. The energy management system shutdowns the operations of equipments not 
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is use e.g. the weather control and lights are automatically turned off when the guest is out 
of their room.  
 

1.9.7 Electronic Locking System 

The electronic locking system is widely used now-a-days. This system helps the hotel to 
control the access to the guest room. The person having the proper card key coded for the 
specific room can enter the room. When the electronic locking system is networked with 
the PMS the front desk person will be able to code the room keys for the guest. The coding 
will be such that the same key will become non- functional after the check out time on date 
of departure. 
 

CHECK YOUR PROGRESS-III 

 
1. What do you mean by term ‘PMS’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
 

2. Write a note on ‘Computer Application Hotel’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
_________________________________________________________________________ 
 

1.10 SUMMARY 

Computers are playing a vital role in almost every walk of life. The present chapter has 
introduced the basic knowledge of computers. The chapter started with a introduction of 
computers basics which includes the component of the computer system where we have 
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discussed about the component of computers like input devices, processing units, output 
devices and secondary storage devices.  
 
The chapter also discussed about the Property Management System. The PMS front office 
application is discussed in detail along with the PMS interfaces with the stand alone 
automated systems like Point of sales, energy management system, call accounting system 
and electronic locking system. 
 

1.11 GLOSSARY 

 
A bit is the smallest unit of storage in a computer. The amount of data and instructions that 
can be stored in the memory of a computer or secondary storage is measured in bytes.  

 

A byte is made up of a combination of eight (8) bits and has the storage power to represent 
one character (a character is a letter or symbol or punctuation mark or blank space). 

 

Barcode Readers: When used in a business barcodes provide a lot of information. Made 
up of columns of thick and thin lines, at the bottom of which a string of numbers is printed.  

 

CD‐R or CD‐ROM (Compact Disk – Read Only Memory) are so called because you can 

only red the information on the CD‐ROM. They are particularly useful for storing 
multimedia (texts, graphics, sound and videos), application software packages.  

CD‐R or Compact Disk Recordable allows you to write information onto the disk only 
once using a CD recordable burner.  

CD‐RW or Compact Disk Rewriteable, allows you to write and erase information from the 
disk many times. They are used to store large volumes of information such as texts, 
graphics, sound and video.  

Desktop Computer: A PC that is expected to be placed on the top of a computer or other 
desk. Desktops usually are powerful and have reasonably large secondary storage. 
Desktops require a number of input and out devices to make them useful.  

 

Digital Cameras: record photographs in the form of digital data that can be stored on a 
computer. These are often used to record photographs on identity cards.  

 

DVD disks or Digital Versatile Disks are specifically created to store movies. A typical 
DVD disk can hold between 4.7GB and 17GB of information.  

 

External hard Disks/Drive ‐ same features as the internal hard disks, but are external to 
the system unit and therefore can be carried around.  
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Impact printers: Dot matrix printers are an example of impact printers. They form 
characters from patterns of dots. They are inexpensive, but the output can be difficult to 
read.  

 

Internal Hard Disks are rigid inflexible disks made of highly polished metal. Data is 
stored magnetically. They can contain a single disk or two or disks stacked on a single 
spindle. They come in a variety of sizes but all have a very high storage capacity compared 

to floppy disks. An average computer has a hard disk of about 80 ‐250GB. It provides 
direct access to information.  

 

Keyboard: A set of keys that resembles a typewriter keyboard. You use the keyboard to 
type text, such as letters or numbers into the computer.  

Laptop: laptops are portable computers that have their monitor, keyboard, and other 
memory and storage devices all included in a packages that is up 17 inches in size and is 
powered by a special battery. Laptops are also called notebooks.  

 

Laser printer: a laser beam is directed at an electro‐statically charged surface, creating a 
template of the page to be printed. This template is then used to transfer the ink to the 
page. Toner sticks to the light images and is transferred to paper.  

 

Mainframe: Mainly associated with large companies, that process millions of transactions 
calculations from multiple sources at one time, mainframes previously filled large rooms, 
but today consist of a number of linked components that allow the different processors to 
communicate with one another and share their total computing power.  

 

Memory Card ‐ Use mainly with digital cameras, cellular phones and music players 

(MP3, MP4 and iPods). They offer high‐re‐record ability and fast and power‐free storage. 
Data can be access by linking the card to a computer using a USB cable or a memory card 
reader.  

 

Microphone: Voice input, for instance, can be recorded via a microphone. A device that 
you can use to talk to people in different parts of the world. You can record sound into the 
computer by using a microphone. You can also use a microphone to record your speech 
and let the computer convert it into text.  

Minicomputer: Minicomputers are powerful and can support many users at once. Their 
size is between microcomputers (PCs) and mainframes.  

 

Monitor: A device that is similar to a television. It is used to display information, such as 
text and graphics, on the computer.  

 

Mouse: A device that you use to interact with items displayed on the computer screen. A 
standard mouse has a left and a right button.  
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Multimedia Devices: This is the combination of sound and images with text and graphics. 
To capture sound and image data, special input devices are required.  

 

Multimedia Output Device: The most common multimedia output is sound, including 
music. The audio output device on a computer is a speaker. Headphones can also be used 
to receive audio output.  

 

Network Interface Card (NIC): The NIC allows the computer to be connected to other 
computers so that information can be exchanged between them.  

Non-impact printers: Inkjet printers work by shooting a jet of ink in the shape of the 

character required, they provide good, low‐cost colour printing.  

 

Optical Disks are disks that are read by laser beams of lights. The three main types are 

CD‐R, CD‐RW and DVD.  
 

Palmtop: More commonly called Personal Digital Assistants (PDAs). They are compact 
computers that often use special secondary flash memory instead of a typical hard drive for 
storage. Palmtops usually have optional keyboards but mainly use touch screens for input. 
They are typically the size of a paperback novel or even smaller and are very lightweight 
and use battery power.  

 

Personal Computer: Personal Computers (PC) was designed to be used by individuals for 
general use. The PC is not usually associated with the Apple Mac although it is a PC. 
Often the term desktop and PC are used interchangeably.  

 

Plotter: A plotter is an output device similar to a printer, but normally allows you to print 
larger images. It is used for printing house plans and maps.  

 

Printer: A device that you use to transfer text and images from a computer to a paper or to 
another medium, such as a transparency film. You can use a printer to create a paper copy 
of whatever you see on your monitor.  

 

Random Access Memory (RAM) is the main working memory. RAM is only filled after 
computer has been turned on and is given something to do. It holds data and instructions 
temporarily while processing takes place.  

 

Read Only Memory (ROM) holds data and instructions necessary for starting up the 

computer when it is switched on. These instructions are hard‐wired at the time of 
manufacture. ROM is permanent and cannot be deleted but can only be accessed or read, 
hence the name Read Only Memory. 

 

Scanner: A device that is similar to a photocopy machine. You can use this device to 
transfer an exact copy of a photograph or document into a computer. A scanner reads the 
page and translates it into a digital format, which a computer can read. For example, you 
can scan photographs of your family using a scanner.  
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Server: A computer that has been optimized to provide services to other computers over a 
network. Servers usually have powerful processors, lots of memory and large hard drives. 

They often provide custom services such as an e‐mail server, a backup server, a database 
server, etc.  

 

Sound Card: It converts audio signals from a microphone, audio tape, or some other 
source to digital signals, which can be stored as a computer audio file. Sound cards also 
convert computer audio files to electrical signals, which you can play through a speaker or 
a headphone. The microphone and the speakers or the headphones connect to the sound 
card.  

 

Supercomputer: Supercomputers have the world‘s fastest processors and are able to 
perform millions of computations a minute. Supercomputers are normally comprised of 
multiple high performance computers working in parallel as a single system. The best 
known supercomputers are built by Cray Supercomputers.  

 

Trackball: This is an alternative to the traditional mouse and is favoured by graphic 
designers. It gives a much finer control over the movement of items on the screen. Other 
screen pointing devices are pointing stick, touch pad, joystick, light pen, digitizing table.  

USB flash drive consists of a flash memory data storage device integrated with a USB 
(Universal Serial Bus) interface. USB flash drives are typically removable and rewritable. 
They come in a variety of sizes to include 128MB, 256MB, 512MB, 1G, 2G, 8G etc.  

 

Video Card: It is connected to the computer monitor and is used to display information on 
the monitor.  

Wearable Computer: This is the latest trend in computing where common computer 
applications such as electronic mail, are integrated into watches, cell phones, visors and 
even clothing.  

 

Webcam: A device that is similar to a video camera. It allows you to capture and send the 
live pictures to the other user. For example, a webcam allows your friends and family to 
see you when communicating with them.  

Workstation: A workstation is a desktop computer with a more powerful processor, and 
more memory for performing a special functions, such as 3D Graphics 
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1.14 TERMINAL QUESTIONS  

 
1. What are the different generation of computers? Explain each with examples. 
2. Write on note on Input devices. 
3. Write a note on Output devices 
4. What are the different storage devices? Explain each. 
5. What is a optical disc? Explain. 
6. Write a note on computer application in hotel. 
7. What do you mean by PMS? Explain. 
8. Explain the following modules of a Property Management System:  

a. Reservation module  
b. Cashier Module  
c. Front Desk Module  
d. Night audit module  
e. Reports  
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UNIT: 02  

INTRODUCTION TO COMPUTERS 

SOFTWARE 
 

Structure 
 

2.1 Introduction 
2.2 Objectives 
2.3 Types of Software  

2.3.1 Operating/System Software  
2.3.1.1 Types of Operating Software 
2.3.1.2 Functions of Operating Software 

2.3.2 Application Software  
2.3.3 Utility Software 
2.3.4 Language Translators 

2.4  Use of MS- Office 
2.5 MS-Word 

2.5.1 Introduction to MS Word 

2.5.2 Navigation and Editing on MS Word 

2.5.3 Character and Paragraph Formatting in MS Word 

2.5.4 Working with Tables and formatting in MS Word 

2.5.5 Controlling Page Layout, Spelling & Grammar Checking and Printing a Document in MS Word 

2.6 MS- Excel 
26.1 Introduction to MS Excel 2007 

2.6.2 Editing and Formatting in MS Excel 

2.6.3 Formulas, Functions and Data Manipulation in MS Excel 

2.7 MS PowerPoint 
2.7.1 Introduction to MS Powerpoint 2007 

2.7.2 Preparing to Deliver a Presentation Using MS Powerpoint 

2.8 Summary 
2.9 Glossary 
2.10 References/Bibliography 
2.11 Suggested Readings 
2.12 Terminal Questions 

2.1 INTRODUCTION 

Computer software, or simply software, is a collection of data or computer instructions that 
tell the computer how to work. Software is often divided into categories. Application 
software refers to user-downloaded programs that fulfill a want or need. Examples of 
applications include office suites, database programs, web browsers, word processors, 
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software development tools, image editors and communication platforms. In this unit we 
will discuss about various types of software.  
 
Application software are used to perform various tasks like word processing, spreadsheet 
operations and making presentations. In this unit we will discuss about three software 
namely MS Word, MS Excel and MS PowerPoint.  

2.2 OBJECTIVES 

After reading this unit, learner will be able to:  

• Explain the purpose of system software.  

• Distinguish among the three major categories of system software.  

• Explain the interaction between the user and the computer and the role of 
system software to support this interaction.  

• Explain the different types of useful application software.  

• Able to create and edit word document using MS word 

• Able to create and edit spread sheet using MS Excel 

• Make presentations using MS PowerPoint 

2.3 TYPES OF SOFTWARE   

There are three different types of software that are part of all computer systems and that ensure 
that the hardware and application programs can effectively communicate with each other. This 
software is classified as operating systems, utility programs and language translators.  
 

2.3.1 Operating System  

A computer cannot work without an operating system! The operating system comprises a 
set of coded programs that work with the peripheral devices and computer hardware to 
control and organize the general operating functions of the computer. Some of these 
functions include:  
 

• Starting the computer (also called ‗booting‘),  

• Managing and monitoring other programs, memory management, 
communications management and the management of peripheral 
devices,  

• Enabling interaction between the user and the computer system through 
the use of external input devices, and  

• monitoring and security of access to data and applications.  

 
Starting the Computer: Starting the computer, also called booting, is the process of 
loading the operating system into the computer‘s memory so it can execute the different 
operations and mange the hardware devices. When the power button on the computer is 
turned on to load the operating system, this process is called a cold boot.  
 

If the computer system is already on and the system needs be re‐started for a number of 
reasons (like the hardware stops operating or the user gets an error message), then the 
process of reloading the operating system is called a warm boot (because the computer was 
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already on). A warm boot in a Windows based PC is normally done by holding down the 

CTL‐ALT‐DEL keys at once.  
 

Managing Other Programs: The computer system needs to manage the programs that the 
computer user needs to complete business or personal tasks such as a word processing, 
Internet research, spreadsheet production and others. The operating system must therefore 
be able to manage one or more software application programs at the same time. This is 

known as multi‐tasking and the computer is considered a multi‐tasking operating 
environment. For example, multitasking operating systems run more than one application 
program at a time. Suppose a user has a word processing program, Internet browser and a 
spreadsheet are open at the same time and the computer user currently typing a report, 
using the word processing program. The word processing program is called the active 
program, since it is the current program in use while the other programs – the Internet 
browser and spreadsheet – are called inactive programs since they are running in the 
background and are not currently in use.  
 
Since computers use primary memory to increase processing efficiency, the operating 
system allocates memory spaces for each running program so that the individual programs 
do not interfere with each other. In order to accomplish this, the operating system uses 
‗virtual memory‘ or secondary storage, as an extension of random access memory (RAM).  
This is illustrated in the figure 3.1. Sometimes, if there are too many applications opened, 
then the operating system is unable to allocated adequate memory to each application. 
When this happens, none of the applications may appear to work and the computer system 
may need a warm boot.  
 

 
 

Figure: Memory CPU Interaction 
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2.3.1.1  Types of Operating Systems  

Now that the purpose of an operating system has been explained, let us examine some 
operating systems that were developed for specific purposes. The Macintosh (or Mac) and 
the IBM personal computer operate with hardware and software configurations. This is 
known as the platform. The platform of a computer system is the underlying hardware and 
software that it allows it to function. For example, the Apple computer was developed with 
a Mac platform using Motorola chips and unique operating software called ―Mac OSǁ The 
original IBM computer uses Intel chips and originally employed an operating system 
called ―DOSǁ or Disk Operating System. Today‘s PCs now use a Windows based 
operating system that incorporates many of the original concepts in DOS. Operating 
systems differ in functionality, flexibility and ease of use. Today there are a number of 
different operating systems in use. They can be classified as either personal operating 
systems, network (client/servers) operating systems and handheld operating systems. A 
representative list of different operating systems is described below. 
 

Operating 
System 

(OS) 

Type 
 

Main Purpose or Major Development 
 

Unix  
 

Network  These are network operating systems that are 
powerful.  
Runs on many types of PCs, mainframes and 
workstations; is the primary operating system for 
Internet servers; first multitasking system, widely 
used by large corporations  
 

Linux  
 

Network  Uses a command line interface; more stable than  
Windows, but applications using Linux are rare.  
 

Macintosh  
(MAC) OS X  

Personal  
 

Graphical user interface. Also considered the 
easiest system for beginners  
 

Microsoft  
Windows 95, 
98  
and XP  

Both  
personal &  
network  

Capable of Internet browsing, and multimedia 
support.  
None of these earlier versions of Windows are 
supported by Microsoft.  
 

Microsoft  
Windows  
NT/2000  

Network  
 

Also network operating systems that were designed 
specifically for corporate and other large 
businesses, and were also known as client/server 
systems (one computer ‗serves‘ provides 
applications for many users ‗clients‘).  
Offered enhanced security, and remote access to 
computer systems among other features  
 

Microsoft  
Windows  

Handheld  
and Cell  

Supports handheld devices and smartphones. 
Supports integration with other Microsoft software.  



   

Application of Computers in Hospitality and Tourism                                BHM-701BT 

Uttarakhand Open University                                        41 

Mobile 7  Phone  
 

 

Microsoft  
Windows 7  

All Types  
 

The current Microsoft operating system with a 
number of variants which can be used in all types 
of computer environments.  
 

 

2.3.1.2 Functions of an Operating System  

 

Birbal and Taylor, (2004: 39‐40) summaries the functions of an operating system as 
follows:  

 

Managing computer resources: The operating system allows application software 
programmes such as word processing, spreadsheet and database packages to communicate 
with the computer‘s hardware. For example if you work on a document in Excel and you 
want to print the document, you just press the print button on the toolbar. Excel will direct 
the operating system to select a printer to print the document. The operating system then 
notifies the computer to begin sending data and nstructions to the appropriate program to 
get the document printed. The operating system therefore acts as an interface between the 
application programmes and the hardware.  

 

Managing files and memory: The operating system manages all files on a computer. It 
keeps tracks of the locations where programmes and data are stored within the computer‘s 
memory. For example, when you open a file that has been saved to the hard drive, you are 
first instructing the computer to find the file, and then to open it. The operating system also 
allows you to easily find files stored in secondary storages devices. Other file management 

functions include copying, erasing, renaming and backing‐up files.  

 

Maintaining security: In networks and larger computers each user is given a user name or 
ID and password to gain access to the computer system. The operating system keeps a 
register of all these names so that only persons with valid usernames and passwords can 
access the system. This prevents access by hackers and unauthorized persons. The 
operating system also keeps a log which records users logged in, the length of time each 
user stayed on the system, and heat they did. Administrators can check the log to look for 
security breaches and abuse of resources.  

 

Managing tasks: A computer can perform many tasks simultaneously. One way of doing 

this is multi‐tasking – ability of the computer to run more than one programme at the same 
time. For example, a user can listen to music on his/her computer whilst at the same time 

typing a document or typing an e‐mail while another e‐mail is being sent. In the case of 
networks the multiuser operating system allows more than one user to access the same data 
at the same time.  

 

Providing a user interface: Many operating systems functions are never apparent on the 
computer‘s display screen. What you do see is what is called the user interface. The 
interface helps the user to interact with the computer.  
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User Interface  
In order to interact with the computer, a user uses 
a part of the operating system called a user 
interface. The functions of the user interface are to 
start application programs, manage secondary 
storage, such as hard disks, as well as manipulate 
files and folders, and finally shut down the 
computer safely.  
 
The three principal types of interfaces include: 

• Graphical User Interface (GUI), 

• menu‐driven interface, and  

• command‐line interface 
 

The Graphical User Interface (GUI) uses graphics 
or icons which represent various tasks. For 
example the icon to print is a small picture of a 
printer which when clicked with a mouse, will 
invoke the printing dialog box. Once the printer 
dialogue box is opened you can pick other 
commands that will be used to send your 

document to the printer. A GUI is a user
interface that eliminates the need to remember 
complex computer commands or programming 
languages.  

The menu

options available to the user in the form of pull

or pop
is shown in figure
include the GUI icons with text menu options. 

The command
line interface 
requires the 
user to type 
keywords or 
commands at a 
prompt, in 
order to enter 

data or execute commands. You can experience this 
type of command w

to input DOS based commands to execute an operating system task. This interface is the 
most difficult one for the average computer users to learn. They are often used in 
programming applications or in support of systems sof

 

Figure: Menu‐driven interface 
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In order to interact with the computer, a user uses 
a part of the operating system called a user 
interface. The functions of the user interface are to 

t application programs, manage secondary 
storage, such as hard disks, as well as manipulate 
files and folders, and finally shut down the 

The three principal types of interfaces include:  

Graphical User Interface (GUI),  

The Graphical User Interface (GUI) uses graphics 
or icons which represent various tasks. For 
example the icon to print is a small picture of a 
printer which when clicked with a mouse, will 

Once the printer 
dialogue box is opened you can pick other 
commands that will be used to send your 

document to the printer. A GUI is a user‐friendly 
interface that eliminates the need to remember 
complex computer commands or programming 

The menu‐driven interface is used to show all of the 

options available to the user in the form of pull

or pop‐up menus. An illustration of a pull‐down menu 
is shown in figure below. Many menu interfaces now 
include the GUI icons with text menu options.  

 
The command 

line interface 
requires the 
user to type 
keywords or 
commands at a 
prompt, in 
order to enter 

data or execute commands. You can experience this 
type of command when you open the ―Runǁ interface 

to input DOS based commands to execute an operating system task. This interface is the 
most difficult one for the average computer users to learn. They are often used in 
programming applications or in support of systems software.   

Figure: Command line interface

Figure: Graphical User Interface
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2.3.2 Application Software  

Application programs assist the user in completing workplace tasks, personal tasks or 
research when using the computer. They are the programs that a regular user sees and 
manipulates. This includes word processing, spreadsheet, graphic presentations software 
and others. .This Topic discusses some categories of application software, including their 
strengths that enhance a user‘s productivity.  

 

Personal Productivity Applications: Personal productivity applications serve the needs 
of various users and have several subcategories. Generally, personal productivity software 
includes word processing, spreadsheet, presentation, and database programs. Another area, 

Internet applications, includes Web browsers and electronic mail programs. Multi‐media or 
graphics applications use desktop publishing, as well as editing of photos and graphics, 
while home and educational applications include personal finance programs, tax 
preparation programs, reference software and game playing software. These personal 

productivity programs are usually stand‐alone programs which do not depend on other 
application software to function.  
 
However, there are some applications whose interfaces are the same, and also share data 
and resources with each other. These applications together are called software suites, and 

some examples are Microsoft Office ‐ which is the most popular, Corel WordPerfect 
Office, and Lotus SmartSuite. 
 
 
 

Types  Description  
Financial Software  Provides automated assistance for tax preparation and 

submission. An example is Turbo Tax.  
 

Accounting Software  Provides assistance for personal accounting and cheque 
writing. Examples are Quicken and QuickBooks. 
  
 

Word Processing 
Software  

Provides assistance in formatting, printing documents. 
Some examples are Microsoft Word, and Corel 
WordPerfect.  
 

Spreadsheet Software  Provides built‐in functions to perform calculations and 

graphics. Some examples are Microsoft Excel and Lotus  
 

Database Software  Stores, manipulates and retrieves data. Some examples are  
Microsoft Access, dBase and FoxPro.  
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Figure: Some useful application softwa

Word Processing Features: All word processing software is designed based on the 
document life cycle. The word processing document life cycle, includes creating a 
document, editing or modifying the document, formatting the document, saving and finally 
printing to provide a hard copy. Editing the document allows sections of text to be deleted, 

moved, or re‐typed, and text can also be searched and replaced. Formatting the document 
enhances its appearance, using various features include using different font types and sizes, 
line spacing, colours and borders.  

Application of Computers in Hospitality and Tourism                                BHM-701

                                       44 

Figure: Some useful application software 
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document life cycle. The word processing document life cycle, includes creating a 
document, editing or modifying the document, formatting the document, saving and finally 

inting to provide a hard copy. Editing the document allows sections of text to be deleted, 

typed, and text can also be searched and replaced. Formatting the document 
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701BT 

All word processing software is designed based on the 
document life cycle. The word processing document life cycle, includes creating a 
document, editing or modifying the document, formatting the document, saving and finally 

inting to provide a hard copy. Editing the document allows sections of text to be deleted, 

typed, and text can also be searched and replaced. Formatting the document 
enhances its appearance, using various features include using different font types and sizes, 
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Mail merge is one of the powerful features of word processing software. This feature 
makes it easy to create personalized letters and reports, as well as print addresses on 
envelopes and mailing labels. With a bit of creative thinking, mail merge can be used to 
simplify many routine tasks such as personalizing invitations, preparing flyers, making 
certificates, labeling file folders, and preparing name tags.  

 

Workgroup Applications: These applications are used by two or more users who work as 
a team to achieve a common task. The programs therefore should support the sharing of 
information and sections of the work or a project, scheduling group meetings, group 
electronic mail services, group decision making and conferencing. Some examples of this 
software are project management software, groupware like Microsoft Sharepoint and 
collaborative software like WIKIs (an example of a WIKI is Wikipedia).  

 

Enterprise Applications: These applications are used by personnel to support the 
company in its interaction with customers and employees. Some of the activities include 
entry of orders, billing, payroll, human resource management, and general reporting 
activities. Enterprise applications are specialized or tailor made to the specific activities of 
the company. Examples of enterprise software include PeopleSoft a complete package of 
company operations and Banner an enterprise system used by universities and colleges to 
support records management, financial management, course management, student 
management, etc.  

 

Application Software Development: Some applications, are developed ‗in‐house‘ 
specifically for use in the company. Other applications are developed via a contract by 
technology companies that specialize in producing custom application software for their 
customers. One example of custom software development would the book ordering process 
for Amazon.com. Finally, there are off the shelf application software packages which, as 
the name implies, can be purchased and used without the ability to customize the software.  

 

Spreadsheet Features: Electronic spreadsheets organize data in a grid of rows and 
columns. Spreadsheet programs are considered a simple database that can be used to 
manipulate data in the form of numbers, percentages, etc.  
 
The benefits include the elimination of much of the tedious tasks of performing the 

calculations manually, so that the calculations are generally error‐free. Data is 

automatically recalculated when one value or calculation is changed. What‐if analysis 
allows users to change one value and have the results instantly recalculated. This is very 
useful in financial forecasting. The intersection of a row and column is called a cell. A cell 
is known by its address which consists of a column letter, followed by row number, for 
example B7. Cells contain:  

• a label, which provides text information or headings of the entries in the 
spreadsheet,  

• a value, which is an actual number that is entered into a cell  

• a displayed value which is what is displayed in the cell. This displayed 
value can represent:  
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• a formula – an instruction to the program to calculate a number, such as 
10% of a value, or  

• a function – a pre‐programmed formula, such as SUM to add some numbers  
 
Spreadsheets produce graphs based on the data given in a visual, easily understood format. 
Analytical graphs are designed to help users analyze and understand specific data using 
simple line, bar, and pie chart graphs.  

 

Presentation Software Features: The use of pictures, photos and other graphics in a 
lecture can help the audience remember and understand what is being presented. This is 
why electronic presentations have become popular in the oral delivery of many topics. 
Presentation software is also effective for training purposes since video clips can also be 
included to illustrate certain topics. Presentation software programs such as Microsoft 
PowerPoint presents information, usually in point form on many pages called a ‗slides‘. 
Presentations can be projected and enlarged using a projector. Indeed the presentation can 
be published on the Internet as well as printed as outlines or scaled slides on paper. The 

usefulness of presentation software includes the easy updating or re‐arrangement of the 

slide content, the inclusion of multi‐media to enhance the audience‘s understanding of the 
content, the content can be viewed be a larger audience since the presentation can be 
magnified as necessary, and the presenter can use links within the presentation to link to 
other documents, files and web resources. 
 

2.3.3 Utility Software 

Utility programs are tools that help the operating system manage the computer system‘s 

secondary or non‐priority jobs. These jobs are repetitive in nature. Some examples of 
utility programs include antivirus software, backup software, disk defragmentation, disk 
scanning; file compression software, file management programs, and searching software. 
Often are automatically loaded into member when the system is booted and they operate in 
the background at the same time as the application program. Often you do not know they 
are working until they send you a message like ―Virus detected, click here to eliminateǁ. 
Only then does the user need to engage some form of interface to take the appropriate 
action. 
 

Utility 

Programmes 
Description 

Antivirus software Protects the computer from computer viruses. Examples are 
Nortan, Macafee, Zone Alarm etc 
 

Backup software Used to copy data from the hard disk to another storage medium. 
Disk 
Defragmentation  
 

Re-organizes data on storage device to improve performance 

Disk Scanning Involves disk-scanning utilities to detect and fix errors on 
storage device, or disk cleanup utilities that removes unused or 
unnecessary files that are no longer needed. 
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File Compression Reduces the size of a file, Folder or directory. Popular utility is 
WinZip 
 

File Management Stores Files in an hierarchical structure, to enable various tasks 
such as creating, deleting, copying and moving files, folders and 
directories. 
 

Search Programmes Used to find files, folders and directories on storage device. 
 

2.3.4 Language Translators 

Language translators convert the data in a program (source code) into machine language 
code (object code) so that the computer can then process. The main purpose of translating 
source code to object code is to create a program in machine language so that the computer 
can produce the desired results. An example of different types of language translators are 
compilers and interpreters. The compiler is a computer program or in some cases a set of 
programs that translates another program‘s source code into object code all at once, while 
the interpreter is a set of programs that translate the application program‘s source code, one 
line at a time while the program is running.  

 

 

CHECK YOUR PROGRESS-I 

 
1. Write a note on ‘System/Operating Software’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
__________________________________________________________________________ 
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2. Write a note on ‘Application Software’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

_________________________________________________________________________ 

 

2.4  USE OF MS- OFFICE 

Microsoft Office, or simply Office, is a family of client software, server software, and 
services developed by Microsoft. It was first announced by Bill Gates on August 1, 1988, 
at COMDEX in Las Vegas. The first version of Office contained Microsoft Word, 
Microsoft Excel, and Microsoft PowerPoint. The application software like MS Word, MS 
Excel and MS PowerPoint are widely used in routine office works.   
 

2.5 MS-WORD 

Microsoft Word is a word processor included in Microsoft Office and some editions of the 
now-discontinued Microsoft Works. The first version of Word, released in the autumn of 
1983, was for the MS-DOS operating system and introduced the computer mouse to more 
users. Word 1.0 could be purchased with a bundled mouse, though none was required. 
Following the precedents of Lisa Write and MacWrite, Word for Macintosh attempted to 
add closer WYSIWYG features into its package. Word for Mac was released in 1985. 
Word for Mac was the first graphical version of Microsoft Word. Initially, it implemented 
the proprietary .doc format as its primary format. Word 2007, however, deprecated this 
format in favor of Office Open XML, which was later standardized by Ecma International 
as an open format. Support for Portable Document Format (PDF) and OpenDocument 
(ODF) (ODF) was first introduced in Word for Windows with Service Pack 2 for Word 
2007 
 

2.4.1 Introduction to MS Word 

Starting Word: Ready? Then I’ll show you how to start Microsoft Word:  
• Click the Start button - the Start menu appears.  

• Point to the entry for All Programs.  

• Click on the entry for Microsoft Office – Word 2007  
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When you need help: 

see a small blue circle containing a question mark; just click on the question 
mark to open the MS Word Help window. You can also access the Help 

window by pressing the [F1] key on your keyboard. To get help on a specific topic, type a 
word or phrase in the blank area at the top of the window and then click the Search button; 
alternatively, you can click on any of the Help topics listed in the window. Click the X in 
the top right corner to close the Help window.

 

Now it’s time for an overview of Word 2007! 

 

The MS Word 2007 window: 

the old menu system has been replaced by the Ribbon and the Office button.
 

• The Office button contains a menu of file
Button to see the available commands. Select a command by clicking on it. 

• The Quick access toolbar provides a set of frequently used commands. The default 
options are to save a file, to undo the last action, and to repeat your most recent 
action.  
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window by pressing the [F1] key on your keyboard. To get help on a specific topic, type a 
word or phrase in the blank area at the top of the window and then click the Search button; 
alternatively, you can click on any of the Help topics listed in the window. Click the X in 
the top right corner to close the Help window. 

 

verview of Word 2007!  

The MS Word 2007 window: If you’ve used previous versions of Word, you’ll notice that 
the old menu system has been replaced by the Ribbon and the Office button.

The Office button contains a menu of file-related commands. Click th
Button to see the available commands. Select a command by clicking on it. 

The Quick access toolbar provides a set of frequently used commands. The default 
options are to save a file, to undo the last action, and to repeat your most recent 
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At the top right corner of your MS Word screen, you’ll 
see a small blue circle containing a question mark; just click on the question 
mark to open the MS Word Help window. You can also access the Help 

window by pressing the [F1] key on your keyboard. To get help on a specific topic, type a 
word or phrase in the blank area at the top of the window and then click the Search button; 
alternatively, you can click on any of the Help topics listed in the window. Click the X in 

If you’ve used previous versions of Word, you’ll notice that 
the old menu system has been replaced by the Ribbon and the Office button. 

 
related commands. Click the Office 

Button to see the available commands. Select a command by clicking on it.  

The Quick access toolbar provides a set of frequently used commands. The default 
options are to save a file, to undo the last action, and to repeat your most recent 
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• The Ribbon tabs provide you with a set of tools that are relevant to what you are 
currently doing. In the example above, the Home tab contains formatting and 
editing options.  

• The Title bar displays the name of the program and the name of the current 
document. If you haven’t named the document yet, then it will be called something 
like Document1.  

• Window controls are used to change the size of a window, or to close it. 
 

 
 

• The Vertical scrollbar is used to scroll up and down the page. You can also click
the little down arrow below the scrollbar to move down the page. If your page is 
wider than the screen display, then you will also see a Horizontal scrollbar across 
the bottom of the window.  

• The Status and information bar displays useful information a
such as the page count and number of words. 

 

Options for viewing a document in Word

“virtual piece of paper”:  

• Print layout  

• Full screen reading 

• Web layout  

• Outline view  

• Draft view  
 
For our purposes, Print layout is the best document view to work with. In Print layout, the 
piece of paper on your screen looks almost exactly as it will appear when printed. You’ll 
be able to see precisely where the page breaks and the edges of the paper fall
switch between the different page views: 

1. Look at the right end of the status and information bar at the bottom of the window. 
Here you’ll find a set of five miniature buttons. 

2. The Print layout button is the first button on the left. 
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The Ribbon tabs provide you with a set of tools that are relevant to what you are 
currently doing. In the example above, the Home tab contains formatting and 

The Title bar displays the name of the program and the name of the current 
ument. If you haven’t named the document yet, then it will be called something 

Window controls are used to change the size of a window, or to close it.  

The Vertical scrollbar is used to scroll up and down the page. You can also click
the little down arrow below the scrollbar to move down the page. If your page is 
wider than the screen display, then you will also see a Horizontal scrollbar across 

The Status and information bar displays useful information about your document, 
such as the page count and number of words.  

Options for viewing a document in Word: Word offers you five different views of your 

Full screen reading  

 

our purposes, Print layout is the best document view to work with. In Print layout, the 
piece of paper on your screen looks almost exactly as it will appear when printed. You’ll 
be able to see precisely where the page breaks and the edges of the paper fall. It’s easy to 
switch between the different page views:  

Look at the right end of the status and information bar at the bottom of the window. 
Here you’ll find a set of five miniature buttons.  

 
The Print layout button is the first button on the left.  
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3. You can click on any of the other buttons to change to the corresponding view. 

 

Showing non-printing characters

format your document, but that aren
you press the [TAB] or [ENTER] key, a formatting character is stored at the corresponding 
point in your docume
document:  

1. Click the Show/Hidebutton
2. Now the non-printing characters will appear in your document. Each time you press 
[ENTER], you‟ll see the paragraph symbol ¶ Spac
key is indicated by a small arrow 
 

3. Click the Show/Hide 

 

Writing right away –

you effectively roll a new, empty page into your Word “typewriter”. In addition, the cursor 
(the writing-mark) blinks contentedly and waits for your text. So what are you waiting for 
then? Start typing! Write down whatever comes into your head! 

 

Typing upper-case lett

[SHIFT] key, and type the letters that you
key in two places on your keyboard.
 

 
On most keyboards, you’ll recognise such “toggle keys” immediately, sin
series of little lights (usually green) on the upper right side of your keyboard.
 

Rules for entering text: 

end of the paragraph. 
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can click on any of the other buttons to change to the corresponding view. 

printing characters: Non-printing characters are characters that are used to 
format your document, but that aren‟t displayed as text on your screen. For example, when 
you press the [TAB] or [ENTER] key, a formatting character is stored at the corresponding 
point in your document. Here‟s how to display the non-printing characters in your 

1. Click the Show/Hidebutton  on the Home ribbon.  
printing characters will appear in your document. Each time you press 

‟ll see the paragraph symbol ¶ Spaces are indicated by dots · The [TAB] 
key is indicated by a small arrow → 

Show/Hide button again to hide the non-printing characters from view. 

– some important buttons and guidelines: When you start Word, 
ly roll a new, empty page into your Word “typewriter”. In addition, the cursor 
mark) blinks contentedly and waits for your text. So what are you waiting for 

then? Start typing! Write down whatever comes into your head!  

case letters: You want to type UPPER-CASE letters? Just hold down the 
[SHIFT] key, and type the letters that you‟d like in upper case. You‟ll find the [SHIFT] 
key in two places on your keyboard. 

On most keyboards, you’ll recognise such “toggle keys” immediately, sin
series of little lights (usually green) on the upper right side of your keyboard.

Rules for entering text: Please type the following text. Do not press [ENTER] until the 
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can click on any of the other buttons to change to the corresponding view.  

printing characters are characters that are used to 
‟t displayed as text on your screen. For example, when 

you press the [TAB] or [ENTER] key, a formatting character is stored at the corresponding 
printing characters in your 

printing characters will appear in your document. Each time you press 
es are indicated by dots · The [TAB] 

 

printing characters from view.  

When you start Word, 
ly roll a new, empty page into your Word “typewriter”. In addition, the cursor 
mark) blinks contentedly and waits for your text. So what are you waiting for 

CASE letters? Just hold down the 
‟d like in upper case. You‟ll find the [SHIFT] 

 

On most keyboards, you’ll recognise such “toggle keys” immediately, since they control a 
series of little lights (usually green) on the upper right side of your keyboard. 

 
Please type the following text. Do not press [ENTER] until the 
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You’ll notice that in Word, line breaks 
[ENTER] if you really want to start a new paragraph. You
if you want to move on to a new line after writing only a few words. For example, you 
might want to do this if you‟re making a
you do, don‟t press [ENTER] after each line of continuous text! That makes it very 
difficult to edit your writing. But do leave a space after every punctuation mark 
after full stops, commas, or exclamation marks. 

 

Correcting mistakes: You made a mistake? 
that helps you correct your mistakes, called the [BACKSPACE] key. 
above the [ENTER] key. Each press of the [BACKSPACE] key dele
the left of the cursor.  

 

Undoing steps: Instead of erasing one word, 
undo several steps at once? No problem!

1. Each press of the Undo button
Access toolbar) takes you one step backwards. 

2. If you click the little down arrow next to the Undo 
button, you’ll see a list of all the steps you’ve taken 
so far. Using this list, you can select the specific 
step(s) that you want to undo. 

Saving Documents : Hey! You’re Writing And 
document? Currently the document exists only in your 
that it could get lost at any second. Your 
storehouse. If there’s a power failure, or your computer crashes (the system hangs), then 
the data in memory will be lost! The solution to the problem? Save your work as soon (and 
as often) as you possible can.  

 

Saving data for the first time: Here’s
1. Click the Save button on the Quick

picture of a diskette on it.  

2. The Save As window will appear. 
Normally, the MY DOCUMENTS folder is already selected. This is NOT 
where you are to save! The MY DOCUMENTS folder is on the C: drive, and to 
prevent it accumulating files for lots of students, it is cleared out daily. (Even if 
it wasn‟t cleared out, to access it you would have to use the exact same 
computer every time you wanted to work on a file.) 
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You’ll notice that in Word, line breaks occur automatically. You should only press 
[ENTER] if you really want to start a new paragraph. You‟ll also press the [ENTER] key 
if you want to move on to a new line after writing only a few words. For example, you 

‟re making a list or typing a short passage of text. Whatever 
‟t press [ENTER] after each line of continuous text! That makes it very 

difficult to edit your writing. But do leave a space after every punctuation mark – that is, 
xclamation marks.  

You made a mistake? That’s not so bad! There is a wonderful key 
that helps you correct your mistakes, called the [BACKSPACE] key. You’ll find it directly 
above the [ENTER] key. Each press of the [BACKSPACE] key deletes one character to 

Instead of erasing one word, you’d like to 
undo several steps at once? No problem! 

Each press of the Undo button  (on the Quick 
Access toolbar) takes you one step backwards.  

ittle down arrow next to the Undo 
see a list of all the steps you’ve taken 

so far. Using this list, you can select the specific 
step(s) that you want to undo.  

 

Hey! You’re Writing And writing, but have you saved your 
ment? Currently the document exists only in your computer’s memory, which means 

that it could get lost at any second. Your computer’s memory is a fleeting electronic 
a power failure, or your computer crashes (the system hangs), then 

the data in memory will be lost! The solution to the problem? Save your work as soon (and 

Here’s what to do if you’re saving a file for the first time: 
Click the Save button on the Quick Access toolbar . You’ll recognize it by the 

The Save As window will appear.  
Normally, the MY DOCUMENTS folder is already selected. This is NOT 
where you are to save! The MY DOCUMENTS folder is on the C: drive, and to 

it accumulating files for lots of students, it is cleared out daily. (Even if 
‟t cleared out, to access it you would have to use the exact same 

computer every time you wanted to work on a file.)  
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saving a file for the first time:  
it by the 

Normally, the MY DOCUMENTS folder is already selected. This is NOT 
where you are to save! The MY DOCUMENTS folder is on the C: drive, and to 

it accumulating files for lots of students, it is cleared out daily. (Even if 
‟t cleared out, to access it you would have to use the exact same 
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3. Instead, click the drop

 
4. Click on the drive (F:) that shows your student number. 
5. Now look at the File name field. Word has already entered a placeholder name for 

you, usually based on the first few words that you typed. But you don
name!  

6. Overwrite the placeholde
First File.  

7. Click the Save button. Your document will be saved with the name you gave it, in 
the F: drive that you selected. Note that the new file name is now displayed on 
Word’s title bar. 

 

Saving Regularly: Now you’ve saved your file for the first time, but that’s not enough! 
You need to keep saving your work at regular intervals. 

1. To save, click the Save button on the Quick Access toolbar from time to time. 
2. Or you can use the keyboard shortcut: 
3. Your file will be saved without a lot of fuss. 

 
Why doesn’t the first dialogue box appear anymore? The answer to this question is simple. 
You gave the file a name and specified its location the first time you saved it. Now Word 
just saves the file under the same name and in the same place! 

 

USING FILES AND FOLDERS 

Opening Your Documents: 

started? Just open the appropriate folder and haul your work out again. There are two 
different approaches you can use for opening existing Word documents. To open a 
document directly from Word:
 

1. Click the Office button. A list of your most recent documents is displayed on the 
right of the file menu. Click any file name to open it. 

2. If the file you want is not on the list, then select the Open command. The button 
looks like a folder 

3. The Open dialog box will appear. 
a. Click on the down arrow beside the Look In field and select the file location 

(probably your F: drive). 

b. Then choose your file by clicking its entry on the list. 
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Instead, click the drop-down arrow next to Save In.  

Click on the drive (F:) that shows your student number.  
Now look at the File name field. Word has already entered a placeholder name for 
you, usually based on the first few words that you typed. But you don

Overwrite the placeholder name by typing your own file name in the field, eg My 

Click the Save button. Your document will be saved with the name you gave it, in 
the F: drive that you selected. Note that the new file name is now displayed on 
Word’s title bar.  

Now you’ve saved your file for the first time, but that’s not enough! 
You need to keep saving your work at regular intervals.  

To save, click the Save button on the Quick Access toolbar from time to time. 
Or you can use the keyboard shortcut: press [CTRL] + [S].  
Your file will be saved without a lot of fuss.  

Why doesn’t the first dialogue box appear anymore? The answer to this question is simple. 
You gave the file a name and specified its location the first time you saved it. Now Word 

aves the file under the same name and in the same place!  

USING FILES AND FOLDERS  
Opening Your Documents: You’d like to work more on a document that you previously 
started? Just open the appropriate folder and haul your work out again. There are two 

erent approaches you can use for opening existing Word documents. To open a 
document directly from Word: 

Click the Office button. A list of your most recent documents is displayed on the 
right of the file menu. Click any file name to open it.  

you want is not on the list, then select the Open command. The button 
looks like a folder that’s being opened.  

The Open dialog box will appear.  
Click on the down arrow beside the Look In field and select the file location 
(probably your F: drive).  

en choose your file by clicking its entry on the list.  
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Now look at the File name field. Word has already entered a placeholder name for 
you, usually based on the first few words that you typed. But you don‟t want this 

r name by typing your own file name in the field, eg My 

Click the Save button. Your document will be saved with the name you gave it, in 
the F: drive that you selected. Note that the new file name is now displayed on 

Now you’ve saved your file for the first time, but that’s not enough! 

To save, click the Save button on the Quick Access toolbar from time to time.  

Why doesn’t the first dialogue box appear anymore? The answer to this question is simple. 
You gave the file a name and specified its location the first time you saved it. Now Word 

You’d like to work more on a document that you previously 
started? Just open the appropriate folder and haul your work out again. There are two 

erent approaches you can use for opening existing Word documents. To open a 

Click the Office button. A list of your most recent documents is displayed on the 

you want is not on the list, then select the Open command. The button 

 

Click on the down arrow beside the Look In field and select the file location 
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4. Click the Open button in the lower right corner of the dialog box. Alternatively, 
you can double-click on the file name to open it. 

4. The contents of your file will be displayed on the screen. Note t
documents can be open simultaneously 

5. To open a document from inside My Computer: 
a. Select MY COMPUTER from the Start menu or by double

its desktop icon. 
b. Double-click on the drive containing the required fol

(this could also be a flash drive). 

 
c. Double-click the folder you saved your document in, to see the files that it contains.
d. Double-click the required file name, or else select it and press [ENTER]. The file 

will open in Word.  

A new empty document: You need a new, empty document? Nothing could be easier! If 
you already have a document open on your screen, then you 
(although this might be a good time to save it!). 

1. Click the Office button and select the New option

 
3. Alternatively, you can select the Insert tab on the ribbon and click the Blank Page 

button on the extreme left. You’ll recognize it by the icon of a dog
page.  

4. A new “sheet” will appear in your Word typewriter. 
know the new document by its placeholder file name, for example Document2. 

5. In addition, if you look at the Windows taskbar at the bottom of the screen, you’ll 
see a new button for your new document. 

 
Don’t forget to save your new document with your own file name, and in the correct 
location! If you’d like to move from one document to another, then all you have to do is to 
click the corresponding button on the Windows taskbar. 
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Click the Open button in the lower right corner of the dialog box. Alternatively, 
click on the file name to open it.  

The contents of your file will be displayed on the screen. Note that several 
documents can be open simultaneously – just repeat this process.  
To open a document from inside My Computer:  

Select MY COMPUTER from the Start menu or by double-clicking 
its desktop icon.  

click on the drive containing the required folder and file 
(this could also be a flash drive).  

 

click the folder you saved your document in, to see the files that it contains.
click the required file name, or else select it and press [ENTER]. The file 

 
You need a new, empty document? Nothing could be easier! If 

you already have a document open on your screen, then you don’t even have to close it 
(although this might be a good time to save it!).  

Click the Office button and select the New option, followed by Blank Document. 

Alternatively, you can select the Insert tab on the ribbon and click the Blank Page 
button on the extreme left. You’ll recognize it by the icon of a dog-eared white 

A new “sheet” will appear in your Word typewriter. Look at the title bar. You’ll 
know the new document by its placeholder file name, for example Document2. 
In addition, if you look at the Windows taskbar at the bottom of the screen, you’ll 
see a new button for your new document.  

r new document with your own file name, and in the correct 
location! If you’d like to move from one document to another, then all you have to do is to 
click the corresponding button on the Windows taskbar.  

701BT 

Click the Open button in the lower right corner of the dialog box. Alternatively, 

 

clicking 

der and file 

click the folder you saved your document in, to see the files that it contains. 
click the required file name, or else select it and press [ENTER]. The file 

You need a new, empty document? Nothing could be easier! If 
even have to close it 

, followed by Blank Document.  

Alternatively, you can select the Insert tab on the ribbon and click the Blank Page 
eared white 

Look at the title bar. You’ll 
know the new document by its placeholder file name, for example Document2.  
In addition, if you look at the Windows taskbar at the bottom of the screen, you’ll 

r new document with your own file name, and in the correct 
location! If you’d like to move from one document to another, then all you have to do is to 
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Creating a new folder: 

You can create a new “data area” even from within Word. You do this using the Save As 
dialog box.  

1. Click on the Office button and select the Save As option. 
2. Click the Create New Folder button. 
3. Now you’ll

new name in, for example Training. 
4. Click OK. 
5. Great service! Word will automatically switch over to your new folder. 
6. Give your file a name (the previous name that you entered was the folder 

name) and clic
 
Save or Save As: By now 
Save and a Save As command. So 
first time, it makes no difference whatsoever! Really 
on the Save icon, or whether you select Save or Save As from the Office button. Word will 
display the Save As dialogue box so that you can specify a file name and location. Only if 
you save the file again will you noti
 

• If you want to keep the same file name and location, then the Save icon and the 
menu option will both save the file with no further comment. 

• If you’d like to save an existing document under a new name, or in a different 
location, then you need to use the Save As command. This will display the Save As 
dialogue box so that you can specify another file name and/or a new folder. 

 

Saving a file on to a flash drive or diskette: 

drive or diskette? You might want to do this to make a backup copy, or to continue 
working on your file using another computer.

 

I’m assuming that you want to save a document 
drive, and so it already has a file name. 
Here’s what to do:  

• Click the Office button and select 
the Save As command. 

• In the dialog box, click the down 
arrow next to the Save In field. 

• From the list, select the device on 
which you want to save your file. 

o Stiffy disk drives are 
typically drive A:. 

o Flash dr
labelled by the device name or as a Removable Disk. 

• Click the Save button. 
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Creating a new folder: You’d like to have a new folder in which you can save your work? 
You can create a new “data area” even from within Word. You do this using the Save As 

Click on the Office button and select the Save As option. 
Click the Create New Folder button.  

you’ll see a dialog box where you’ll name your new folder. Type the 
new name in, for example Training.  
Click OK.  
Great service! Word will automatically switch over to your new folder. 
Give your file a name (the previous name that you entered was the folder 
name) and click on the Save button.  

By now you’ve probably noticed that the Office button offers you both a 
Save and a Save As command. So what’s the difference? Well, when you save a file for the 
first time, it makes no difference whatsoever! Really – it doesn’t matter whether you click 
on the Save icon, or whether you select Save or Save As from the Office button. Word will 
display the Save As dialogue box so that you can specify a file name and location. Only if 
you save the file again will you notice a difference: 

If you want to keep the same file name and location, then the Save icon and the 
menu option will both save the file with no further comment.  

like to save an existing document under a new name, or in a different 
en you need to use the Save As command. This will display the Save As 

dialogue box so that you can specify another file name and/or a new folder. 

Saving a file on to a flash drive or diskette: Would you like to save your file to a flash 
? You might want to do this to make a backup copy, or to continue 

working on your file using another computer. 

I’m assuming that you want to save a document that’s already been saved to the network 
drive, and so it already has a file name. 

Click the Office button and select 
the Save As command.  

In the dialog box, click the down 
arrow next to the Save In field.  

From the list, select the device on 
which you want to save your file.  

Stiffy disk drives are 
typically drive A:.  

Flash drives have a letter allocated by the operating system, and may be 
labelled by the device name or as a Removable Disk.  

Click the Save button.  
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older in which you can save your work? 
You can create a new “data area” even from within Word. You do this using the Save As 

Click on the Office button and select the Save As option.  

name your new folder. Type the 

Great service! Word will automatically switch over to your new folder.  
Give your file a name (the previous name that you entered was the folder 

probably noticed that the Office button offers you both a 
the difference? Well, when you save a file for the 

matter whether you click 
on the Save icon, or whether you select Save or Save As from the Office button. Word will 
display the Save As dialogue box so that you can specify a file name and location. Only if 

If you want to keep the same file name and location, then the Save icon and the Save 
 

like to save an existing document under a new name, or in a different 
en you need to use the Save As command. This will display the Save As 

dialogue box so that you can specify another file name and/or a new folder.  

Would you like to save your file to a flash 
? You might want to do this to make a backup copy, or to continue 

 

already been saved to the network 

ives have a letter allocated by the operating system, and may be 
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Closing a Document: You’d like to close the current 
document without quitting Word? 

 

• Just click the Office button and select the Close 
command  

You’ll see the Word screen without any document. 

 

Closing Word: There are several methods you can use to end Word: 

• Click the Office button, and then click the Exit Word button in the bottom right 
corner.  

 

 

 

 
Alternatively, close the window by clicking on the X at the far right edge of the title bar. 
If you’ve made any changes since you last saved your document, then you
whether you want to save your changes. You can return to your document by pressing 
[ESC] or clicking the Cancel button. 

 

 

 

2.4.2 Navigation and Editing on MS Word

 

COMFORTABLE NAVIGATION: MOVING AROUND IN WORD 

 

Moving with the mouse: How do you move around the text most easily? Use your mouse! 
Have you already typed a few lines of text? Then move the mouse over your virtual page 
and observe the shape of the mouse pointer

• When the mouse pointer is completely outside the document, it looks like a hollow 
arrow facing to the left.  

 

• When the mouse pointer is in the document margin area, it looks like a hollow 
arrow facing to the right. 

 

• When you move the mouse pointer over 
called the insertion point.  
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like to close the current 

and select the Close 

You’ll see the Word screen without any document.  

There are several methods you can use to end Word:  

Click the Office button, and then click the Exit Word button in the bottom right 

, close the window by clicking on the X at the far right edge of the title bar. 
If you’ve made any changes since you last saved your document, then you‟ll be asked 
whether you want to save your changes. You can return to your document by pressing 

 

 

Navigation and Editing on MS Word 

TABLE NAVIGATION: MOVING AROUND IN WORD  

How do you move around the text most easily? Use your mouse! 
Have you already typed a few lines of text? Then move the mouse over your virtual page 
and observe the shape of the mouse pointer.  

When the mouse pointer is completely outside the document, it looks like a hollow 

When the mouse pointer is in the document margin area, it looks like a hollow 

When you move the mouse pointer over text, it looks like a capital “I” – this is 

701BT 

Click the Office button, and then click the Exit Word button in the bottom right 

, close the window by clicking on the X at the far right edge of the title bar.  
‟ll be asked 

whether you want to save your changes. You can return to your document by pressing 

How do you move around the text most easily? Use your mouse!  
Have you already typed a few lines of text? Then move the mouse over your virtual page 

When the mouse pointer is completely outside the document, it looks like a hollow 

When the mouse pointer is in the document margin area, it looks like a hollow 

this is 
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To enter or edit text, you need to position the insertion point at the place in the text where 
you want to type, and then click the left mouse button. The text cursor (a thin vertical line) 
will blink to show that it is ready for you to start typing at this point.  
 
If you want to add text below the end of your document, you can either press [ENTER] 
after the last paragraph to move the text cursor lower down the page; or else you can 
position the insertion point where you would like to type, and do a double click. Word will 
automatically fill in any blank lines for you!  

 

Using the cursor keys: The mouse isn’t always the fastest way to move through text. 
Sometimes it saves time to use the keyboard as a clever alternative! Have a look at the 
cursor keys (arrow keys), which are found on the right of the normal keyboard. These 
provide you with flexible options for navigation. Note that if you hold down an arrow key, 
it will rapidly repeat its action. 

 
 

Moving word by word: You’d like to move a bit faster through your text? In order to 
move one whole word at a time, hold down the [CTRL] key while you press either the left 
or right arrow key.  

 

Beginning and end of the line: It can be difficult to get to the beginning or end of a line 
using the mouse. The keyboard offers you two keys intended specifically for this task! 
 

 
 

Beginning and end of the document: You’d like to jump immediately to the beginning of 
your document? Nothing could be easier! Just hold down the [CTRL] key and press 
[HOME].  
 
To jump to the end of the document, hold down [CTRL] and press [END].  

 

Bigger steps: If you’d like to move through the document using bigger steps, try using the 
following keys: 
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Jumping to a particular page: You’ve already written a number of pages and now you’d 
like to return to a particular page? Here’s what to do: 
 

1. Press the function key [F5]. This key calls up the Find and Replace dialog box. 
You’ll find yourself automatically in the Go To tab.

 

 

2. You don’t have to click anywhere; the cursor will be waiting for you in the Enter 
Page Number field. Just type the number of the page that you’d like to jump to. 

3. Click on the Go To button or press [ENTER], and you’ll find yourself transported 
to the page you wanted to see. 

 
There’s another way that you can jump to a particular page, which uses the mouse and the 
vertical scroll bar. 
 

1. Click the box on the vertical scroll bar 
and hold the left mouse button down. 

2. Now drag the scroll box in the desire
direction. You’ll see the actual page 
location in an information box on the left 
of the scroll bar.  
 

3. When you’ve reached the page you want to see, release the mouse button! 
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You’ve already written a number of pages and now you’d 
like to return to a particular page? Here’s what to do:  

Press the function key [F5]. This key calls up the Find and Replace dialog box. 
You’ll find yourself automatically in the Go To tab.  

 

You don’t have to click anywhere; the cursor will be waiting for you in the Enter 
Page Number field. Just type the number of the page that you’d like to jump to. 

Click on the Go To button or press [ENTER], and you’ll find yourself transported 
e page you wanted to see.  

There’s another way that you can jump to a particular page, which uses the mouse and the 

Click the box on the vertical scroll bar 
and hold the left mouse button down.  

Now drag the scroll box in the desired 
see the actual page 

location in an information box on the left 

reached the page you want to see, release the mouse button!  
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You’ve already written a number of pages and now you’d 

Press the function key [F5]. This key calls up the Find and Replace dialog box. 

You don’t have to click anywhere; the cursor will be waiting for you in the Enter 
Page Number field. Just type the number of the page that you’d like to jump to.  

Click on the Go To button or press [ENTER], and you’ll find yourself transported 

There’s another way that you can jump to a particular page, which uses the mouse and the 
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Setting the zoom factor

suit your taste? Just use the zoom function! 
is, and set it as you like it: 

1. You’d like to find out what the zoom factor is? Just look on the Zoom button, 
which is located towards the right end of th
bottom of the Word window. 

 
2. The picture is too big or too small? Then drag the slider at the right of the Zoom 

button, or else click the button to open the Zoom dialog box. 

3. The dialog box lets you choose a preset zoo
value in the Percent field. 

4. Click OK, and the screen will immediately appear as you want it. 
 

Viewing a document with Print Preview: 

want to know about. I’m talking 
 

1. Click the Office button, select Print and then Print Preview. The Print Preview icon 
shows a dog-eared page with a magnifying glass. 

 

 
2. Now you’re in Print Preview mode. You see the document exactly as it will look 

when printed.  
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Setting the zoom factor: Did you know that you can adjust the size of the text 
suit your taste? Just use the zoom function! Here’s how you find out what the zoom factor 
is, and set it as you like it:  

like to find out what the zoom factor is? Just look on the Zoom button, 
which is located towards the right end of the status and information bar at the 
bottom of the Word window.  

The picture is too big or too small? Then drag the slider at the right of the Zoom 
button, or else click the button to open the Zoom dialog box.  

The dialog box lets you choose a preset zoom factor, or else you can type your own 
value in the Percent field.  

Click OK, and the screen will immediately appear as you want it. 

Viewing a document with Print Preview: Word has a cool feature that you’ll definitely 
want to know about. I’m talking about print Preview. To call it up:  

Click the Office button, select Print and then Print Preview. The Print Preview icon 
eared page with a magnifying glass.  

Now you’re in Print Preview mode. You see the document exactly as it will look 
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Did you know that you can adjust the size of the text onscreen to 
how you find out what the zoom factor 

like to find out what the zoom factor is? Just look on the Zoom button, 
e status and information bar at the 

The picture is too big or too small? Then drag the slider at the right of the Zoom 
 

 

m factor, or else you can type your own 

 
Click OK, and the screen will immediately appear as you want it.  

Word has a cool feature that you’ll definitely 

Click the Office button, select Print and then Print Preview. The Print Preview icon 

 

Now you’re in Print Preview mode. You see the document exactly as it will look 



   

Application of Computers in Hospitality

Uttarakhand Open University 

3. Once again, you can adjust the zoom factor to suit yourself. There is a Zoom button 
on the Print Preview ribbon, as well as the usual zoom controls on the status bar. 
Note that the Many Pages option in the Zoom dialogue box allows you to disp
several pages at once, depending on the resolution of your screen. 

 

 
4. To close Print Preview, click the Close Print Preview button on the right of the 

ribbon.  
 

Selecting text: Before you can do anything to your text, you need to select the parts you
want to act on. Selected text passages are easy to manipulate. You can
paste them in elsewhere in your document. You
pages.  

 

Selecting a word: You want to select just one word? No problem! 
1. Position the mouse pointer directly over the word. 
2. Double-click the left mouse button. It
3. If you want to de-select text that you

selected text.  

 

Selecting a group of words: Selecting a group of words isn
1. Position the mouse pointer before the first word 
2. Click the left mouse button and hold it down. 
3. Now, while holding the left mouse button down, drag the mouse over the text. 
4. Release the mouse button only when you

 
Selecting longer sentences : The text you
example, it begins on the upper right side of the screen but ends far below on the left? 

1. Start by positioning the mouse at the beginning of the first sentence. Hold the left 
mouse button down, and don
want.  

2. Now drag the mouse directly downwards. This way you select an entire line at a 
time. Don‟t let go of the mouse button! 

3. Have you selected too much text? Don
backwards to unselect, until you

 
If you accidentally moved some of your text around while you were selecting it, then click 

the Undo button on the Quick Access toolbar. Occasionally Wor
feature can play tricks on you!  

 

Application of Computers in Hospitality and Tourism                                BHM-701

                                       60 

Once again, you can adjust the zoom factor to suit yourself. There is a Zoom button 
on the Print Preview ribbon, as well as the usual zoom controls on the status bar. 
Note that the Many Pages option in the Zoom dialogue box allows you to disp
several pages at once, depending on the resolution of your screen.  

To close Print Preview, click the Close Print Preview button on the right of the 

Before you can do anything to your text, you need to select the parts you
want to act on. Selected text passages are easy to manipulate. You can cut them out and 
paste them in elsewhere in your document. You‟ll find out more about this on the next few 

You want to select just one word? No problem!  
Position the mouse pointer directly over the word.  

mouse button. It‟s that easy!  
select text that you‟ve selected, just click anywhere outside the 

Selecting a group of words isn‟t hard either.  
Position the mouse pointer before the first word in the passage to be selected. 
Click the left mouse button and hold it down.  
Now, while holding the left mouse button down, drag the mouse over the text. 
Release the mouse button only when you‟ve selected all the text you want.  

The text you‟d like to select extends over multiple lines? For 
example, it begins on the upper right side of the screen but ends far below on the left? 

Start by positioning the mouse at the beginning of the first sentence. Hold the left 
down, and don‟t release it until you‟ve selected the entire area you 

Now drag the mouse directly downwards. This way you select an entire line at a 
‟t let go of the mouse button!  

Have you selected too much text? Don‟t let go of the mouse button yet! Just drag 
backwards to unselect, until you‟ve reached the word that ends your selection. 

If you accidentally moved some of your text around while you were selecting it, then click 

Undo button on the Quick Access toolbar. Occasionally Word‟s drag and drop 
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Once again, you can adjust the zoom factor to suit yourself. There is a Zoom button 
on the Print Preview ribbon, as well as the usual zoom controls on the status bar. 
Note that the Many Pages option in the Zoom dialogue box allows you to display 

 

To close Print Preview, click the Close Print Preview button on the right of the 

Before you can do anything to your text, you need to select the parts you 
cut them out and 

‟ll find out more about this on the next few 

‟ve selected, just click anywhere outside the 

in the passage to be selected.  

Now, while holding the left mouse button down, drag the mouse over the text.  

‟d like to select extends over multiple lines? For 
example, it begins on the upper right side of the screen but ends far below on the left?  

Start by positioning the mouse at the beginning of the first sentence. Hold the left 
‟t release it until you‟ve selected the entire area you 

Now drag the mouse directly downwards. This way you select an entire line at a 

button yet! Just drag 
‟ve reached the word that ends your selection.  

If you accidentally moved some of your text around while you were selecting it, then click 

‟s drag and drop 



   

Application of Computers in Hospitality

Uttarakhand Open University

Selecting line by line: 

1. Position the mouse in the margin to the left of the first line 
mouse pointer will look like a hol

2. Click the left mouse button and 
immediately.  

3. Now, holding the left mouse button down, drag the mouse down the side of the 
page. Let the mouse button go when you
to select.  

 

 

Selecting precisely what you want:

you? Then here’s another approach: 
1. Click wherever you’d like the selection to begin. (Just click, don’t keep on holding 

the mouse button down.) 
2. Press the [SHIFT] key and hold it down. 
3. While still holding the [SHIFT] key down, click wherever you’d like the selection 

to end. Release the [SHIFT] key. All the text between these two points is selected! 
 
Selecting with the keyboard

You can also use the cursor (arrow) keys on the keyboard. 
Try holding down the [SHIFT] key and using the arrow keys to expand your selection. 

 

Selecting everything 

the right end of the Home ribbon, click the down arrow next to the word Select, and then 
click Select All.  
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: You can even highlight entire lines of text at a swoop. 
Position the mouse in the margin to the left of the first line you’d
mouse pointer will look like a hollow arrow facing to the right. 
Click the left mouse button and don’t let go. The first line will be selected 

 
Now, holding the left mouse button down, drag the mouse down the side of the 
page. Let the mouse button go when you‟ve highlighted as much text as you want 

Selecting precisely what you want: Is clicking and dragging the mouse too clumsy for 
you? Then here’s another approach:  

Click wherever you’d like the selection to begin. (Just click, don’t keep on holding 
button down.)  

Press the [SHIFT] key and hold it down.  
While still holding the [SHIFT] key down, click wherever you’d like the selection 
to end. Release the [SHIFT] key. All the text between these two points is selected! 

Selecting with the keyboard: By the way, you don’t have to use the mouse to select text. 
You can also use the cursor (arrow) keys on the keyboard.  
Try holding down the [SHIFT] key and using the arrow keys to expand your selection. 

Selecting everything : You’d like to select the whole document at once? That’s easy! At 
the right end of the Home ribbon, click the down arrow next to the word Select, and then 
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You can even highlight entire lines of text at a swoop.  
you’d like to select. The 

low arrow facing to the right.  
let go. The first line will be selected 

Now, holding the left mouse button down, drag the mouse down the side of the 
s much text as you want 

 

Is clicking and dragging the mouse too clumsy for 

Click wherever you’d like the selection to begin. (Just click, don’t keep on holding 

While still holding the [SHIFT] key down, click wherever you’d like the selection 
to end. Release the [SHIFT] key. All the text between these two points is selected!  

the way, you don’t have to use the mouse to select text. 

Try holding down the [SHIFT] key and using the arrow keys to expand your selection.  

document at once? That’s easy! At 
the right end of the Home ribbon, click the down arrow next to the word Select, and then 
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Deleting and adding text: Now it’s finally time to reveal the secrets of deleting and 
adding text! 
 
Deleting individual characters: In Word there are two ways that you can delete your text, 
character by character, step by step.  

• You’ve already met the [BACKSPACE] key; use it to delete characters to 
the left of the cursor.  

• There’s also a key that deletes characters
[DEL] (delete) key. Go ahead and try it! 

 

 

Removing larger blocks of text : You’d like to remove several sentences at once? And 
you’re going to do this by pressing the [BACKSPACE] key until you’ve erased 
everything? I’d like to know where you find so much time! Instead, I’d advise you to select 
the text that you want to remove, and then press the [DEL] key. It’s really that easy! 

 

Adding text: One of the best things about word processing is that it’s so easy to add 
something to your text.  

1. Click the point where you’d like to add to your text. 
2. Type the new text.  
3. The line breaks will automatically adjust themselves to accommodate the addition 

to your text.  
4. If the line breaks don’t adjust themselves, then you may have press

instead of using Word’s automatic line breaks. Display the non
and delete any unnecessary ¶‟s.

 

Overtype mode: While you’re working, you may notice that your previous text is being 
deleted character by character as you type. 
Overtype Mode. Press the [INSERT] key to turn this mode off and return to Insert mode. 
 
If Insert / Overtype mode isn’t visible on your status bar, then you can do a right click in 
the blank area of the status bar, and check the Overtype option.
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Now it’s finally time to reveal the secrets of deleting and 

In Word there are two ways that you can delete your text, 
 

You’ve already met the [BACKSPACE] key; use it to delete characters to 

There’s also a key that deletes characters ahead of the cursor. It’s the 
[DEL] (delete) key. Go ahead and try it!  

You’d like to remove several sentences at once? And 
you’re going to do this by pressing the [BACKSPACE] key until you’ve erased 

ke to know where you find so much time! Instead, I’d advise you to select 
the text that you want to remove, and then press the [DEL] key. It’s really that easy! 

One of the best things about word processing is that it’s so easy to add 

Click the point where you’d like to add to your text.  

The line breaks will automatically adjust themselves to accommodate the addition 

If the line breaks don’t adjust themselves, then you may have pressed [ENTER] 
instead of using Word’s automatic line breaks. Display the non-printing characters 

‟s. 

While you’re working, you may notice that your previous text is being 
deleted character by character as you type. This happens if you’ve accidentally turned on 
Overtype Mode. Press the [INSERT] key to turn this mode off and return to Insert mode. 

visible on your status bar, then you can do a right click in 
bar, and check the Overtype option. 
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Now it’s finally time to reveal the secrets of deleting and 

In Word there are two ways that you can delete your text, 

 

You’d like to remove several sentences at once? And 
you’re going to do this by pressing the [BACKSPACE] key until you’ve erased 

ke to know where you find so much time! Instead, I’d advise you to select 
 

One of the best things about word processing is that it’s so easy to add 

The line breaks will automatically adjust themselves to accommodate the addition 

ed [ENTER] 
printing characters 

While you’re working, you may notice that your previous text is being 
This happens if you’ve accidentally turned on 

Overtype Mode. Press the [INSERT] key to turn this mode off and return to Insert mode.  

visible on your status bar, then you can do a right click in 
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Using the clipboard: 

of a word processor.  

 

Cutting and Pasting: 

document? It couldn’t 
1. Select the relevant text. 
2. Click the Cut button on the Home ribbon 

scissors.  
3. Whoops! Where did the selected text go? 

is an (invisible) storage area. 
4. Place the cursor at the point where 
5. Now click the Paste button 

clipboard.  
6. If necessary, add an extra space at the end of the pasted text. 

 

Copying instead of cutting

text, and then click Copy (the icon shows two sheets of paper) instead of Cut. 
 
When you copy, the selected text remains in its original position in the document, and a 
copy of it is placed on the clipboard. You can paste the c
document (or in another document).

 

 
Some keyboard shortcuts

cut, copy and paste! Just hold down the first key [CTRL] while you type the second one. 
[CTRL] + [X] 
[CTRL] + [C] : Copy 
[CTRL] + [V] : Paste

 

2.4.3 Character and Paragraph Formatting in MS Word

Character formatting: 

professional-looking documents! Characteristics that affect the appearanc
characters are called character formats. 

 

Changing the font: The style of typeface that you use is called the font, and there are 
literally hundreds to choose from! 
To change your font:  

1. First, select the relevant 
text. This can be anyt
from a single character to 
the entire document. 

2. Find the Font field on the Home ribbon. 
3. Click the drop-
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: Cutting, copying, and pasting are some of the most practical features 
 

: You’d like to move some text from one place to another in your 
 be easier! Here’s how it’s done:  

Select the relevant text.  
Click the Cut button on the Home ribbon – its icon is a pair of 

Whoops! Where did the selected text go? It’s been moved to the Clipboard, which 
is an (invisible) storage area.  

ace the cursor at the point where you’d like to add the text.  
Now click the Paste button – its icon is a picture of a 

If necessary, add an extra space at the end of the pasted text.  

Copying instead of cutting: So how does copying work? It’s very similar! Select your 
text, and then click Copy (the icon shows two sheets of paper) instead of Cut. 

When you copy, the selected text remains in its original position in the document, and a 
copy of it is placed on the clipboard. You can paste the copied text anywhere else in your 
document (or in another document). 

Some keyboard shortcuts: There are also some easy-to-remember key combinations to 
cut, copy and paste! Just hold down the first key [CTRL] while you type the second one. 

[CTRL] + [X] : Cut  
[CTRL] + [C] : Copy  
[CTRL] + [V] : Paste 

Character and Paragraph Formatting in MS Word 

Character formatting: Word provides an amazing range of tools to help you create 
looking documents! Characteristics that affect the appearanc

characters are called character formats.  

The style of typeface that you use is called the font, and there are 
literally hundreds to choose from!  

 
First, select the relevant 
text. This can be anything 
from a single character to 
the entire document.  

Find the Font field on the Home ribbon.  
-down arrow next to the Font field.  
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Cutting, copying, and pasting are some of the most practical features 

like to move some text from one place to another in your 

its icon is a pair of 

been moved to the Clipboard, which 

 
its icon is a picture of a 

s very similar! Select your 
text, and then click Copy (the icon shows two sheets of paper) instead of Cut.  

When you copy, the selected text remains in its original position in the document, and a 
opied text anywhere else in your 

 

remember key combinations to 
cut, copy and paste! Just hold down the first key [CTRL] while you type the second one.  

Word provides an amazing range of tools to help you create 
looking documents! Characteristics that affect the appearance of one or more 

The style of typeface that you use is called the font, and there are 
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4. You’ll see a list with countless font 
choices. Scroll through the list until 
you’ve found the font you want t
As you move the mouse over a 
particular font, your document will 
show what that font would look like 
this is called Live Preview.  

5. Select the font you want by clicking 
its name.  

 

 

Changing the font size: You can change the size of the font to su
your needs:  
1. Once again, first select the relevant text. 
2. Find the Point Size field on the Home ribbon, and click the drop

down arrow next to it.  
3. On the list, find the font size that suits you and click it. 
 

You can also specify your own font size. Ju
and type in the size that you’d like, then press [ENTER]. The size must be 
between 1 and 1638, and can include “half sizes” such as 12.5.

 
Changing the default font: The default font is what Word uses every time you start a
document. By changing this, you can ensure that all new documents will use your choice 
of font and point size!  

1. Find the Font category label on the Home ribbon, and click the arrow on its right. 

2. The Font dialog box will appear. 

 

3. Select the font and size that you’d like 
to use as your default. Leave the style 
as Regular.  

4. When you’re happy with your 
selection, be 
courageous and click 
the Default button.  

5. Word will inform you that you’re
update the NORMAL template. Go ahead and click Yes. 
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You’ll see a list with countless font 
choices. Scroll through the list until 
you’ve found the font you want to use. 
As you move the mouse over a 
particular font, your document will 
show what that font would look like – 

Select the font you want by clicking 

You can change the size of the font to suit 

Once again, first select the relevant text.  
Find the Point Size field on the Home ribbon, and click the drop-

On the list, find the font size that suits you and click it.  

You can also specify your own font size. Just click in the Point Size field 
and type in the size that you’d like, then press [ENTER]. The size must be 
between 1 and 1638, and can include “half sizes” such as 12.5. 

The default font is what Word uses every time you start a
document. By changing this, you can ensure that all new documents will use your choice 

Find the Font category label on the Home ribbon, and click the arrow on its right. 

 
The Font dialog box will appear.  

nd size that you’d like 
to use as your default. Leave the style 

When you’re happy with your 

you’re about to change the default font, which will 
L template. Go ahead and click Yes.  
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The default font is what Word uses every time you start a new 
document. By changing this, you can ensure that all new documents will use your choice 

Find the Font category label on the Home ribbon, and click the arrow on its right.  

about to change the default font, which will 
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Bold, italic, and underline

very easy! As usual, you start by selecting the text that you want to format, since otherwise 
Word won’t know where the new

1. Select the relevant portion of your text. 

2. Click the appropriate character formatting button on the Home ribbon. 

 for Bold 

 for Italic 

 for Underline 
 

The arrow next to the underline button offers you a choice of underlinin
3. To turn a character format off, click the same button again. 

 

 
Different Colours: Colours can really make life worth living! And Word gives you the 
ability to make your texts as colourful as you wish! The general rule applies here too: first 
select your text, then act: 

1. Find the Font Color button on the Home ribbon, and click the drop
down arrow.  

2. You’ll see a palette containing all the text colours available to you. 
3. Choose the text colour that you’d like by clicking on it. 

 

The complete selection

small caps? Do you have a thing for shadowed text? You can access the complete set of 
options through the font window. 

1. Select the required text. 

2. Click the arrow to the right of the F
simpler, click the right mouse button and select Font. The Font window will be 
displayed.  

3. Use the drop-down arrows to select colour or underlining options. 

4. Check any effects that 
you want to apply, like 
Shadow or Small Caps. 
The Preview field let
you see what your 
choices will look like. 

 
 
 

5. Confirm your settings with OK when 
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Bold, italic, and underline: Would you like your text to be bold, italic or underlined? It’s 
very easy! As usual, you start by selecting the text that you want to format, since otherwise 
Word won’t know where the new formatting should be applied.  

Select the relevant portion of your text.  

Click the appropriate character formatting button on the Home ribbon. 

for Bold  

for Italic  

for Underline  

The arrow next to the underline button offers you a choice of underlinin
To turn a character format off, click the same button again.  

Colours can really make life worth living! And Word gives you the 
ability to make your texts as colourful as you wish! The general rule applies here too: first 
select your text, then act:  

Find the Font Color button on the Home ribbon, and click the drop

You’ll see a palette containing all the text colours available to you. 
Choose the text colour that you’d like by clicking on it.  

lection: But wait – there’s more! Would you like your text to appear in 
small caps? Do you have a thing for shadowed text? You can access the complete set of 
options through the font window.  

Select the required text.  

Click the arrow to the right of the Font category label on the Home ribbon 
simpler, click the right mouse button and select Font. The Font window will be 

down arrows to select colour or underlining options. 

Check any effects that 
you want to apply, like 

adow or Small Caps. 
The Preview field let‟s 
you see what your 
choices will look like.  

Confirm your settings with OK when you’ve finished  
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Would you like your text to be bold, italic or underlined? It’s 
very easy! As usual, you start by selecting the text that you want to format, since otherwise 

Click the appropriate character formatting button on the Home ribbon.  

The arrow next to the underline button offers you a choice of underlining styles.  

 

Colours can really make life worth living! And Word gives you the 
ability to make your texts as colourful as you wish! The general rule applies here too: first 

Find the Font Color button on the Home ribbon, and click the drop-

You’ll see a palette containing all the text colours available to you.  

there’s more! Would you like your text to appear in 
small caps? Do you have a thing for shadowed text? You can access the complete set of 

ont category label on the Home ribbon - or even 
simpler, click the right mouse button and select Font. The Font window will be 

down arrows to select colour or underlining options.  
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Paragraph formatting: Paragraph formatting applies to a complete paragraph 
the text between two occurrences of [ENTER]. And you 
first, unless you want to format more than one paragraph. Just position your cursor 
anywhere inside the paragraph that you want to format. 

 

Right, left, or in the middle? Please arrange! 

By default, paragraphs are usually left
margin is jagged (like in this manual). Word provides you with a number of other options 
though. Just position your cursor anywhere in the pa
alignment buttons on the Home ribbon. 
 

 Align left: text is aligned at the left margin but jagged on the right. 

 Center: text is centred within each line, with jagged margins on both left and right. 

 Align right: Text is aligned at the right margin but jagged on the left. 

 Justify: text is aligned at both the left and right margins (Word does this by 
adjusting the amount of space between words). 

 
Using bullets: Here’s how you can create a nifty bulleted list! 

1. First, type the points that you want to bullet, one under another. Make sure you 
create them as individual paragraphs by pressing [ENTER] after typing each point. 

2. Select the paragraphs that you
3. Click the Bullets button in the Paragraph section of 

ribbon.  
4. Look! The selected paragraphs have been formatted as bullet points. 

 
The drop-down arrow on the right of the Bullets button allows you to choose from 
different bullet styles.  

 

Creating a numbered list: In much the same way, you can cr
numbered list. Instead of clicking the Bullets button, you should click the 
Numbering button just next to it.  
The best thing about Word numbering is that the numbers adjust themselves automatically 
when you edit the text!  

 

Borders and shading: You want to place a border around an entire paragraph? 
problem either!  

1. Place the cursor anywhere in the paragraph that 
 

2. Click the Outside Borders button in the 
Paragraph section of the Home ribbon. 
(Note: if the Outside Border button 
doesn’t show a “frame” icon, then click 
the drop-down arrow to select it.) 
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Paragraph formatting applies to a complete paragraph - that is, all 
currences of [ENTER]. And you don’t even need to select the text 

first, unless you want to format more than one paragraph. Just position your cursor 
anywhere inside the paragraph that you want to format. It’s as simple as that!  

dle? Please arrange!  
By default, paragraphs are usually left-aligned: the left margin is straight, but the right 
margin is jagged (like in this manual). Word provides you with a number of other options 
though. Just position your cursor anywhere in the paragraph, and click one of the text 
alignment buttons on the Home ribbon.  

Align left: text is aligned at the left margin but jagged on the right.  

Center: text is centred within each line, with jagged margins on both left and right. 

aligned at the right margin but jagged on the left.  

Justify: text is aligned at both the left and right margins (Word does this by 
adjusting the amount of space between words).  

how you can create a nifty bulleted list!  
the points that you want to bullet, one under another. Make sure you 

create them as individual paragraphs by pressing [ENTER] after typing each point. 
Select the paragraphs that you‟d like to bullet.  
Click the Bullets button in the Paragraph section of the Home 

Look! The selected paragraphs have been formatted as bullet points.  

down arrow on the right of the Bullets button allows you to choose from 

In much the same way, you can create a neatly 
numbered list. Instead of clicking the Bullets button, you should click the 

The best thing about Word numbering is that the numbers adjust themselves automatically 

You want to place a border around an entire paragraph? That’s

Place the cursor anywhere in the paragraph that you’d like to frame.  

Click the Outside Borders button in the 
Paragraph section of the Home ribbon. 

de Border button 
show a “frame” icon, then click 
down arrow to select it.)  
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that is, all 
even need to select the text 

first, unless you want to format more than one paragraph. Just position your cursor 

aligned: the left margin is straight, but the right 
margin is jagged (like in this manual). Word provides you with a number of other options 

ragraph, and click one of the text 

Center: text is centred within each line, with jagged margins on both left and right.  

Justify: text is aligned at both the left and right margins (Word does this by 

the points that you want to bullet, one under another. Make sure you 
create them as individual paragraphs by pressing [ENTER] after typing each point.  

down arrow on the right of the Bullets button allows you to choose from 

The best thing about Word numbering is that the numbers adjust themselves automatically 

That’s no 
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For more complex borders and shading, select the Borders and Shading option at the 
bottom of the Outside Borders drop
dialogue box. Effects can be applied to the whole paragraph, or to selected words.

 Using the Borders tab, you can select a border setting, style, colour and width. The 
Apply To field lets you specify whether this should be applied to the whole 
paragraph or to selected text. Click OK to see the effect. (And then Undo if you 
don’t like it!)  

 

 

 Using the Shading 
tab, you can select a 
background colour 
and/or pattern. The 
Apply To field lets you 
specify whether this 
should be applied to the 
whole paragraph or to 
selected text. Click OK 
see the effect.  
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For more complex borders and shading, select the Borders and Shading option at the 
bottom of the Outside Borders drop-down list. This will open the Borders and Sh
dialogue box. Effects can be applied to the whole paragraph, or to selected words.

 
Using the Borders tab, you can select a border setting, style, colour and width. The 
Apply To field lets you specify whether this should be applied to the whole 

graph or to selected text. Click OK to see the effect. (And then Undo if you 
 

 

Using the Shading 

Apply To field lets you 

should be applied to the 
aragraph or to 

selected text. Click OK 
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For more complex borders and shading, select the Borders and Shading option at the 
down list. This will open the Borders and Shading 

dialogue box. Effects can be applied to the whole paragraph, or to selected words. 

Using the Borders tab, you can select a border setting, style, colour and width. The 
Apply To field lets you specify whether this should be applied to the whole 

graph or to selected text. Click OK to see the effect. (And then Undo if you 

to 
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Working with indents: If you are working with a long document, you might want to 
consider setting off certain sections of text by using indents. Indents allow you to set text 
within a paragraph at different margins. 
There are 4 different types of indents: 

�  First Line: Use this option to move the first line of your paragraph to the right 

�  Hanging: Use this option to control the left margin of every line in your 
paragraph except the first one 

�  Left: Use this option to move the left margin of your paragraph to the right. 

�  Right: Use this option to move the right margin of your paragraph to the left 

 
First Line Indent  

1. Click in front of the line that you want to indent. 

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing 

3. In the Special list under Indentation, click First line, and then in the By box, set 
the amount of space that you want the first line to be indented. 
 

 

Hanging Indent  
1. Select the paragraph in which yo

paragraph.  
2. On the Page Layout tab, click Paragraph, and then Indents and Spacing 
3. In the Special list under Indentation, click Hanging, and then in the By box, set 

the amount of space that you want for the ha
 

Setting left and right indents  
1. Select the paragraph that you want to change. 
2. On the Page Layout tab, click Paragraph, and then Indents and Spacing. 
3. Click the arrows next to Indent Left / Right to increase / decrease the left / right 

indentation of the paragraph.  
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If you are working with a long document, you might want to 
consider setting off certain sections of text by using indents. Indents allow you to set text 

h at different margins.  
There are 4 different types of indents:  

First Line: Use this option to move the first line of your paragraph to the right 

Hanging: Use this option to control the left margin of every line in your 
e  

Left: Use this option to move the left margin of your paragraph to the right. 

Right: Use this option to move the right margin of your paragraph to the left 

Click in front of the line that you want to indent.  

tab, click Paragraph, and then Indents and Spacing  

In the Special list under Indentation, click First line, and then in the By box, set 
the amount of space that you want the first line to be indented.  

Select the paragraph in which you want to indent all but the first line of the 

On the Page Layout tab, click Paragraph, and then Indents and Spacing  
In the Special list under Indentation, click Hanging, and then in the By box, set 
the amount of space that you want for the hanging indent.  

Select the paragraph that you want to change.  
On the Page Layout tab, click Paragraph, and then Indents and Spacing.  
Click the arrows next to Indent Left / Right to increase / decrease the left / right 
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If you are working with a long document, you might want to 
consider setting off certain sections of text by using indents. Indents allow you to set text 

First Line: Use this option to move the first line of your paragraph to the right  

Left: Use this option to move the left margin of your paragraph to the right.  

Right: Use this option to move the right margin of your paragraph to the left  

In the Special list under Indentation, click First line, and then in the By box, set 

 

u want to indent all but the first line of the 

In the Special list under Indentation, click Hanging, and then in the By box, set 

Click the arrows next to Indent Left / Right to increase / decrease the left / right 
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Working with line spacing 

By default, paragraphs are followed by a blank line, and headings have extra space above 
them.  

1. Select the paragraph before or after which you w
2. On the Page Layout tab, in Paragraph, click arrow next to Spacing Before or 

Spacing After and enter the amount of space required. 
 

 

Line spacing options 

 Single Default option 
 1.5 lines This o
 Double This option is twice that of single line spacing. 
 At least This option sets at minimum amount of space between lines 
 Exactly This option sets fixed line spacing, expressed in points. 
 Multiple Sets the line spacing to accommodate multiple lines 

 

Change the line spacing for paragraphs 

1. Select the paragraphs for which you want to change the line spacing. 
2. On the Home tab, in Paragraph, click Line Spacing 
3. Click on Line Spacing Options, an
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Working with line spacing : Change the spacing before and after selected paragraphs 
By default, paragraphs are followed by a blank line, and headings have extra space above 

Select the paragraph before or after which you want to change the spacing. 
On the Page Layout tab, in Paragraph, click arrow next to Spacing Before or 
Spacing After and enter the amount of space required.  

Line spacing options  

Single Default option - sets line spacing to one line  
1.5 lines This option is one-and-one-half times that of single line spacing. 
Double This option is twice that of single line spacing.  
At least This option sets at minimum amount of space between lines 
Exactly This option sets fixed line spacing, expressed in points. 

ultiple Sets the line spacing to accommodate multiple lines  

Change the line spacing for paragraphs  

Select the paragraphs for which you want to change the line spacing. 
On the Home tab, in Paragraph, click Line Spacing  
Click on Line Spacing Options, and select options you want under Spacing. 
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Change the spacing before and after selected paragraphs  
By default, paragraphs are followed by a blank line, and headings have extra space above 

ant to change the spacing.  
On the Page Layout tab, in Paragraph, click arrow next to Spacing Before or 

 

half times that of single line spacing.  

At least This option sets at minimum amount of space between lines  
Exactly This option sets fixed line spacing, expressed in points.  

 

Select the paragraphs for which you want to change the line spacing.  

d select options you want under Spacing.  
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Using tabs: Use tabs to align text in your documents. It
text! By default, Word has tab stops sert every 0.5” on the ruler. 
 
Tab stop types:  
 
There are five types of tab stops available which do the following: 

• Left-aligned Text flows to the right 

• Centered The text centers on this position as you type 

• Right-alighned Text flows to the left 

• Decimal-aligned Text aligns on the decimal point when using numbers 

• Bar Inserts a vertical line at tab stop 
 
Setting tabs using the ruler: This is the easiest way to set tabs! 
If you can‟t see the ruler, click View Ruler at the top of the vertical scroll bar. Click 
anywhere on the ruler, and you will have set a tab stop. 
Setting custom tabs  

1. On the Page Layout tab, click Paragraph. 
2. In Paragraph, click Tabs.  

 

2.4.4 Working with Tables and Formatting in MS Word

 

Arranging text with tables: If you need to include structured text in your document, then 
using a table is the easiest way to make sure that it will remain neatly formatted, even 
when you edit it.  

 

Creating a table  
1. It’s really easy to create a table. Here’s what you need to do: 
2. Click at the point in your document where you’d like to add a table. 
3. Click on the Insert ribbon tab. 
4. Click on the Table button just below the Insert tab. 
5. A blank table grid will appear. 
6. Position the mouse pointer in the top left square of the table grid. Click the left 

button, and hold it down while dragging the mouse down and to the right. This is 
how you specify the number of columns and rows you’d like in your table. 
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Use tabs to align text in your documents. It‟s great for aligning columns of 
text! By default, Word has tab stops sert every 0.5” on the ruler.  

vailable which do the following:  

aligned Text flows to the right  

Centered The text centers on this position as you type  

alighned Text flows to the left  

aligned Text aligns on the decimal point when using numbers  

al line at tab stop  

This is the easiest way to set tabs!  
‟t see the ruler, click View Ruler at the top of the vertical scroll bar. Click 

anywhere on the ruler, and you will have set a tab stop.  

On the Page Layout tab, click Paragraph.  

ormatting in MS Word 

If you need to include structured text in your document, then 
using a table is the easiest way to make sure that it will remain neatly formatted, even 

t’s really easy to create a table. Here’s what you need to do:  
Click at the point in your document where you’d like to add a table.  
Click on the Insert ribbon tab.  
Click on the Table button just below the Insert tab.  
A blank table grid will appear.  

sition the mouse pointer in the top left square of the table grid. Click the left 
button, and hold it down while dragging the mouse down and to the right. This is 
how you specify the number of columns and rows you’d like in your table.  
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‟s great for aligning columns of 

‟t see the ruler, click View Ruler at the top of the vertical scroll bar. Click 

 

If you need to include structured text in your document, then 
using a table is the easiest way to make sure that it will remain neatly formatted, even 

sition the mouse pointer in the top left square of the table grid. Click the left 
button, and hold it down while dragging the mouse down and to the right. This is 
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7. Release the left mo
document.  

 
After you create a table, the Design ribbon will be displayed giving you a choice of 
standard table styles. Or use the Borders and Shading buttons to design your own!

 

 

Adding text to your table:

1. After you’ve created the table, the cursor will be blinking in the first cell. You can 
begin typing here. 

2. To move on to the next cell, just press the [TAB] key. 
3. When you want to mo

[ENTER] – that will create a new line inside the current cell. 
 
What if you’ve reached the end of the table and you need 
another row? Pressing the [TAB] key will automatically 
add it. 

 

Deleting Rows and C

Or a column? Here’s how: 
1. Position the cursor in the row or column that you 

want to get rid of. 
2. Click on the Layout ribbon tab. 
3. Click on the Delete button, and a drop

will appear.  
4. Select an option to 

even the entire table. 
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Release the left mouse button, and the framework of your table is included in the 

After you create a table, the Design ribbon will be displayed giving you a choice of 
standard table styles. Or use the Borders and Shading buttons to design your own!

 

t to your table: You want to fill the table in? Nothing could be easier! 
After you’ve created the table, the cursor will be blinking in the first cell. You can 
begin typing here.  
To move on to the next cell, just press the [TAB] key.  
When you want to move to the next line, just press [TAB] again. Don’t press 

that will create a new line inside the current cell.  

What if you’ve reached the end of the table and you need 
another row? Pressing the [TAB] key will automatically 

Columns: You’d like to delete a row? 
Or a column? Here’s how:  

Position the cursor in the row or column that you 
want to get rid of.  
Click on the Layout ribbon tab.  
Click on the Delete button, and a drop-down menu 

Select an option to delete cells, columns, rows, or 
even the entire table.  
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use button, and the framework of your table is included in the 

After you create a table, the Design ribbon will be displayed giving you a choice of 
standard table styles. Or use the Borders and Shading buttons to design your own! 

You want to fill the table in? Nothing could be easier!  
After you’ve created the table, the cursor will be blinking in the first cell. You can 

ve to the next line, just press [TAB] again. Don’t press 
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Adding rows and columns: You need to have the Layout ribbon visible for this too. 
1. Position the cursor in the row 

(column) next to which you want 
add another row (column).  

2. Click on one of the Rows &
Columns options (located on the 
right of the Delete button). The 
new row or column will be 
included in your table.  

 
 

Adding ClipArt to documents: You can add pizzazz to your documents with ClipArt, the 
ready-made pictures that come with Word! 

 

Adding ClipArt graphics  
Here’s what you need to do to add ClipArt graphics to your document: 

1. Click at the point in your document where you’d like to add a 
ClipArt graphic.  

2. Click on the Insert ribbon tab. 
3. Click on the ClipArt button.  
4. A ClipArt pane will open 

document. 
5. Type a descriptive term in the Search For field, for 

example sport. Then click Go or press [ENTER]. 

6. The ClipArt Gallery will show you all the available 
graphics related to this theme.  

7.  Clicking on a picture will insert it i
 
To remove a graphic from your document, click on it and then 
press the [DEL] key. 

 
Moving graphics : It’s easy to move a graphic wherever you want it: 

1. As you move the mouse pointer over the graphic, it will change into a four
arrow.  

2. Hold down the left mouse button, and drag the graphic to wherever you
 
Scaling graphics: You’d like to change the size of the image? Simple! 

1. Click on the graphic to select it. You’ll know it’s selected when you see eight small 
selection marks around it.  

2. Move the mouse to one of the corners. The mouse pointer changes to a double 
arrow.  

3. Hold down the left mouse button, and drag the corner of the graphic until it
size you’d like it to be.  

 

Text flow around graphics: When you add a gr
your text. That isn’t good! So let’s make the text flow around the graphic instead: 
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You need to have the Layout ribbon visible for this too. 
Position the cursor in the row 
(column) next to which you want 

Click on one of the Rows & 
Columns options (located on the 
right of the Delete button). The 
new row or column will be 

You can add pizzazz to your documents with ClipArt, the 
made pictures that come with Word!  

Here’s what you need to do to add ClipArt graphics to your document:  
Click at the point in your document where you’d like to add a 

Click on the Insert ribbon tab.  
 

A ClipArt pane will open on the right of your 

Type a descriptive term in the Search For field, for 
example sport. Then click Go or press [ENTER].  
The ClipArt Gallery will show you all the available 

 
Clicking on a picture will insert it in your document.  

To remove a graphic from your document, click on it and then 

It’s easy to move a graphic wherever you want it:  
As you move the mouse pointer over the graphic, it will change into a four-headed 

Hold down the left mouse button, and drag the graphic to wherever you‟d like it. 

You’d like to change the size of the image? Simple!  
Click on the graphic to select it. You’ll know it’s selected when you see eight small 

Move the mouse to one of the corners. The mouse pointer changes to a double 

Hold down the left mouse button, and drag the corner of the graphic until it

When you add a graphic, it will probably obstruct some of 
your text. That isn’t good! So let’s make the text flow around the graphic instead:  
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You need to have the Layout ribbon visible for this too.  

You can add pizzazz to your documents with ClipArt, the 

headed 

‟d like it.  

Click on the graphic to select it. You’ll know it’s selected when you see eight small 

Move the mouse to one of the corners. The mouse pointer changes to a double 

Hold down the left mouse button, and drag the corner of the graphic until it‟s the 

aphic, it will probably obstruct some of 
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1. As soon as you click on a graphic, a Format ribbon tab 

appears at the top of the screen. 

2. Click the Format ribbon tab. 

3. Click on the Text Wrapping button. 

4.  Select a position for the graphic relative to the text 

around it. For example, if you

around the contours of the graphic, select Through.) 

 

2.4.5 Controlling Page Layout, Spelling, 

Document in MS Wo

 

Controlling Page Layout

to your document? That’s not hard! (Headers and footers are elements of a document that 
are repeated on every page.) 

 

Adding page numbers

document:  
1. Select the Insert ribbon tab, and click on the Page Number 

button.  
2. From the drop-

your page numbers, and one of the built

numbering style or sequence then click the Page Number 
button again, and select Format Page Numbers. 

 
5. Finally, click Close Header & Footer to return to your 

document text. 

 
Adding a Header : Headers and footers aren’t automatically included in 
a new document. But that’s easily remedied! Let’s start with a header: 

1. On the Insert ribbon, click the Header button. 
2. The Header menu will drop down, offering you a choice of built

in header layouts. Select a layout by clicking on it. 
3. The header area will appear above your document text (which 

will be greyed out). The Design ribbon will replace the Insert 
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As soon as you click on a graphic, a Format ribbon tab 

appears at the top of the screen.  

Click the Format ribbon tab.  

the Text Wrapping button.  

Select a position for the graphic relative to the text 

around it. For example, if you‟d like the text to flow 

around the contours of the graphic, select Through.)  

ntrolling Page Layout, Spelling, Grammar Checking and Printing a 

Document in MS Word 

Controlling Page Layout: You’d like to add page numbers, or perhaps a header or footer, 
to your document? That’s not hard! (Headers and footers are elements of a document that 
are repeated on every page.)  

Adding page numbers: Let’s start by adding page numbers to your 

Select the Insert ribbon tab, and click on the Page Number 

-down menu, select the position you’d like for 
your page numbers, and one of the built-in formats. It’s as 

simple as that!  
3. Page numbers will 

your document, and the Design ribbon will 
replace the Insert ribbon above the document 
window.  

4. If you want 
to adjust the page 

numbering style or sequence then click the Page Number 
button again, and select Format Page Numbers.  

click Close Header & Footer to return to your 

document text.  

Headers and footers aren’t automatically included in 
a new document. But that’s easily remedied! Let’s start with a header: 

On the Insert ribbon, click the Header button.  
he Header menu will drop down, offering you a choice of built

in header layouts. Select a layout by clicking on it.  
The header area will appear above your document text (which 
will be greyed out). The Design ribbon will replace the Insert 
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Grammar Checking and Printing a 

You’d like to add page numbers, or perhaps a header or footer, 
to your document? That’s not hard! (Headers and footers are elements of a document that 

age numbers to your 

Select the Insert ribbon tab, and click on the Page Number 

down menu, select the position you’d like for 
in formats. It’s as 

Page numbers will be inserted into 
your document, and the Design ribbon will 
replace the Insert ribbon above the document 

Headers and footers aren’t automatically included in 
a new document. But that’s easily remedied! Let’s start with a header:  

he Header menu will drop down, offering you a choice of built-

The header area will appear above your document text (which 
will be greyed out). The Design ribbon will replace the Insert 
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ribbon above the document window. 
4. You‟ll see a text placeholder in the header area. Click on it and then type the text 

that you want to appear in the header. 
5. When you‟ve finished creating your header, you can either 

a. click the Close Header and Footer button, or 
b. if you‟d like to add a foo

 
To edit an existing header, just double
To remove a header, click the Header button and then select Remove 
Header from the bottom of the drop-down menu. 

 

Adding a footer: Adding, editing or removing a footer follows the same 
steps as described above for a header. Just click the Footer button instead 
of the Header button!  
 
Setting page orientation: You can decide on the orientation of your page ie. portrait or 
landscape by selecting Page Layout, then Orientation. 

 

Setting page margins: To change the margins of your document, select Page Layout, then 
Margins. The most common margin width to use is the Normal option. You are also 
welcome to select your own margin settings by sel
  

 

Inserting a manual page break: You will often need to 
insert a manual page break to add a blank page to your 
document. You do this by clicking on Insert and then 
selecting the Blank Page option. 

 

Deleting a page break  
1. Select Print Layout.  
2. Click on the page break in Print Layout view and hit 

the delete key  
 
Spelling and grammar checking: Have you sometimes noticed a wavy red line appearing 
beneath your typing? This indicates a typo, or a word that Word 
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document window.  
‟ll see a text placeholder in the header area. Click on it and then type the text 

that you want to appear in the header.  
‟ve finished creating your header, you can either  

click the Close Header and Footer button, or  
‟d like to add a footer as well, then click the Footer button.  

To edit an existing header, just double-click anywhere in the header area. 
To remove a header, click the Header button and then select Remove 

down menu.  

ing, editing or removing a footer follows the same 
steps as described above for a header. Just click the Footer button instead 

You can decide on the orientation of your page ie. portrait or 
ecting Page Layout, then Orientation.  

To change the margins of your document, select Page Layout, then 
Margins. The most common margin width to use is the Normal option. You are also 
welcome to select your own margin settings by selecting Margins, Custom Margins. 

You will often need to 
insert a manual page break to add a blank page to your 
document. You do this by clicking on Insert and then 

Click on the page break in Print Layout view and hit 

Have you sometimes noticed a wavy red line appearing 
beneath your typing? This indicates a typo, or a word that Word doesn’t recognise. Note 
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‟ll see a text placeholder in the header area. Click on it and then type the text 

You can decide on the orientation of your page ie. portrait or 

To change the margins of your document, select Page Layout, then 
Margins. The most common margin width to use is the Normal option. You are also 

 

 

Have you sometimes noticed a wavy red line appearing 
se. Note 



   

Application of Computers in Hospitality

Uttarakhand Open University

that Word also regards a missing space after a comma or a period, or the doubling of a 
word (the the), as a mistake! 

 

Proofing while you type

 
1. Mistype a word so 

that the wavy red 
line appears.  

2. Click the right 
mouse button on 
the underlined 
word. A context
sensitive menu will 
open up.  

3. Click with the left 
mouse button on 
the correct 
suggestion, and the 
mistyped word will 
automatically be 
replaced.  
 

What if Word doesn’t
make any suggestions?
comma.  
 

 

Spell checking the entire document

you’d rather get your thoughts down on paper 
without stopping to make corrections as you 
go? Word also has an option to spell check the 
entire document or selected passages of text. 

1. Position the cursor at the point where 
you’d like to begin spell checking. 

2. Click on the Review ribbon tab, and 
then on the Spelling & Grammar 
button. The Spelling and Grammar 
dialogue box will open. 

3. The first spelling or grammar error will 
be highlighted and a list of suggestions 
provided.  

4. Click the correct suggestion and then 
Change, or click the Ignore Once 
button to skip over it. 
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that Word also regards a missing space after a comma or a period, or the doubling of a 
word (the the), as a mistake!  

Proofing while you type: Now I’ll show you how to use the nifty spell checker! 

Mistype a word so 
that the wavy red 

Click the right 
mouse button on 
the underlined 
word. A context-
sensitive menu will 

Click with the left 
mouse button on 
the correct 
suggestion, and the 
mistyped word will 
automatically be 

doesn’t 
make any suggestions? Then check whether maybe you left out a space after a period or 

Spell checking the entire document: Maybe 
rather get your thoughts down on paper 

without stopping to make corrections as you 
go? Word also has an option to spell check the 
entire document or selected passages of text.  

Position the cursor at the point where 
like to begin spell checking.  

Click on the Review ribbon tab, and 
then on the Spelling & Grammar 
button. The Spelling and Grammar 
dialogue box will open.  

t spelling or grammar error will 
be highlighted and a list of suggestions 

Click the correct suggestion and then 
Change, or click the Ignore Once 
button to skip over it.  
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that Word also regards a missing space after a comma or a period, or the doubling of a 

show you how to use the nifty spell checker!  

Then check whether maybe you left out a space after a period or 
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5. Each subsequent problem will be highlighted in turn. 

6. Press OK when the spelling and grammar check is complete. 
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Each subsequent problem will be highlighted in turn.  

spelling and grammar check is complete.  

701BT 

 

 

 



   

Application of Computers in Hospitality

Uttarakhand Open University

Automatic error correction

you are still typing a word? Try it 
the. You can’t do it! The f

 

Printing a document: 

 

The Print dialog box: 

1. Click the Office button and select the Print command. 

2. The Print dialog box will appear. 

3. If you have more than one printer to choose from, they will be available in the 
Printer area. Click the drop
preferred printer. 

4. Would you like to print selected pages onl
the page numbers that 

5. If you’d like more than one copy of the document, then enter the required number 
of copies in the Number of Copies field. 

6. If you’d like to print more than 
select the required number in the Pages per Sheet field. 

7. Click OK when 
will be sent to the printer. 
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Automatic error correction: Did you know that Word is already looking for errors while 
you are still typing a word? Try it – for example, type adn instead of and, or teh instead of 

do it! The force behind this is an intelligent function called Auto

: Now it’s finally time to see your words on paper! 

: This is the approach that I recommend:  
Click the Office button and select the Print command.  

The Print dialog box will appear.  

If you have more than one printer to choose from, they will be available in the 
Printer area. Click the drop-down arrow next to the Name field to select your 
preferred printer.  

Would you like to print selected pages only? Find the Page Range area, and type 
the page numbers that you’d like printed in the Pages field.  

like more than one copy of the document, then enter the required number 
of copies in the Number of Copies field.  

like to print more than one page per sheet (compressed printing), then 
select the required number in the Pages per Sheet field.  
Click OK when you’re satisfied with your settings. The specified document pages 
will be sent to the printer.  
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Did you know that Word is already looking for errors while 
for example, type adn instead of and, or teh instead of 

orce behind this is an intelligent function called Auto-Correct.  

finally time to see your words on paper!  

If you have more than one printer to choose from, they will be available in the 
down arrow next to the Name field to select your 

y? Find the Page Range area, and type 

like more than one copy of the document, then enter the required number 

one page per sheet (compressed printing), then 

satisfied with your settings. The specified document pages 
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Word tips and tricks: Now we’re almost
have a few tricks for you hidden up my sleeve! 

 

Beginning on a new page: You’d like to begin a piece of text on a new page? Perhaps 
you’ve tried to do this by repeatedly pressing [ENTER] until you reach the
And then when you changed something on the previous page, the entire line count became 
scrambled! Here’s a trick to ensure this will never happen to you again. 

1. Click just before the text that 
2. Hold down the [CTRL] key and press [ENTER]. 
3. Word will automatically add a hard page break to your document. 

 

 

Searching for text: You’re working on a long document, and looking 
for a particular item of text?  

1. Click the Find button at the left end of the Home ri
 

2. The Find and Replace dialog box will appear. Click the Find tab. 
3. Type in the word or phrase you

Next.  
4. Word will 

display and 
highlight the 
next 
occurrence of 
the specified 
word or 
phrase.  

5. You can 
continue 
pressing Find Next to locate all occurrences of the specified word or phrase, or 
click Cancel to close the window. 

6. Word will tell you when all occurrences of the word or phrase have been displayed. 
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almost at the end of this manual. Almost – but I still 
have a few tricks for you hidden up my sleeve!  

like to begin a piece of text on a new page? Perhaps 
tried to do this by repeatedly pressing [ENTER] until you reach the right position? 

And then when you changed something on the previous page, the entire line count became 
a trick to ensure this will never happen to you again.  

Click just before the text that you’d like to place on a new page.  
the [CTRL] key and press [ENTER].  

Word will automatically add a hard page break to your document.  

working on a long document, and looking 

Click the Find button at the left end of the Home ribbon.  

The Find and Replace dialog box will appear. Click the Find tab.  
Type in the word or phrase you‟re searching for and click Find 

Find Next to locate all occurrences of the specified word or phrase, or 
click Cancel to close the window.  
Word will tell you when all occurrences of the word or phrase have been displayed. 
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but I still 

like to begin a piece of text on a new page? Perhaps 
right position? 

And then when you changed something on the previous page, the entire line count became 

 

Find Next to locate all occurrences of the specified word or phrase, or 

Word will tell you when all occurrences of the word or phrase have been displayed.  
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Text effects with WordArt

and 3D? Check out the WordArt functions! 
1. Select the text to which you want to add WordArt 

effects.  
2. Click the WordArt button on the Insert ribbon. 
3. A selection of WordArt design options will appear. 

4. Click on a design optio
5. The Edit WordArt Text dialog box will allow you to change the font style and size. 

Click OK to accept the settings. 

6. Your selected text will be transformed by the WordArt you have chosen! 
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Text effects with WordArt: How would you like to create cool text effects with shadows 
and 3D? Check out the WordArt functions!  

Select the text to which you want to add WordArt 

Click the WordArt button on the Insert ribbon.  
A selection of WordArt design options will appear.  

 
Click on a design option to select it.  
The Edit WordArt Text dialog box will allow you to change the font style and size. 
Click OK to accept the settings.  

Your selected text will be transformed by the WordArt you have chosen! 
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ool text effects with shadows 

The Edit WordArt Text dialog box will allow you to change the font style and size. 

 
Your selected text will be transformed by the WordArt you have chosen!  
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CHECK YOUR PROGRESS-II 
 

Perform following Activity:  

 

Page layout and graphics: In this exercise, you’ll create a brochure that can be used for 
advertising a business. The brochure will be printed in “landscape mode”, and set in 
columns so that it can be folded in three to stand upright on a counter top.  
 

1. Open MS Word Start MS Word, open a new blank document and save it in your 
home director with the name “Brochure”.  

2. Formatting Under the Page Layout tab, set the page Orientation to be Landscape. 
Set the top and bottom Margins to be 2.5 cm each, and the left and right margins to 
be 1 cm each.  

3. Columns Use the Columns button and select More Columns. Choose a three 
column layout with equal column width, and with Spacing of 2 cm. Click OK to 
confirm your settings, and then save your file again. The ruler bar above your 
document should display the columns that you have set up.  

4. Insert Word Art Under the Insert tab, click WordArt in the Text section of the 
ribbon. Select any Word Art style and type the word SHARP. When you close the 
Word Art window, the word SHARP should be positioned at the top of your first 
column. Drag the borders if necessary to fit the width of the column. Press Enter 
twice below the Word Art box.  

5. Insert a Text Box Go back to the Insert tab, click the Text box button and select a 
Simple text box. Inside the text box type the words Hair Salon. Change the font to 
be Verdana 48 point, and centre align the text. Format the font colour to your own 
choice. Right click on the text box border and format the text box to have no line 
visible. Press enter twice below your text box.  

6. Insert a picture Use Insert > ClipArt to insert a picture below your text box. Drag 
the edges to resize it if necessary. Column one should now contain the word 
SHARP in Word Art, the words “Hair Salon” in a text box, and a clip art picture. 
You can use Print Preview to see how the column looks. Save your document 
again.  

7. Enter text in Column Two Press Enter until your cursor is at the top of the second 
column. Then type the following text in 20 point Verdana: At Sharp Hair Salon we 
know how to style your hair! We offer hair cuts, treatments, braids, extensions and 
dreadlocks at affordable prices. Try us - we guarantee you won’t regret it. Contact 
082 678123 for prices and appointments.  
 

8. Insert pictures Search on the Internet for some pictures of hair styles and insert 
them in the third column. Size them appropriately. (If you are feeling adventurous, 
then you can click on your clip art picture in column one, delete it, and replace it 
with an Internet picture as well.) Use Print Preview to see what your brochure looks 
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like, and save your document. Tip: to find pictures, go to www.google.com and 
click on the Images hyperlink on the Google search page. 

 
Your document should look similar to the example shown (in reduced si
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like, and save your document. Tip: to find pictures, go to www.google.com and 

Your document should look similar to the example shown (in reduced size) below. 
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2.6 MS- EXCEL  

Microsoft Excel is a spreadsheet editor that originally competed with the dominant Lotus 
1-2-3 and eventually outsold it. Microsoft released the first version of Excel for the Mac 
OS in 1985 and the first Windows version (numbered 2.05 to line up with the Mac) in 
November 1987. 
 

2.6.1  Introduction to MS Excel 

 

Getting started with Excel : Excel and Word have a lot in common, since they both 
belong to the MS Office suite of programs. This means that if you are familiar with Word, 
then you already know how to use several Excel features!  
 
In the Word section of this manual, you’ll be able to find more information and guidance 
on  

1. Using the mouse and keyboard  
2. Starting the program  
3. The Office button and ribbon  
4. Character formatting  
5. Opening, saving and printing files  
6. Accessing Help  

 

What is Excel: Excel is all about numbers! There’s almost no limit to what you can do 
with numbers in Excel, including sorting, advanced calculations, and graphing. In addition, 
Excel’s formatting options mean that whatever you do with your numbers, the result will 
always look professional!  
 
Data files created with Excel are called workbooks (in the same way as Word files are 
called documents). But where Word starts up with a single blank page, Excel files by 
default contain three blank worksheets. This gives you the flexibility to store related data 
in different locations within the same file. More worksheets can be added, and others 
deleted, as required.  
 
You’ll often hear Excel files referred to as spreadsheets. This is a generic term, which 
sometimes means a workbook (file) and sometimes means a worksheet (a page within the 
file). For the sake of clarity, I’ll be using the terms workbook and worksheet in this 
manual.  

 

The Excel 2007 window: As in Word 2007, the old menu system has been replaced by the 
Ribbon and the Office button. The title bar displays the name of your current workbook. 
Tabs at the bottom of the screen identify the different worksheets available to you – I’ll 
show you a little later how to give them meaningful names.  
 
Notice how the working area of the screen is divided into rows (1, 2, 3, 4, ...) and columns 
(A, B, C, D, …). Together these provide an address, such a C10 or G21, that uniquely 
identifies each cell in the worksheet. A range of cells extends in a rectangle from one cell 
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to another, and is referred to by using the first and last cell addresses separated by a colon. 
For example, the group of cells 
 
In the example above, the current or active cell is B7. It is surrounded by a heavy black 
border, and its address is displayed in the name box above column A. Its row and column 
numbers are also highlighted.
 

 
 
On the right of the name box is the 
formula bar. This displays the value 
stored in the active cell, and is also the 
place where you would enter a new 
data value or formula into that cell. 

 

Starting Excel: If you have an icon on 
the desktop for Excel, the
to do is double-click it to open Excel.
 
Alternatively, click the Start button and 
then select All Programs, Microsoft 
Office, Microsoft Excel.
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to another, and is referred to by using the first and last cell addresses separated by a colon. 
For example, the group of cells from A3 to G4 would be written as A3:G4. 

In the example above, the current or active cell is B7. It is surrounded by a heavy black 
border, and its address is displayed in the name box above column A. Its row and column 
numbers are also highlighted. 

On the right of the name box is the 
formula bar. This displays the value 
stored in the active cell, and is also the 
place where you would enter a new 
data value or formula into that cell.  

If you have an icon on 
the desktop for Excel, then all you have 

click it to open Excel. 

Alternatively, click the Start button and 
then select All Programs, Microsoft 
Office, Microsoft Excel. 
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to another, and is referred to by using the first and last cell addresses separated by a colon. 
from A3 to G4 would be written as A3:G4.  

In the example above, the current or active cell is B7. It is surrounded by a heavy black 
border, and its address is displayed in the name box above column A. Its row and column 
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• When you open Excel from a desktop icon or from the Start menu, a new empty 
workbook (consisting of three worksheets) will be displayed on your screen. 

• If you double-click on an existing Excel file from inside the Windows Explorer 
window, then Excel will open and display the selected file on your screen. 

 

Closing Excel : Close Excel by clicking
 

 

 

NAVIGATING WITHIN A WORKSHEET

Using the mouse:  

• Use the vertical and horizontal scroll bars if you want to move to an area of the 
screen that is not currently visible. 

• To move to a different worksheet, just c
 

Using the keyboard:  

• Use the arrow keys, or [PAGE UP] and [PAGE DOWN], to move to a different 
area of the screen.  

• [CTRL] + [HOME} will take you to cell A1. 

• [CTRL] + [PAGE DOWN] will take you to the next worksheet, o
[PAGE UP] for the preceding worksheet. 

You can jump quickly to a specific cell by pressing [F5] and typing in the cell address. 
You can also type the cell address in the name box above column A, and press [ENTER]. 
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When you open Excel from a desktop icon or from the Start menu, a new empty 
ting of three worksheets) will be displayed on your screen.  

click on an existing Excel file from inside the Windows Explorer 
window, then Excel will open and display the selected file on your screen.  

Close Excel by clicking the X on the far right of the title bar. 

 

NAVIGATING WITHIN A WORKSHEET 

Use the vertical and horizontal scroll bars if you want to move to an area of the 
screen that is not currently visible.  

To move to a different worksheet, just click on the tab below the worksheet.  

Use the arrow keys, or [PAGE UP] and [PAGE DOWN], to move to a different 

[CTRL] + [HOME} will take you to cell A1.  

[CTRL] + [PAGE DOWN] will take you to the next worksheet, or use [CTRL] + 
[PAGE UP] for the preceding worksheet.  

You can jump quickly to a specific cell by pressing [F5] and typing in the cell address. 
You can also type the cell address in the name box above column A, and press [ENTER]. 
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When you open Excel from a desktop icon or from the Start menu, a new empty 
 

click on an existing Excel file from inside the Windows Explorer 

Use the vertical and horizontal scroll bars if you want to move to an area of the 

 

Use the arrow keys, or [PAGE UP] and [PAGE DOWN], to move to a different 

r use [CTRL] + 

You can jump quickly to a specific cell by pressing [F5] and typing in the cell address. 
You can also type the cell address in the name box above column A, and press [ENTER].  
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SELECTING CELLS

Using the mouse:  

• Click on a cell to select it. 

• You can select a range of adjacent cells by clicking on the first one, and then 
dragging the mouse over the others. 

• You can select a set of non
holding down t

 

Using the keyboard: 

• Use the arrow keys to move to the desired cell, which is automatically selected. 

• To select multiple cells, hold down the [SHIFT] key while the first cell is active, 
and then use the arrow ke

 
Selecting rows or columns

number (1, 2, 3, etc) at the left edge of the worksheet. Hold down the mouse button and 
drag across row numbers to select mu
to select a set of non-adjacent rows. 
 
Similarly, to select all the cells in column, you should click on the column heading (A, B, 
C, etc) at the top edge of the worksheet. Hold down the mouse button and 
column headings to select multiple adjacent columns. Hold down [CTRL] if you want to 
select a set of non-adjacent columns. 
 
You can quickly select all the cells in a worksheet by clicking the square to the immediate 
left of the Column A headin
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SELECTING CELLS  

Click on a cell to select it.  

You can select a range of adjacent cells by clicking on the first one, and then 
dragging the mouse over the others.  

You can select a set of non-adjacent cells by clicking on the first one, and then 
holding down the [CTRL] key as you click on the others.  

Using the keyboard:  

Use the arrow keys to move to the desired cell, which is automatically selected. 

To select multiple cells, hold down the [SHIFT] key while the first cell is active, 
and then use the arrow keys to select the rest of the range.  

Selecting rows or columns: To select all the cells in a particular row, just click on the row 
number (1, 2, 3, etc) at the left edge of the worksheet. Hold down the mouse button and 
drag across row numbers to select multiple adjacent rows. Hold down [CTRL] if you want 

adjacent rows.  

Similarly, to select all the cells in column, you should click on the column heading (A, B, 
C, etc) at the top edge of the worksheet. Hold down the mouse button and 
column headings to select multiple adjacent columns. Hold down [CTRL] if you want to 

adjacent columns.  

You can quickly select all the cells in a worksheet by clicking the square to the immediate 
left of the Column A heading (just above the label for Row 1). 
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You can select a range of adjacent cells by clicking on the first one, and then 

adjacent cells by clicking on the first one, and then 

Use the arrow keys to move to the desired cell, which is automatically selected.  

To select multiple cells, hold down the [SHIFT] key while the first cell is active, 

To select all the cells in a particular row, just click on the row 
number (1, 2, 3, etc) at the left edge of the worksheet. Hold down the mouse button and 

ltiple adjacent rows. Hold down [CTRL] if you want 

Similarly, to select all the cells in column, you should click on the column heading (A, B, 
C, etc) at the top edge of the worksheet. Hold down the mouse button and drag across 
column headings to select multiple adjacent columns. Hold down [CTRL] if you want to 

You can quickly select all the cells in a worksheet by clicking the square to the immediate 
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ENTERING DATA  
 

First you need a workbook: Before you start entering data, you need to decide whether 
this is a completely new project deserving a workbook of its own, or whether the data you 
are going to enter relates to an existing workbook. Remember that you can always add a 
new worksheet to an existing workbook, and 
related data if it’s all stored in the same file. 
 

If you need to create a new workbook from inside Excel: 

1. Click on the Office button, select New and then Blank Workbook. 
2. Sheet 1 of a new workbook will be displayed on your screen, with cell A1 active. 

 

To open an existing workbook from inside Excel: 

1. Click on the Office button, click Open, and then navigate t
containing the file you want to open. 

2. Double-click on the required file name. 

 

Overview of data types: Excel allows you to enter different sorts of data into the cells on 
a worksheet, such as dates, text, and numbers. If you unders
different types of data, you‟ll be able to structure your worksheet as efficiently as possible. 
 

• Numbers lie at the heart of Excel
variety of different ways – 
mixing text and numbers in a single cell, since Excel will regard the cell contents as 
text, and won‟t include the embedded number in calculations. If you type any 
spaces within a number, it will also be regarded as text. 

 

 
Note that dates and times are stored as numbers in Excel, so that you can calculate 
the difference between two dates. However, they are usually displayed as if they 
are text.  
 
If a number is too large to be displayed in the current cell, it will be displayed
“#####”. The formatting section of this manual explains how to widen a column. 
 

• Text consist mainly of alphabetic characters, but can also include numbers, 
punctuation marks and special characters (like the check mark in the example 
above). Text fields are not included in numeric calculations. If you want Excel to 
treat an apparent number as text, then you should precede the number with a single 
quotation mark („). This can be useful when entering for example a phone number 
that starts with 0, since leading zeros are not usually displayed for Excel numbers. 
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Before you start entering data, you need to decide whether 
this is a completely new project deserving a workbook of its own, or whether the data you 

tes to an existing workbook. Remember that you can always add a 
new worksheet to an existing workbook, and you’ll find it much easier to work with 

all stored in the same file.  

If you need to create a new workbook from inside Excel:  

Click on the Office button, select New and then Blank Workbook.  
Sheet 1 of a new workbook will be displayed on your screen, with cell A1 active. 

To open an existing workbook from inside Excel:  

Click on the Office button, click Open, and then navigate to the drive and folder 
containing the file you want to open.  

click on the required file name.  

Excel allows you to enter different sorts of data into the cells on 
a worksheet, such as dates, text, and numbers. If you understand how Excel treats the 

‟ll be able to structure your worksheet as efficiently as possible. 

lie at the heart of Excel‟s functionality. They can be formatted in a 
 we‟ll get to that later. You should generally avoid 

mixing text and numbers in a single cell, since Excel will regard the cell contents as 
‟t include the embedded number in calculations. If you type any 

spaces within a number, it will also be regarded as text.  

e that dates and times are stored as numbers in Excel, so that you can calculate 
the difference between two dates. However, they are usually displayed as if they 

If a number is too large to be displayed in the current cell, it will be displayed
“#####”. The formatting section of this manual explains how to widen a column. 

consist mainly of alphabetic characters, but can also include numbers, 
punctuation marks and special characters (like the check mark in the example 

ds are not included in numeric calculations. If you want Excel to 
treat an apparent number as text, then you should precede the number with a single 
quotation mark („). This can be useful when entering for example a phone number 

eading zeros are not usually displayed for Excel numbers. 
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Before you start entering data, you need to decide whether 
this is a completely new project deserving a workbook of its own, or whether the data you 

tes to an existing workbook. Remember that you can always add a 
find it much easier to work with 

Sheet 1 of a new workbook will be displayed on your screen, with cell A1 active.  

o the drive and folder 

Excel allows you to enter different sorts of data into the cells on 
tand how Excel treats the 

‟ll be able to structure your worksheet as efficiently as possible.  

‟s functionality. They can be formatted in a 
ou should generally avoid 

mixing text and numbers in a single cell, since Excel will regard the cell contents as 
‟t include the embedded number in calculations. If you type any 

 

e that dates and times are stored as numbers in Excel, so that you can calculate 
the difference between two dates. However, they are usually displayed as if they 

If a number is too large to be displayed in the current cell, it will be displayed as  
“#####”. The formatting section of this manual explains how to widen a column.  

consist mainly of alphabetic characters, but can also include numbers, 
punctuation marks and special characters (like the check mark in the example 

ds are not included in numeric calculations. If you want Excel to 
treat an apparent number as text, then you should precede the number with a single 
quotation mark („). This can be useful when entering for example a phone number 

eading zeros are not usually displayed for Excel numbers.  
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If a text field is too long to be displayed in the current cell, it will spill over into the 
next cell if that cell is empty, otherwise it will be truncated at the cell border. The 
formatting section of this manual explains how to wrap text within a cell.  
 

• Formulas are the most powerful elements of an Excel spreadsheet. Every formula 
starts with an “=” sign, and contains at least one logical or mathematical operation 
(or special function), combined with numbers and/or cell references.  

 

Data entry cell by cell  
To enter either numbers or text:  

1. Click on the cell where you want the data to be stored, so that the cell becomes 
active.  

2. Type the number or text.  
3. Press [ENTER] to move to the next row, or [TAB] to move to the next column. 

Until you‟ve pressed [ENTER] or [TAB], you can cancel the data entry by pressing 
[ESC].  

 
To enter a date, use a slash or hyphen between the day, month and year, for example 
14/02/2009. Use a colon between hours, minutes and seconds, for example 13:45:20.  

 

DELETING DATA  
You want to delete data that’s already been entered in a worksheet? Simple!  

1. Select the cell or cells containing data to be deleted.  
2. Press the [DEL] key on your keyboard.  
3. The cells remain in the same position as before, but their contents are deleted.  

 
Moving data: You’ve already entered some data, and want to move it to a different area 
on the worksheet?  

1. Select the cells you want to move (they will become highlighted).  
2. Move the cursor to the border of the highlighted cells. When the cursor changes 

from a white cross to a four-headed arrow (the move pointer), hold down the left 
mouse button.  

 

 
 

3. Drag the selected cells to a new area of the worksheet, then release the mouse 
button.  

4. You can also cut the selected data using the ribbon icon or [CTRL] + [X], then 
click in the top left cell of the destination area and paste the data with the ribbon 
icon or [CTRL] + [V].  
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Copying data:  
To copy existing cell contents to another area on the worksheet: 
 

1. Select the cells you want to copy (they will become highlighted).  
2. Move the cursor to the border of the highlighted cells while holding down the 

[CTRL] key. When the cursor changes from a white cross to a hollow left-pointing 
arrow (the copy pointer), hold down the left mouse button.  

 
 

3. Drag the selected cells to a second area of the worksheet, then release the mouse 
button.  

You can also copy the selected data using the ribbon icon or [CTRL] + [C], then click in 
the top left cell of the destination area and paste the data with the ribbon icon or [CTRL] + 
[V].  
 
To copy the contents of one cell to a set of adjacent cells, select the initial cell and then 
move the cursor over the small square in the bottom right-hand corner (the fill handle). 

 
 
The cursor will change from a white cross to a black cross. Hold down the mouse button 
and drag to a range of adjacent cells. The initial cell contents will be copied to the other 
cells.  
 
Note that if the original cell contents end with a number, then the number will be 
incremented in the copied cells. 
 

 
 
Using Auto fill : This is one of Excel’s niftiest features! It takes no effort at all to repeat a 
data series (such as the days of the week, months of the year, or a numbers series such as 
odd numbers) over a range of cells.  

1. Enter the start of the series into a few adjacent cells (enough to show the underlying 
pattern).  

2. Select the cells that contain series data.  
3. Move the cursor over the small square in the bottom right-hand corner of the 

selection (the fill handle). Hold down the mouse button and drag to a range of 
adjacent cells.  
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4. The target cells will be filled based on the pattern of the original series cells.  

 

Saving a workbook: So now it’s time to save your work. As usual, you need to specify the 
file name, and its location (drive and folder).  

1. Click the Office button and select Save, or click the Save icon on the Quick Access 
toolbar. If this workbook has been saved before, then that’s it – your workbook will 
be saved again with the same name and location.  

2. If it’s the first time of saving this workbook, then the Save As dialogue box will 
open.  

3. Click the drop-down arrow next to Save In to select the desired drive and folder.  
4. Type the new file name in the File Name field.  
5. Click the Save button.  

 

 
 

2.6.2  Editing and Formatting in MS Excel 

 
Editing data: In data entry mode, when you move the cursor to a new cell, anything you 
type replaces the previous cell contents. Edit mode allow you to amend existing cell 
contents without having to retype the entire entry. Note that while you are in edit mode, 
many of the Ribbon commands are disabled.  

 

Editing cell contents: There are two different ways to enter edit mode: either double-click 
on the cell whose contents you want to edit, or else click to select the cell you want to edit, 
and then click anywhere in the formula bar.  

1. To delete characters, use the [BACKSPACE] or [DEL] key.  
2. To insert characters, click where you want to insert them, and then type. You can 

toggle between insert and overtype mode by pressing the [INSERT] key.  
3. You can force a line break within the current cell contents by typing [ALT] + 

[ENTER].  
 
Exit edit mode by pressing [ENTER]. 
 

 
 



   

Application of Computers in Hospitality

Uttarakhand Open University 

Inserting or deleting cells: You can insert a new cell above the current active cell, in 
which case the active cell and those below it will each move down 
one row. You can also insert a new cell to the left of the current 
active cell, in which case the active cell and those on its right will 
each move one column to the right.  
 

To insert a cell:  

1. Select the cell next to which you want to 
insert a new cell.  

2. On the Home ribbon, find the Cells group 
and click Insert followed by Insert Cells. 

3. A dialog box will open. Click the direction in 
which you want the surrounding cells to 
shift.  

 
 

 

To delete a cell, do as follows

group and click Delete 
followed by Delete 
Cells. 

box will open. Click the 
direction in which you 
want the surrounding 
cells to shift. 

You can also right-click on the active cell and select Insert or Delete on the pop

 

Inserting or deleting rows: When you insert a row, the new row will be positioned above 
the row containing the active cell.  

1. Select a cell in the row above which you want to insert a new row. 
2. On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

Rows.  
3. A new row will be inserted above the current row. 

 

To delete a row, do as follows: 

1. Select a cell in the row that you want to delete. 
2. On the Home ribbon, find the C

Sheet Rows.  
3. The row containing the active cell will be deleted. All the rows below it will move 

up by one.  
You can also right-click on the active cell and use the pop
row.  
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You can insert a new cell above the current active cell, in 
and those below it will each move down 

one row. You can also insert a new cell to the left of the current 
the active cell and those on its right will 

to which you want to 

On the Home ribbon, find the Cells group 
and click Insert followed by Insert Cells.  
A dialog box will open. Click the direction in 
which you want the surrounding cells to 

 

To delete a cell, do as follows:  

1. Select the cell that you want to delete. 
2. On the Home ribbon, find the Cells 

group and click Delete 
followed by Delete 
Cells.  

3. A dialog 
box will open. Click the 
direction in which you 
want the surrounding 
cells to shift.  

e active cell and select Insert or Delete on the pop-up menu. 

When you insert a row, the new row will be positioned above 

Select a cell in the row above which you want to insert a new row.  
On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

A new row will be inserted above the current row.  

Select a cell in the row that you want to delete.  
On the Home ribbon, find the Cells group and click Delete followed by Delete 

The row containing the active cell will be deleted. All the rows below it will move 

click on the active cell and use the pop-up menu to insert or delete a 
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You can insert a new cell above the current active cell, in 

Select the cell that you want to delete.  
On the Home ribbon, find the Cells 

up menu.  

When you insert a row, the new row will be positioned above 

On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

ells group and click Delete followed by Delete 

The row containing the active cell will be deleted. All the rows below it will move 

up menu to insert or delete a 
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Inserting or deleting columns

positioned on the left of the column containing the active cell. 
1. Select a cell in the column to the left of which you want to insert a new column. 
2. On the Home ribbon, find the C

Columns.  
3. A new column will be inserted to the left of the current column. 

 

To delete a column, do as follows: 

1. Select a cell in the column that you want to delete. 
2. On the Home ribbon, find the Cells g

Sheet Columns. 
3. The column containing the active cell will be deleted. All the columns on its right 

will move left by one. 
 
You can also right-click on the active cell and use the pop
column.  

 

Inserting or deleting a worksheet

worksheets, just click the Insert Worksheet tab at the bottom of the screen.
 

 

To insert a new worksheet before an existing worksheet, do as follows:

1. Select the worksheet before which you want to insert a new worksheet. 
2. On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet. 
3. A new worksheet will be inserted before the current worksheet. 

 

To delete a worksheet, 

1. Select the worksh
2. On the Home ribbon, find the Cells group and click Delete followed by Delete 

Sheet.  
3. The current worksheet will be deleted. 

 

Moving or copying a worksheet 

Right-click on the worksheet tab, and select Move or 
Copy from the pop-up menu. A dialog box will open: 
 
The To Book field allows you to move or copy the 
current worksheet to another workbook. 
 
The Before Sheet field allows you to specify the new 
position of the worksheet. 
 
The Create a Copy checkbox lets you specify 
whether the worksheet should be moved or copied.
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erting or deleting columns: When you insert a column, the new column will be 
positioned on the left of the column containing the active cell.  

Select a cell in the column to the left of which you want to insert a new column. 
On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

A new column will be inserted to the left of the current column. 

To delete a column, do as follows:  

Select a cell in the column that you want to delete.  
On the Home ribbon, find the Cells group and click Delete followed by Delete 
Sheet Columns.  
The column containing the active cell will be deleted. All the columns on its right 
will move left by one.  

click on the active cell and use the pop-up menu to insert or delete a 

Inserting or deleting a worksheet: To insert a new worksheet at the end of the existing 
worksheets, just click the Insert Worksheet tab at the bottom of the screen.

To insert a new worksheet before an existing worksheet, do as follows:

the worksheet before which you want to insert a new worksheet. 
On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet. 
A new worksheet will be inserted before the current worksheet. 

To delete a worksheet,  

Select the worksheet that you want to delete.  
On the Home ribbon, find the Cells group and click Delete followed by Delete 

The current worksheet will be deleted.  

Moving or copying a worksheet  
click on the worksheet tab, and select Move or 

up menu. A dialog box will open:  

The To Book field allows you to move or copy the 
current worksheet to another workbook.  

The Before Sheet field allows you to specify the new 
position of the worksheet.  

The Create a Copy checkbox lets you specify 
ether the worksheet should be moved or copied. 
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When you insert a column, the new column will be 

Select a cell in the column to the left of which you want to insert a new column.  
ells group and click Insert followed by Insert Sheet 

A new column will be inserted to the left of the current column.  

roup and click Delete followed by Delete 

The column containing the active cell will be deleted. All the columns on its right 

up menu to insert or delete a 

To insert a new worksheet at the end of the existing 
worksheets, just click the Insert Worksheet tab at the bottom of the screen. 

 

To insert a new worksheet before an existing worksheet, do as follows: 

the worksheet before which you want to insert a new worksheet.  
On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet.  
A new worksheet will be inserted before the current worksheet.  

On the Home ribbon, find the Cells group and click Delete followed by Delete 
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Renaming a worksheet: Right-click on the worksheet tab, and select Rename from the 
pop-up menu. Type the new worksheet name and press [ENTER].
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click on the worksheet tab, and select Rename from the 
up menu. Type the new worksheet name and press [ENTER]. 
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click on the worksheet tab, and select Rename from the 
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FORMATTING DATA 

Cell formatting  
The icons on the Home rib
any of these, just select the cell or cells that you want to format, and then click the desired 
icon. Commonly used formatting attributes include:
 

 
 
The Format Painter allows you to copy for
cells.  

1. Select the cell whose formatting attributes you want to copy. 

2. Click on the Format Painter icon. 
3. Select the cell or range of cells that you want to have the same formatting 

attributes.  
 
The cell values will remain as before, but their format will change. 

 

Formatting rows and columns

applied to all the cells contained in one or more rows or columns. Simply select the rows 
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FORMATTING DATA  

The icons on the Home ribbon provide you with a variety of formatting options. To apply 
any of these, just select the cell or cells that you want to format, and then click the desired 
icon. Commonly used formatting attributes include: 

The Format Painter allows you to copy formatting attributes from one cell to a range of 

Select the cell whose formatting attributes you want to copy.  

Click on the Format Painter icon.  
Select the cell or range of cells that you want to have the same formatting 

ues will remain as before, but their format will change.  

Formatting rows and columns: Any of the cell formatting options above can easily be 
applied to all the cells contained in one or more rows or columns. Simply select the rows 
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bon provide you with a variety of formatting options. To apply 
any of these, just select the cell or cells that you want to format, and then click the desired 

 

matting attributes from one cell to a range of 

 

Select the cell or range of cells that you want to have the same formatting 

Any of the cell formatting options above can easily be 
applied to all the cells contained in one or more rows or columns. Simply select the rows 
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or columns by clicking on the row or column labels, and then click on the formatting icons 
that you want to apply.  
You may also want to adjust the width of a column: 

• To manually adjust the width, click and drag the boundary between two column 

headings. 
 

• To automatically adjust the width, select the required columns, and then in the Cell 
group on the Home ribbon, select Format, Cell Size, Autofit Column Width. 

 

 

• To specify an exact column width, select the columns, and then in the Cell group 
on the Home ribbon, select Forma
you want.  

 

To adjust the height of a row:  

• To manually adjust the height, click and drag the boundary between two row labels. 

• To automatically adjust the height, select the required rows, and then in the C
group on the Home ribbon, select Format, Cell Size, Autofit Row Height. 

• To set a row or rows to a specific height, select the rows, and then in the Cell group 
on the Home ribbon, select Format, Cell Size, Row Height, and type the value that 
you want.  

 
Hiding rows and columns: If your spreadsheet contains sensitive data that you don’t want 
displayed on the screen or included in printouts, then you can hide the corresponding rows 
or columns. The cell values can still be used for calculations, but will b
 
The easiest way to hide or unhide a row or column is to select the row or column heading, 
right-click to view the pop-up menu, and then select Hide or Unhide. 
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on the row or column labels, and then click on the formatting icons 

You may also want to adjust the width of a column:  

To manually adjust the width, click and drag the boundary between two column 

 

st the width, select the required columns, and then in the Cell 
group on the Home ribbon, select Format, Cell Size, Autofit Column Width.  

 

To specify an exact column width, select the columns, and then in the Cell group 
on the Home ribbon, select Format, Cell Size, Column Width, and type the value 

 

To manually adjust the height, click and drag the boundary between two row labels. 

To automatically adjust the height, select the required rows, and then in the C
group on the Home ribbon, select Format, Cell Size, Autofit Row Height.  

To set a row or rows to a specific height, select the rows, and then in the Cell group 
on the Home ribbon, select Format, Cell Size, Row Height, and type the value that 

If your spreadsheet contains sensitive data that you don’t want 
displayed on the screen or included in printouts, then you can hide the corresponding rows 
or columns. The cell values can still be used for calculations, but will be hidden from view.

The easiest way to hide or unhide a row or column is to select the row or column heading, 
up menu, and then select Hide or Unhide.  
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on the row or column labels, and then click on the formatting icons 

To manually adjust the width, click and drag the boundary between two column 

st the width, select the required columns, and then in the Cell 
 

To specify an exact column width, select the columns, and then in the Cell group 
t, Cell Size, Column Width, and type the value 

To manually adjust the height, click and drag the boundary between two row labels.  

To automatically adjust the height, select the required rows, and then in the Cell 

To set a row or rows to a specific height, select the rows, and then in the Cell group 
on the Home ribbon, select Format, Cell Size, Row Height, and type the value that 

If your spreadsheet contains sensitive data that you don’t want 
displayed on the screen or included in printouts, then you can hide the corresponding rows 

e hidden from view. 

The easiest way to hide or unhide a row or column is to select the row or column heading, 
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Alternatively, you can click the Format icon on the Home ribbon, and selec
Unhide option. 
 

 
Keeping row and column headings in view

worksheet, you’ll probably lose sight of the column headings as they disappear off the top 
of your “page”. This can make life really difficul
result for tutorial 8 in row 183 of the 
worksheet! And it’s even more difficult if 
the student’s name in column A has 
scrolled off the left edge of the window. 
 
The Freeze Panes feature allows you to 

the first option. If Freeze Panes has already been applied, then the ribbon option 
automatically changes to Unfreeze Panes.
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Alternatively, you can click the Format icon on the Home ribbon, and selec

Keeping row and column headings in view: If you scroll through a lot of data in a 
worksheet, you’ll probably lose sight of the column headings as they disappear off the top 
of your “page”. This can make life really difficult – imagine trying to check a student’s 
result for tutorial 8 in row 183 of the 
worksheet! And it’s even more difficult if 
the student’s name in column A has 
scrolled off the left edge of the window.  

The Freeze Panes feature allows you to 

specify particular rows and columns that will 
always remain visible as you scroll through the 
worksheet. And it’s easy to do! Select a cell 
immediately below the rows that you want to 
remain visible, and immediately to the right of the 
columns that you want to remain vi
example, if you want to be able to see Rows 1 and 
2, and column A, then you would click on cell B3.
 
On the View tab, click Freeze Panes, and select 

the first option. If Freeze Panes has already been applied, then the ribbon option 
changes to Unfreeze Panes. 
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Alternatively, you can click the Format icon on the Home ribbon, and select the Hide & 

 

If you scroll through a lot of data in a 
worksheet, you’ll probably lose sight of the column headings as they disappear off the top 

imagine trying to check a student’s 

ular rows and columns that will 
always remain visible as you scroll through the 
worksheet. And it’s easy to do! Select a cell 
immediately below the rows that you want to 
remain visible, and immediately to the right of the 
columns that you want to remain visible. For 
example, if you want to be able to see Rows 1 and 
2, and column A, then you would click on cell B3. 

On the View tab, click Freeze Panes, and select 
the first option. If Freeze Panes has already been applied, then the ribbon option 
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2.6.3 Formulas, Functions and Data Manipulation in MS Excel 

 
Functions: Excel provides a wide range of built-in functions that can be included in your 
formulas to save you the effort of having to specify detailed calculations step-by-step. Each 
function is referred to by a specific name, which acts as a kind of shorthand for the 
underlying calculation.  
 
Because a function is used inside a formula, you’ll still need to start off with an equals sign 
to show Excel that a calculation is required.  
 
Using AutoSum: Because addition is the most frequently used Excel function, a shortcut 
has been provided to quickly add a set of numbers:  

1. Select the cell where you want the total to appear.  
2. Click on the Sum button on the Home ribbon.  
3. Check that the correct set of numbers has been selected (indicated by a dotted line). 

If not, then drag to select a different set of numbers.  
4. Press [ENTER] and the total will be calculated.  

 
Basic functions: Some of the most commonly used functions include: 

SUM() to calculate the total of a set of numbers  
AVERAGE() to calculate the average of a set of numbers  
MAX() to calculate the maximum value within a set of numbers  
MIN() to calculate the minimum value within a set of numbers  
ROUND() to round a set a values to a specified number of decimal places  
TODAY () to show the current date  
IF() to calculate a result depending on one or more conditions  

 

So how do you use a function?  

 
A function makes use of values or cell references, just like a simple formula does. The 
numbers or cell references that it needs for its calculations are placed in brackets after the 
name of the function.  
 
To give a simple illustration: 

 
 
Several popular functions are available to you directly from the Home ribbon.  

1. Select the cell where you want the result of the calculation to be displayed.  
2. Click the drop-down arrow next to the Sum button.  
3. Click on the function that you want.  
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4. Confirm the range of cells that the function should use in its calculation. (Excel will 
try to guess this for you. If you don
click and drag to make your own selection.) 

5. Press [ENTER]. The result of the calculation will be shown in the active cell. 
 
As an example, to calculate the average for the follo

1. Click on cell F3 to make it active. 
2. Click on the arrow next to the Sum button, and select Average. 
3. Press [ENTER] to accept the range of cells that is suggested (B3:E3). 

 
That’s it! You can now copy the formula i
relative addressing because you want a different set of tutorial marks to be used for each 
student. 

 
If you want to use a function that 
can click on More Functions to open the Insert Function dialog box. Another way to open 
this dialog box is to click the Insert Function icon on the immediate left of the formula bar. 
 
The Insert Function dialog box displays a list of functions within a selected function 
category.  
 
If you select a function it will briefly describe the purpose and structure of the function.
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Confirm the range of cells that the function should use in its calculation. (Excel will 
s this for you. If you don‟t like what it shows inside the dotted line, then 

click and drag to make your own selection.)  
Press [ENTER]. The result of the calculation will be shown in the active cell. 

As an example, to calculate the average for the following set of tutorial results, you would: 
Click on cell F3 to make it active.  
Click on the arrow next to the Sum button, and select Average. 
Press [ENTER] to accept the range of cells that is suggested (B3:E3). 

That’s it! You can now copy the formula in cell F3 down to cells F4 and F5 
relative addressing because you want a different set of tutorial marks to be used for each 

If you want to use a function that isn’t directly available from the drop
Functions to open the Insert Function dialog box. Another way to open 

this dialog box is to click the Insert Function icon on the immediate left of the formula bar. 

The Insert Function dialog box displays a list of functions within a selected function 

If you select a function it will briefly describe the purpose and structure of the function.
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Confirm the range of cells that the function should use in its calculation. (Excel will 
‟t like what it shows inside the dotted line, then 

Press [ENTER]. The result of the calculation will be shown in the active cell.  

wing set of tutorial results, you would:  

Click on the arrow next to the Sum button, and select Average.  
Press [ENTER] to accept the range of cells that is suggested (B3:E3).  

n cell F3 down to cells F4 and F5 – using 
relative addressing because you want a different set of tutorial marks to be used for each 

 

directly available from the drop-down list, then you 
Functions to open the Insert Function dialog box. Another way to open 

this dialog box is to click the Insert Function icon on the immediate left of the formula bar.  

The Insert Function dialog box displays a list of functions within a selected function 

If you select a function it will briefly describe the purpose and structure of the function. 
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When you click the OK button at the bottom of the
dialogue box that helps you to select the function arguments (usually the range of cells that 
the function should use). 
 

 
Some functions use more than one argument. For example, the ROUND() function needs 
to know not only which cells to use, but also how many decimal places those cells should 
be rounded to. So the expression =ROUND(G5:G8, 0) will round the values in cells G5 to 
G8 to the nearest whole number (i.e. no decimal places).
 

 

 

The IF() function: The IF() function is getting a section all of its own, because for many 
people it‟s not as intuitive to understand as the common maths and stats functions. 
 
The IF() function checks for a specific condition. If the condition is met, then one action is 
taken; if the condition is not met, then a different action is taken. For example, you may be 
reviewing a set of tutorial marks. If a student’s average mark is below 50, then the cell 
value should be FAIL; so the condition you are checking is whether or not the average 
result is below 50. If this condition is not met (that is, the average result is 50 or more), 
then the cell value should be PASS.  
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When you click the OK button at the bottom of the window, you‟ll be taken to a second 
dialogue box that helps you to select the function arguments (usually the range of cells that 

Some functions use more than one argument. For example, the ROUND() function needs 
only which cells to use, but also how many decimal places those cells should 

be rounded to. So the expression =ROUND(G5:G8, 0) will round the values in cells G5 to 
G8 to the nearest whole number (i.e. no decimal places). 

nction is getting a section all of its own, because for many 
‟s not as intuitive to understand as the common maths and stats functions.  

The IF() function checks for a specific condition. If the condition is met, then one action is 
condition is not met, then a different action is taken. For example, you may be 

reviewing a set of tutorial marks. If a student’s average mark is below 50, then the cell 
value should be FAIL; so the condition you are checking is whether or not the average 
result is below 50. If this condition is not met (that is, the average result is 50 or more), 
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‟ll be taken to a second 
dialogue box that helps you to select the function arguments (usually the range of cells that 

 

Some functions use more than one argument. For example, the ROUND() function needs 
only which cells to use, but also how many decimal places those cells should 

be rounded to. So the expression =ROUND(G5:G8, 0) will round the values in cells G5 to 

 

nction is getting a section all of its own, because for many 

The IF() function checks for a specific condition. If the condition is met, then one action is 
condition is not met, then a different action is taken. For example, you may be 

reviewing a set of tutorial marks. If a student’s average mark is below 50, then the cell 
value should be FAIL; so the condition you are checking is whether or not the average 
result is below 50. If this condition is not met (that is, the average result is 50 or more), 
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Let’s see this in action: 
 
The structure of an IF() function is:
 

=IF (condition, result if true, result if false) 
Using English to describe our example as an IF statement: IF the average mark is less than 
50, then display the word “FAIL”, else display the word “PASS”. 
Now for a real worksheet example. Look at the formula bar in the screenshot below:
 

 
 
Do you follow how the formula in cell G4 was constructed? Because the average mark is 
stored in cell F4, we need to check whether the value in F4 is less than 50. If it is, then the 
active cell (G4) must display the word “Fail”. If the value in F4 is not less than 50, then t
active cell must display the word “Pass”. 

 

Nested functions  
Take a deep breath and don
include one function inside another. 
 
In the example above, 
outcome. But we could have done it all in a single step, by using the following formula in 
row 3:  
=IF(AVERAGE(B3:E3) < 50, “FAIL”, “PASS”)
 
In this IF statement, I’ve
been replaced with a function that calculates the average tutorial mark, and then checks it 
against the same condition as before (“< 50”), with the same possible outcomes. Doing it 
this way, you wouldn’t
 
Of course, in real life 
and would probably want to keep the Average column to explain the outcome 
allocated to them. So the first example using a se
simpler, it’s also more practical! 
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Let’s see this in action:  

The structure of an IF() function is: 

=IF (condition, result if true, result if false)  
nglish to describe our example as an IF statement: IF the average mark is less than 

50, then display the word “FAIL”, else display the word “PASS”.  
Now for a real worksheet example. Look at the formula bar in the screenshot below:

he formula in cell G4 was constructed? Because the average mark is 
stored in cell F4, we need to check whether the value in F4 is less than 50. If it is, then the 
active cell (G4) must display the word “Fail”. If the value in F4 is not less than 50, then t
active cell must display the word “Pass”. That’s not really so complicated, is it? 

Take a deep breath and don‟t panic! I just want to show you that if you need to, you can 
include one function inside another.  

In the example above, we first worked out the Average mark, and then the Pass/Fail 
outcome. But we could have done it all in a single step, by using the following formula in 

=IF(AVERAGE(B3:E3) < 50, “FAIL”, “PASS”) 

I’ve nested one function inside another. The reference to cell F4 has 
been replaced with a function that calculates the average tutorial mark, and then checks it 
against the same condition as before (“< 50”), with the same possible outcomes. Doing it 

wouldn’t need column F in the worksheet at all.  

Of course, in real life you’d expect to get students coming to query their Pass/Fail status, 
and would probably want to keep the Average column to explain the outcome 

them. So the first example using a separate Average and Outcome is not only 
also more practical!  
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nglish to describe our example as an IF statement: IF the average mark is less than 

Now for a real worksheet example. Look at the formula bar in the screenshot below: 

 

he formula in cell G4 was constructed? Because the average mark is 
stored in cell F4, we need to check whether the value in F4 is less than 50. If it is, then the 
active cell (G4) must display the word “Fail”. If the value in F4 is not less than 50, then the 

not really so complicated, is it?  

‟t panic! I just want to show you that if you need to, you can 

we first worked out the Average mark, and then the Pass/Fail 
outcome. But we could have done it all in a single step, by using the following formula in 

another. The reference to cell F4 has 
been replaced with a function that calculates the average tutorial mark, and then checks it 
against the same condition as before (“< 50”), with the same possible outcomes. Doing it 

expect to get students coming to query their Pass/Fail status, 
and would probably want to keep the Average column to explain the outcome that’s been 

parate Average and Outcome is not only 
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Printing: By default, Excel prints all the data on the current worksheet. If your worksheet 
extends over several pages, it’s worth making sure that the printed copy will be easily
readable. Here are a few tips.  

 

Print preview: Start by using Print Preview to see what your data will look like when 
printed.  

1. Click the Office button, select Print and then Print Preview. The Print Preview icon 
shows a dog-eared page with a magnif
 

2. The display will change to Print Preview mode. You see the document exactly as it will 
look when printed.  

3. The Show Margins option allows you to not only adjust your page margins by dragging 
them, but also to drag the column and row bounda

 

4. Now is the time to consider whether the column and row labels are easily visible, 
whether page breaks are in appropriate places, and whether you need to include page 
numbers. The following section tells you how to 

5. To close Print Preview, click the Close Print Preview button on the right of the ribbon. 

 
 
Preparing to print: Your best option is to use the Page Layout ribbon for this. (Some of 
the same options are available from inside Print Preview, bu

1. Use the Orientation button to swap between portrait and landscape mode. 

2. Use the Print Area button to select a subset of your data for printing. (The data that 
you want included in the print area should be selected before you cli

3. Use the Breaks button to insert a page break immediately above the currently active 
cell, or to remove previously specified page breaks. 
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By default, Excel prints all the data on the current worksheet. If your worksheet 
worth making sure that the printed copy will be easily

Start by using Print Preview to see what your data will look like when 

Click the Office button, select Print and then Print Preview. The Print Preview icon 
eared page with a magnifying glass.  

 
 

The display will change to Print Preview mode. You see the document exactly as it will 

The Show Margins option allows you to not only adjust your page margins by dragging 
them, but also to drag the column and row boundaries to make them narrower or wider. 

 
 

Now is the time to consider whether the column and row labels are easily visible, 
whether page breaks are in appropriate places, and whether you need to include page 
numbers. The following section tells you how to do all these.  

To close Print Preview, click the Close Print Preview button on the right of the ribbon. 

Your best option is to use the Page Layout ribbon for this. (Some of 
the same options are available from inside Print Preview, but many of them aren’t.)  

 
Use the Orientation button to swap between portrait and landscape mode.  

Use the Print Area button to select a subset of your data for printing. (The data that 
you want included in the print area should be selected before you click this icon.) 

Use the Breaks button to insert a page break immediately above the currently active 
cell, or to remove previously specified page breaks.  
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By default, Excel prints all the data on the current worksheet. If your worksheet 
worth making sure that the printed copy will be easily 

Start by using Print Preview to see what your data will look like when it’s 

Click the Office button, select Print and then Print Preview. The Print Preview icon 

The display will change to Print Preview mode. You see the document exactly as it will 

The Show Margins option allows you to not only adjust your page margins by dragging 
ries to make them narrower or wider.  

Now is the time to consider whether the column and row labels are easily visible, 
whether page breaks are in appropriate places, and whether you need to include page 

To close Print Preview, click the Close Print Preview button on the right of the ribbon.  

Your best option is to use the Page Layout ribbon for this. (Some of 
 

Use the Print Area button to select a subset of your data for printing. (The data that 
ck this icon.)  

Use the Breaks button to insert a page break immediately above the currently active 
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The Print Titles button takes you to the Page Setup dialogue box, which has four tabs that 
allow you to do a whole lot more than printing titles. 
 

The Page tab is used to set orientation and scaling. 
The Margins tab is used to adjust page margins. 
The Header/Footer tab allows you to enter a header or footer to be repeated on every page. 
This is where you would include page numbers.
 
The Sheet tab lets you specify rows that are to be repeated at the top of each sheet (such as 
column headings), and columns to be repeated at the left of each sheet (such as student 
names). You can also adjust the print 
 

 

Printing a worksheet: 

with the way it looks –
1. Click the Office button and select the Print command. 
2. The Print dialog box will 
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The Print Titles button takes you to the Page Setup dialogue box, which has four tabs that 
to do a whole lot more than printing titles.  

 
The Page tab is used to set orientation and scaling.  
The Margins tab is used to adjust page margins.  
The Header/Footer tab allows you to enter a header or footer to be repeated on every page. 

re you would include page numbers. 

The Sheet tab lets you specify rows that are to be repeated at the top of each sheet (such as 
column headings), and columns to be repeated at the left of each sheet (such as student 
names). You can also adjust the print area under this tab. 

 

Printing a worksheet: You’ve previewed your worksheet one last time, and 
– now it’s time to finally print it!  

Click the Office button and select the Print command.  
The Print dialog box will appear.  
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The Print Titles button takes you to the Page Setup dialogue box, which has four tabs that 

 

The Header/Footer tab allows you to enter a header or footer to be repeated on every page.  

The Sheet tab lets you specify rows that are to be repeated at the top of each sheet (such as 
column headings), and columns to be repeated at the left of each sheet (such as student 

 

  

previewed your worksheet one last time, and you’re happy 
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3. If you have more than one printer to choose from, they will be available in the 
Printer area. Click the drop-
preferred printer.  

4. Would you like to print selected pages only? Find the Page Range 
the page numbers that you’d like printed in the Pages field. 

5. If you’d like to print the entire workbook, rather than just the active sheet, you can 
specify this in the Print What area of the dialog box. 

6. If you’d like more than one copy of 
of copies in the Number of Copies field. 

7. Click OK when you’re satisfied with your settings. The specified worksheet pages 
will be sent to the printer.  

 

Charts: A picture is worth a thousand words! Often it’s 
when it’s presented graphically, and Excel provides the perfect tools to do this! 
 
It’s worth starting with a quick outline of different data types and charts: 

• Categorical data items belong to separate conceptual categories
forks and spoons; or males and females. They don
values, and it doesn‟t make sense to do calculations such as finding an average 
category. A pie chart or column chart is most suitable for categorical data. 

• Discrete data items have numerical values associated with them, but only whole 
values; for example, the number of TV sets in a household. Again, average values 
don‟t make much sense. Discrete data is often grouped in categories (“less than 
three”, “four or more”) and treated

• Continuous data refers to numerical values that have an infinite number of possible 
values, limited only by the form of measurement used. Examples are rainfall, 
temperature, time. Where discrete data has a very large number of possib
it may also be treated as continuous. Continuous data is well suited to line graphs, 
which are very useful for illustrating trends. 

 
Of course, Excel offers you many more chart types than just these three. Do remember that 
it’s best to select a chart type based on what you’re trying to communicate.

 
Creating a chart: It’s very easy to create a basic chart in Excel: 

1. Select the data that you want to include in the chart (together with column headings 
if you have them).  

2. Find the Charts category on the 
Insert ribbon, and select your 
preferred chart type.  
 

3. That’s it! The chart appears in the 
current window. Move the cursor 
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If you have more than one printer to choose from, they will be available in the 

-down arrow next to the Name field to select your 

Would you like to print selected pages only? Find the Page Range area, and type 
the page numbers that you’d like printed in the Pages field.  
If you’d like to print the entire workbook, rather than just the active sheet, you can 
specify this in the Print What area of the dialog box.  
If you’d like more than one copy of the worksheet, then enter the required number 
of copies in the Number of Copies field.  
Click OK when you’re satisfied with your settings. The specified worksheet pages 

A picture is worth a thousand words! Often it’s much easier to understand data 
when it’s presented graphically, and Excel provides the perfect tools to do this!  

It’s worth starting with a quick outline of different data types and charts:  

Categorical data items belong to separate conceptual categories such as kniv
forks and spoons; or males and females. They don‟t have inherent numerical 

‟t make sense to do calculations such as finding an average 
category. A pie chart or column chart is most suitable for categorical data.  

have numerical values associated with them, but only whole 
values; for example, the number of TV sets in a household. Again, average values 

‟t make much sense. Discrete data is often grouped in categories (“less than 
three”, “four or more”) and treated as categorical data.  

Continuous data refers to numerical values that have an infinite number of possible 
values, limited only by the form of measurement used. Examples are rainfall, 
temperature, time. Where discrete data has a very large number of possible values, 
it may also be treated as continuous. Continuous data is well suited to line graphs, 
which are very useful for illustrating trends.  

Of course, Excel offers you many more chart types than just these three. Do remember that 
chart type based on what you’re trying to communicate. 

It’s very easy to create a basic chart in Excel:  
Select the data that you want to include in the chart (together with column headings 

y on the 
Insert ribbon, and select your 

That’s it! The chart appears in the 
current window. Move the cursor 
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If you have more than one printer to choose from, they will be available in the 
down arrow next to the Name field to select your 

area, and type 

If you’d like to print the entire workbook, rather than just the active sheet, you can 

the worksheet, then enter the required number 

Click OK when you’re satisfied with your settings. The specified worksheet pages 

much easier to understand data 

such as knives, 
‟t have inherent numerical 

‟t make sense to do calculations such as finding an average 

have numerical values associated with them, but only whole 
values; for example, the number of TV sets in a household. Again, average values 

‟t make much sense. Discrete data is often grouped in categories (“less than 

Continuous data refers to numerical values that have an infinite number of possible 
values, limited only by the form of measurement used. Examples are rainfall, 

le values, 
it may also be treated as continuous. Continuous data is well suited to line graphs, 

Of course, Excel offers you many more chart types than just these three. Do remember that 

 

Select the data that you want to include in the chart (together with column headings 
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over the Chart Area to drag it to a new position. 
 

 
Modifying a chart:  

Ribbon, with Design, Layout and Format 
tabs.  

• Use the Design tab to quickly 
change the chart type, or to swap 
data rows and columns. 

 
In this example, I
changed the previous 
chart type to Column, and 
swapped rows and 
columns. All it took was 
two mouse clicks! 
 

• Use the Layout tab 
to add a title, and 
to provide axis and 
data labels.  

• Use the Format tab 
to add border and 
fill effects.  

 

Inserting graphics in a worksheet

example a corporate logo
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over the Chart Area to drag it to a new position.  

Modifying a chart:  When you click on a chart, a Chart Tools section
Ribbon, with Design, Layout and Format 

Use the Design tab to quickly 
change the chart type, or to swap 
data rows and columns.  

In this example, I‟ve 
changed the previous 
chart type to Column, and 
swapped rows and 

ook was 

Use the Layout tab 
to add a title, and 
to provide axis and 

Use the Format tab 
to add border and 

Inserting graphics in a worksheet: Sometimes you may want to add graphics, for 
example a corporate logo, to a worksheet. The good news is that images, ClipArt and 
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When you click on a chart, a Chart Tools section appears on your 

Sometimes you may want to add graphics, for 
, to a worksheet. The good news is that images, ClipArt and 
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WordArt are available in 
Excel, along with a host of 
call-out shapes that you 
can use to label your 
charts. You’ll find them all 
on the Insert ribbon. 
 

Data manipulation:  
The features mentioned in 
this section are most 
relevant when you’re 
working with a large data 
set – perhaps several hundred, or even thousand records 
through the entire worksheet each time you want to find a particular record. 
To use data functions effectively, each column of your worksheet should contain the same 
data type, apart from the column heading. Ideally, row 1 should contain the column 
headings, with the data rows immediately below; this structure is referred to as a data table. 
If you have blank rows in your data set, then you’ll need to manually select the data to be 
manipulated, which you don’t really want to do. 

 

Sort: The sort function does exactly what it says: it sorts your data records based on the 
criteria that you specify. You can sort numbers, text or dates, in either ascending (default) 
or descending order. Blank cells are always placed last in a sort. 
If you want to sort an entire data table: 

1. Click anywhere in the column that you want to sort 
by.  

2. On the Home ribbon, select Sort & Filter. 
3. Choose either Ascending (Sort A to Z) or Descending 

(Sort Z to A) order.  
4. Your data will be sorted based on the value in the 

column that you initially clicked on. 
 
If you want to sort on two or more criteria (columns), or if you want
cells, then you need to do a custom sort: 

1. Click in the data table, or select the cells to be sorted. 
2. On the Home ribbon, select Sort & Filter, and choose Custom Sort. The Sort 

Window will open. 
 

3. In the Sort By field, use the drop
to sort by and the order (ascending or descending) to be used. 
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perhaps several hundred, or even thousand records – and it isn’t practical to scroll 
through the entire worksheet each time you want to find a particular record.  

ctions effectively, each column of your worksheet should contain the same 
data type, apart from the column heading. Ideally, row 1 should contain the column 
headings, with the data rows immediately below; this structure is referred to as a data table. 

ou have blank rows in your data set, then you’ll need to manually select the data to be 
manipulated, which you don’t really want to do.  

The sort function does exactly what it says: it sorts your data records based on the 
You can sort numbers, text or dates, in either ascending (default) 

or descending order. Blank cells are always placed last in a sort.  
If you want to sort an entire data table:  

Click anywhere in the column that you want to sort 

elect Sort & Filter.  
Choose either Ascending (Sort A to Z) or Descending 

Your data will be sorted based on the value in the 
column that you initially clicked on.  

If you want to sort on two or more criteria (columns), or if you want to sort a range of 
cells, then you need to do a custom sort:  

Click in the data table, or select the cells to be sorted.  
On the Home ribbon, select Sort & Filter, and choose Custom Sort. The Sort 

In the Sort By field, use the drop-down arrows to select the column that you want 
to sort by and the order (ascending or descending) to be used.  
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and it isn’t practical to scroll 

ctions effectively, each column of your worksheet should contain the same 
data type, apart from the column heading. Ideally, row 1 should contain the column 
headings, with the data rows immediately below; this structure is referred to as a data table. 

ou have blank rows in your data set, then you’ll need to manually select the data to be 

The sort function does exactly what it says: it sorts your data records based on the 
You can sort numbers, text or dates, in either ascending (default) 

to sort a range of 

On the Home ribbon, select Sort & Filter, and choose Custom Sort. The Sort 

 
wn arrows to select the column that you want 
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4. If you want to add another sort criterion, then click the Add Level button, and a 
second details row will appear in the window. Again, choose the s
sort order.  

5. Add more levels (or delete levels) as required. 
6. When you click the OK button at the bottom of the window, your data will be 

sorted. Note that the Sort function is also available from the Data ribbon. 
 

10.4.2 Filter  
The filter function lets you view just the records that you want to see! The other records in 
your data table will still be there, but hidden. To use this amazing function: 

1. On the Home ribbon, select Sort & Filter, and select the Filter option. 
2. In the first row of

each column heading. When you click on a drop
the values occurring in that column. Press [ESC] to close the filter list. 

3. If you want to view records wit
All option, and then check one or more values that you want to view. Click the OK 
button. (The example above has already been filtered on Product, Delivery month 
and Customer Type, and is about to be f

4. All rows that do not contain the value(s) you checked, will be hidden from view. A 
column that has been filtered will show a funnel icon next to the drop
on the heading. 

5. Repeat the filtering process for as many co
column filter by checking its Select All option. 

 
To clear your previous filter settings, select Sort & Filter, and then Clear.
 
To turn off filtering, select Sort & Filter, and then Filter (the same option that you 
originally used to turn it on). 
 
Note that the Sort function is also available from the Data ribbon. 

 

Subtotals: If your data table includes a column with categorical data (such as month, 
department, region, etc), then you can easily obtain subtotals of nu
sales, salaries, rainfall). 

1. First sort your data on the column that contains categorical data for which you want 
subtotals calculated. 
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If you want to add another sort criterion, then click the Add Level button, and a 
second details row will appear in the window. Again, choose the s

Add more levels (or delete levels) as required.  
When you click the OK button at the bottom of the window, your data will be 
sorted. Note that the Sort function is also available from the Data ribbon. 

function lets you view just the records that you want to see! The other records in 
your data table will still be there, but hidden. To use this amazing function: 

On the Home ribbon, select Sort & Filter, and select the Filter option. 
In the first row of your data table, a drop-down arrow will appear on the right of 
each column heading. When you click on a drop-down arrow, you
the values occurring in that column. Press [ESC] to close the filter list. 

If you want to view records with a particular value only, click to uncheck the Select 
All option, and then check one or more values that you want to view. Click the OK 
button. (The example above has already been filtered on Product, Delivery month 
and Customer Type, and is about to be filtered on Discount as well.) 
All rows that do not contain the value(s) you checked, will be hidden from view. A 
column that has been filtered will show a funnel icon next to the drop
on the heading.  
Repeat the filtering process for as many columns as you need. You can remove a 
column filter by checking its Select All option.  

To clear your previous filter settings, select Sort & Filter, and then Clear.

To turn off filtering, select Sort & Filter, and then Filter (the same option that you 
iginally used to turn it on).  

Note that the Sort function is also available from the Data ribbon.  

If your data table includes a column with categorical data (such as month, 
department, region, etc), then you can easily obtain subtotals of numeric values (such as 
sales, salaries, rainfall).  

First sort your data on the column that contains categorical data for which you want 
subtotals calculated.  
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If you want to add another sort criterion, then click the Add Level button, and a 
second details row will appear in the window. Again, choose the sort column and 

When you click the OK button at the bottom of the window, your data will be 
sorted. Note that the Sort function is also available from the Data ribbon.  

function lets you view just the records that you want to see! The other records in 
your data table will still be there, but hidden. To use this amazing function:  

On the Home ribbon, select Sort & Filter, and select the Filter option.  
down arrow will appear on the right of 

down arrow, you‟ll see a list of all 
the values occurring in that column. Press [ESC] to close the filter list.  

 
h a particular value only, click to uncheck the Select 

All option, and then check one or more values that you want to view. Click the OK 
button. (The example above has already been filtered on Product, Delivery month 

iltered on Discount as well.)  
All rows that do not contain the value(s) you checked, will be hidden from view. A 
column that has been filtered will show a funnel icon next to the drop-down arrow 

lumns as you need. You can remove a 

To clear your previous filter settings, select Sort & Filter, and then Clear. 

To turn off filtering, select Sort & Filter, and then Filter (the same option that you 

If your data table includes a column with categorical data (such as month, 
meric values (such as 

First sort your data on the column that contains categorical data for which you want 
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2. Click the Subtotal button on the Data ribbon. The Subtotal window will appear. 
 

 
3. In the At Each Change In field, select the column with categorical data that was 

used for sorting.  
4. The Use Function field allows you to choose from a range of functions such as 

sum, average, count, etc.  
5. Check under Add Subtotal To to identify the columns for which yo

to be calculated.  
6. Click the OK button. The screen display will show three outline levels on the left of 

the data window.  
a. Level 1 shows the overall grand total only. Click on the “+” icon or on the 

level 2 button to see subtotals. 
 

 
b. Level 2 shows the requested subtotals only. Click on a “+” icon to see the 

records within one category, or click on the level 3 button to see all records. 
 

 
To remove subtotals, click the Subtotal button on the Data ribbon, and then Remove All.
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Click the Subtotal button on the Data ribbon. The Subtotal window will appear. 

 

h Change In field, select the column with categorical data that was 

The Use Function field allows you to choose from a range of functions such as 

Check under Add Subtotal To to identify the columns for which you want subtotals 

Click the OK button. The screen display will show three outline levels on the left of 

Level 1 shows the overall grand total only. Click on the “+” icon or on the 
level 2 button to see subtotals.  

 

vel 2 shows the requested subtotals only. Click on a “+” icon to see the 
records within one category, or click on the level 3 button to see all records. 

 

To remove subtotals, click the Subtotal button on the Data ribbon, and then Remove All.
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Click the Subtotal button on the Data ribbon. The Subtotal window will appear.  

h Change In field, select the column with categorical data that was 

The Use Function field allows you to choose from a range of functions such as 

u want subtotals 

Click the OK button. The screen display will show three outline levels on the left of 

Level 1 shows the overall grand total only. Click on the “+” icon or on the 

vel 2 shows the requested subtotals only. Click on a “+” icon to see the 
records within one category, or click on the level 3 button to see all records.  

To remove subtotals, click the Subtotal button on the Data ribbon, and then Remove All. 
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CHECK YOUR PROGRESS-III 

 
1. Write a note on ‘Uses of Excel’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
 

2. Write a note on ‘using formula in Excel’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

_________________________________________________________________________ 

 

2.7 MS POWERPOINT 

Microsoft PowerPoint is a presentation program used to create slideshows composed of 
text, graphics, and other objects, which can be displayed on-screen and shown by the 
presenter or printed out on transparencies or slides. 
 

2.7.1 Introduction to MS Powerpoint 2007 

Microsoft Office PowerPoint : "PowerPoint" refers to Microsoft PowerPoint, a program 
that allows the user to design a presentation that consists of multiple slides. These slides 
may contain images, text, video clips, and related types of information. PowerPoint is 
useful for delivering a speech, because the user can utilize text on the screen to remind him 
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or herself of the information to be conveyed to the audience or to summarize his/her 
dialogue into more manageable and "friendly" sizes, as well as to entertain or explain 
graphs, charts, and related data.  

 

THE BASICS: CREATING AND EDITING A PRESENTATION 

 

The PowerPoint Window  
1. Title Bar - Displays the name of the application followed by the title of the 

presentation  
2. Formatting Toolbar - Provides quick access to commands you need for formatting 
3. Outline and Slides Tab - The slides tab gives you a thumbnail view of all the 

slides in the presentation and allows to rearrange their order; the outline tab adds 
textual content to the slides in an outline format 

4. Slide Pane - Area where you build the slides f
5. View Buttons - Change the way you view the presentation; the Normal view (left 

button) is the default, the Slide Sorter view (center button) shows you only the 
thumbnails and is used to sort and rearrange the presentation, and the Run
(right button) runs the presentation from the current slide 

6. Drawing Toolbar - Provides all the tools you need to draw and format objects 
7. Notes Pane - Adds notes for yourself for each slide in your presentation 
8. Task Pane (Windows version) 

on; when you first start PowerPoint, you see the New Presentation task pane; other 
possible tasks include Slide Layout, Slide Design, and Effects 

9. Menu Bar - Includes all of the PowerPoint menu choices 
10. Placeholders - Designate the space that will be filled with titles, text, or other 

objects such as graphics or charts 
11. Application Close Button (Windows Version) 

12. Presentation Close Button (Windows version) 
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or herself of the information to be conveyed to the audience or to summarize his/her 
dialogue into more manageable and "friendly" sizes, as well as to entertain or explain 

THE BASICS: CREATING AND EDITING A PRESENTATION  

Displays the name of the application followed by the title of the 

Provides quick access to commands you need for formatting 
The slides tab gives you a thumbnail view of all the 

slides in the presentation and allows to rearrange their order; the outline tab adds 
textual content to the slides in an outline format  

Area where you build the slides for your presentation  
Change the way you view the presentation; the Normal view (left 

button) is the default, the Slide Sorter view (center button) shows you only the 
thumbnails and is used to sort and rearrange the presentation, and the Run
(right button) runs the presentation from the current slide  

Provides all the tools you need to draw and format objects 
Adds notes for yourself for each slide in your presentation  

Task Pane (Windows version) - Varies based on what you are currently working 
on; when you first start PowerPoint, you see the New Presentation task pane; other 
possible tasks include Slide Layout, Slide Design, and Effects  

Includes all of the PowerPoint menu choices  
Designate the space that will be filled with titles, text, or other 

objects such as graphics or charts  
Application Close Button (Windows Version) - Exits PowerPoint  
Presentation Close Button (Windows version) - Closes the current presentation 
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or herself of the information to be conveyed to the audience or to summarize his/her 
dialogue into more manageable and "friendly" sizes, as well as to entertain or explain 

Displays the name of the application followed by the title of the 

Provides quick access to commands you need for formatting  
The slides tab gives you a thumbnail view of all the 

slides in the presentation and allows to rearrange their order; the outline tab adds 

Change the way you view the presentation; the Normal view (left 
button) is the default, the Slide Sorter view (center button) shows you only the 
thumbnails and is used to sort and rearrange the presentation, and the Run view 

Provides all the tools you need to draw and format objects  

based on what you are currently working 
on; when you first start PowerPoint, you see the New Presentation task pane; other 

Designate the space that will be filled with titles, text, or other 

Closes the current presentation  
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CREATE A NEW PRESENTATION  
Using the AutoContent Wizard  

1. If necessary, chose File > New to display the New Presentation pane  
2. On the New Presentation pane, click on the AutoContent Wizard link  

 
You will be walked through a series of questions about the presentation you are making, 
including a category for the type of information being presented and the method of 
delivery. The Wizard then applies a background and text as well as an outline of text you 
may use as a guide. This is the preferred method for creating a presentation in the least of 
amount of time.  

 

Using a Design Template  
1. If necessary, choose File > New to display the New Presentation pane  
2. On the New Presentation pane, click on the From Design Template link  
3. The Slide Design pane will display on the right side of the screen with a variety of 

different templates to choose from  
4. Select the design of your choice from the Slide Design pane.  
5. Click OK to begin working with the first slide in the Normal View.  

 

Using a Blank Presentation  
1. If necessary, chose File > New to display the New Presentation pane  
2. On the New Presentation pane, click on the Blank Presentation link  

 
This will open a new presentation with no template. You will provide the content, 
background, color scheme, text format, etc. This method gives you the most freedom, but 
also requires the most amount of time to complete.  

 

Adding a new slide: Once you have opened a new presentation, the next step is to add and 
format the content. PowerPoint provides a selection of pre-defined slide layouts based on 
different types of content that you can use to quickly add content to the slides. For each of 
the 27 Slide Layouts provided, PowerPoint combines the four types of placeholders in 
different combinations; each placeholder 
will be replaced with the following type 
of content:  
 
Using a Slide Layout ensures that the text 
and other elements you enter into the 
placeholders will have consistent spacing 
and be optimally arranged.  

 

How to Add Slides to a Presentation  
1. Click the New Slide button on the 

Formatting toolbar.  
2. From the list of Slide Layouts, select 

the layout you want to apply to the new slide.  
3. You may now begin adding content using the placeholders in the layout.  
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How to Change the Layout for any Slide: PowerPoint will try to guess what layout you 
want to use for new slides that are added to the presentation. If you want a different layout 
for the slide you can quickly change the layout for any slide.  

1. Display the slide that you want to change in the Slide Pane (work area in the center 
of the window).  

2. Choose Format > Slide Layout to display the Slide Layout task pane.  
3. Click on the layout you want to apply to the slide.  
4. PowerPoint will attempt to fit existing content into the new layout, but you will 

probably have to make additional changes.  

 

How to Add Slides in the Outline Tab: You can also create new slides while working in 
the Outline tab. By default the Outlining toolbar should display, but if it does not, select 
View > Toolbars > Outlining.  

1. Display the Outline tab by clicking on Outline in the pane on the left.  
2. Place the cursor at the end of the text in the slide you wish the new slide to follow.  
3. Click the New Slide button to insert a new slide.  

 

ENTERING TEXT ON A SLIDE  
 

Enter Text on a Slide Using Placeholders  
1. Click on the Title, Subtitle, or Text placeholder.  
2. Type the text you want.  
3. If necessary, press [Return] or [Enter] to move to a new line.  
4. Click anywhere on the slide outside of the placeholder to deselect it.  

 

 

Enter Text Using the Outline Tab: Working in the Outline Tab allows you to type and 
edit text for the presentation in a more word processing-like environment than the Slide 
pane. The Outline tab displays in the pane on the left side of the screen when you are 
working in the Normal view.  
 
Information in the Outline tab is arranged by levels. The Title of each slide appears as the 
first, left-most level next to a numbered icon of the slide. Bulleted text is indented one to 
four levels to the right of the title. The Outline tab has an Outlining toolbar that displays to 
the left of the pane.  
 
Tip: If the Outline and Slides panes are not displaying in the Normal view, select View > 
Normal (restore panes) and it will display on the left side of the screen.  

1. After adding a new slide, Type the slide title and press [Return] or [Enter].  
2. To change the slide text to a first level bullet, press [Tab] or click the Demote 

button on the Outlining toolbar.  
3. Type the text for the first bullet and press [Return] or [Enter] to move to the second 

bullet.  
4. To create a sub-bullet, press [Tab] and type the text.  
5. Continue to enter text for bullets and sub-bullets until the slide is complete.  
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a. Use [Return] or [Enter] to create a new instance of the same level you are 
on. For example, if you are typing a level one bullet, pressing [Return] or 
[Enter] will create another level one bullet.  

b. To demote a line of text, use [Tab] or the Demote button. This will make a 
level one bullet into a level two sub-bullet.  

c. To promote a line of text, press [Shift] and [Tab] together or click on the 
Promote button. This will turn a level one bullet into the Title of a new 
slide.  

 

Adding Clip Art to a Slide: Effective visuals emphasize the key content points in a 
presentation. PowerPoint provides a selection of professionally designed pictures, or clip 
art, that you can use in your presentations. These clip art images include many different 
themes such as animals, people, buildings, food, holidays, business, and more.  

 

How to Insert a Clip Art Image  
1. Move to the slide on which you want to place clip art.  
2. Apply a Slide Layout that includes a content or clip art placeholder.  
3. Open the Select a Picture dialog box by:  

a. Clicking on the Clip Art button on the content placeholder OR  
b. Double-clicking on the clip art placeholder  

4. In the Search box, type a word or phrase that describes the clip you want.  
5. Click Search. PowerPoint displays the search results in the Select Picture List.  
6. Click on the clip art image you want and click OK.  

 
How to Resize a Clip Art Image: Once you have added a clip art object to your slide, you 
can resize it to make it fit better into your presentation.  

1. Click on the Clip Art object to select it.  
2. Put the arrow on one of the resize handles at the corner of the picture until the 

cursor changes to a double-headed arrow.  
3. Depress the mouse button and drag the handle toward or away from the center to 

make the image larger or smaller. The corner handles resize the image 
proportionally and the handles on the sides of the image increase or decrease the 
height or width of the image. When you release the mouse button, the object 
appears in its new size.  

 

Editing Slide Text: You know how to enter text into your presentation, but what happens 
if you decide you want to change the text? PowerPoint allows you to navigate to a specific 
slide and change the text.  
 

Navigate in a Presentation 
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Selecting Text: Knowing how to select text is a critical skill in all Microsoft Office 
applications. Selecting text is a necessary step for many procedures such as deleting blocks 
of text or formatting. 

 
 

How to Edit Text in a Slide Pane: You can edit text or move bulleted text in the Slide 
pane or the Outline tab. To edit text in the Slide pane:  
 

1. Select the bulleted text you want to change.  
2. If necessary, edit the text by:  

a. Pressing the [Delete] key to delete the text; or  
b. Typing new text to replace the selected text.  

3. If necessary, move the bulleted item by:  
a. Selecting the entire bulleted item; and  
b. Dragging the item up or down to move it to its new location.  

 
Move Bulleted Items in the Outline Tab: You can change the order of bulleted items and 
slides in the Outline tab:  

1. Select the slide or bulleted item you want to move.  
2. Click the Move Up or Move Down button on the Outlining toolbar until the slide or 

bulleted item appears where you want it.  
 

FORMATTING TEXT SLIDES  
Apply Character Formats: You can use character formatting to add interest to 
presentations, but do so sparingly. Keep in mind that adding too much character formatting 
can detract from your message or make it confusing.  

 

Format Text: You can change the appearance of text by changing its font, size, style, and 
color. You can format text in the Outline tab or the Slide pane. To format text:  

1. Select the text you want to format.  
2. To change the font, select a new font from the Font drop-down list on the 

Formatting toolbar.  
3. To change the size, select a new size from the Size drop-down list on the 

Formatting toolbar.  
4. To change the style, click the Bold, Italic, or Underline button on the Formatting 

toolbar.  
5. To change the color, select a new color from the Font Color button's drop-down 

palette. (The Font Color button is on the Drawing toolbar).  

 



   

Application of Computers in Hospitality and Tourism                                BHM-701BT 

Uttarakhand Open University                                        113 

Repeat Formatting: When you format text in a slide, you can press the [F4] key to repeat 
that format for newly selected text. If you use the toolbar to apply more than one format, 
PowerPoint will repeat only the last format you applied.  

 

Align Text: Alignment determines the position of the text within its text object box on a 
slide. Text can be left-aligned, right-aligned, centered, or justified, as follows:  

1. Select the text you want to align.  

2. Choose Format > Alignment to display the Alignment sub-menu.  

3. From the sub-menu, select the alignment option you want:  

• Align Left - aligns text at the left edge of the text object box.  

• Center - aligns text between the left and right edges of the text 
object box.  

• Align Right - aligns text at the right edge of the text object box.  

• Justify - begins text at the left edge and ends the text at the right 
edge of the text object box.  

 
You can also use the Alignment buttons on the Formatting toolbar to left-align, center, and 
right-align text.  

 

Line Spacing: Line spacing is the vertical distance between two lines of text. By default, 
line spacing is set to single-line spacing, which means that the amount of space between 
lines of text depends on the size of the font used. For example, if the font size is 12, then 
single-line spacing will be 12 pts between lines of text. If you applied double-line spacing, 
then the lines would be separated by 24 pts of space.  

 

Setting Line Spacing  
1. Place the cursor in a paragraph, or select the paragraphs you want to affect.  
2. Choose Format > Line Spacing.  
3. In the Line Spacing dialog box, click on the arrows to increase or decrease line 

spacing options, or enter an exact setting.  
4. Click OK.  

 
Line Spacing Options: In the Line Spacing dialog box, there are three options for 
changing the amount of space between lines and bullet items on a slide.  

• Line Spacing - the amount of space between selected lines of text. By default, line 
spacing is set to 1.  

• Before Paragraph - increase or decrease the spacing before the first line of each 
selected paragraph.  

• After Paragraph - the amount of space after the last line of each selected paragraph  
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Indents: In PowerPoint, indents are used to align bullets and text at a set distance from the 
margins. When the horizontal ruler in PowerPoint is displayed, you will find one set of the 
following indent markers on the left edge of the ruler for each level of bullets on the slide: 

 

Indent Marker Types 

 
 

How to Change Indents  
1. Select the text object that you want to affect.  
2. Choose View > Ruler to display the ruler.  
3. To adjust the first-line indent, click and drag the upper marker for that 

indent to a desired position on the ruler.  
4. To adjust the subsequent lines in a paragraph, click and drag the upper 

marker for that indent to a desired position on the ruler.  
5. To maintain the relationship between the first line and the rest of the 

paragraph (to move both markers at once), click and drag the bottom half of 
the lower marker to a desired position on the ruler.  
 

2.7.2 Preparing to Deliver a Presentation Using MS Powerpoint 

 
After adding all of the content to a presentation, it is time to put the finishing touches on it. 
There are multiple ways to check for spelling errors, inconsistencies, or other problems. 
There are also several ways to enhance the presentation.  

 

SPELL CHECK A PRESENTATION  
AutoCorrect: Autocorrect corrects many common spelling errors automatically as you 
type. It is similar to the version used in Microsoft Word. Autocorrect fixes spelling errors 
as well as instances such as double capital letters at the beginning of a word, capitalizing 
the days of the week and the first words of a sentence. Common typing mistakes such as 
letter transposition are also automatically corrected as you type. 
 
There may be times when you do not want Autocorrect turned on. To access options for 
Autocorrect, go under the Tools menu and choose Autocorrect Options. Each function in 
AutoCorrect can be selected or deselected by clicking in the check box associated with 
each function.  
 

Spellchecking a PowerPoint Presentation: PowerPoint provides you with a powerful 
spellchecker that works in the same fashion as the one in Microsoft Word. As with that 
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spellchecker, it's always a good idea to proofread your presentation yourself; however, the 
spell checker can sometimes be a lifesaver.  
 
To check an entire presentation, don't select any text. If you run the spellchecker with 
specific text selected, it will only check that text. You don't have to click the insertion 
point at the beginning of a presentation to begin spellchecking, as the spellchecker will 
wrap around until it has checked the entire presentation.  
 
There are four ways to access the spellchecker:  

• In the Tools menu, choose Spelling.  

• Click the Spelling button on the Toolbar.  

• Press [F7].  

• Right-click on a flagged spelling error and choose Spelling.  
 
Once the spellchecker is running, you can use the various options to help you find and 
correct spelling errors in your presentation. PowerPoint's spellchecker compares words 
with its internal dictionary. If PowerPoint does not recognize a word, there are several 
options you can have it perform, as described below:  

• If the correction you want is already highlighted in the Suggestions list box, click 
Change.  

• If the correction you want is in the Suggestions list box but not highlighted, select 
that word and click Change.  

• If the correction you want is not suggested, you can type the correction in the top 
text box and click Change.  

• You can click Change All to automatically correct any further occurrences of the 
particular spelling error.  

• If the spellchecker comes across a word that has been repeated, you can click 
Delete to delete on of the instances of a word.  

 
PowerPoint can check your spelling as you type. If it thinks you've misspelled a word, 
PowerPoint lets you know by drawing a wavy red line under the word. To correct one of 
these errors, right-click on the erroneous word and either choose one of the suggested 
changes or open the Spell Check dialog box and make the change there as described above.  

 

View the Slide Show: While putting together a PowerPoint slide show, it is often useful to 
actually run the show to see what it will really look like when it is presented to an 
audience. This can provide a "reality check" and give a better idea of how the show is 
actually going to look.  

 

Slide Show View: Use the Slide Show view to see the slide show on your computer screen 
one slide at a time, using the full screen, as you will when actually presenting the show. 
You can move the subsequent slides by either clicking your mouse button, clicking the 
[Page Up] and [Page Down] buttons, or by using the left and right arrow keys on your 
keyboard.  
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To view the Slide Show:  
1. When you use the Slide Show view button, PowerPoint starts the show at 

the currently selected slide. So, go to the first slide in your presentation.  
2. Click the Slide Show view button.  
3. To move to the next slide, click the mouse button or push the right arrow 

key. At the end of the show, PowerPoint will display, "End of slide show, 
click to exit".  

4. You can exit a slide show at any point by pressing the [Esc] key.  
5. When you exit a slide show, PowerPoint returns to Normal view.  

 

Arrange Slides in a Presentation: The ability to reorder slides in a presentation after 
you've created them enables you to easily reorder slides after you've created them, as well 
as giving you the freedom to organize a new presentation out of an older one. This can be 
essential in using the same material for different audiences without having to recreate and 
entire slide show presentation. PowerPoint also lets you hide selected slides in a 
presentation, in case you want to reuse a slide show for an audience and omit certain parts 
of the presentation that don't apply to that particular presentation.  

 

Slide Sorter View: Choose View/Slide Sorter, or click on the Slide Sorter view button. 
PowerPoint changes to the Slide Sorter view and opens the slide sorter toolbar.  
 
In Slide Sorter view, you see the thumbnail representations of the slides comprising your 
slide show. This is a great way to see the whole presentation at once, in the order in which 
they will appear in the slide show. After you are finished creating and editing your 
presentation, you can come to Slide Sorter view to shuffle slides around, and copy, delete, 
or hide slides, until you've got it right. Slide Sorter view also allows you to set up special 
effects to the slides in the presentation.  
 
As you look through your slides in Slide Sorter view, and find a slide that you need to 
further edit, just double-click on that slide and it will be displayed in Normal view.  

 

Rearranging Slides in Slide Sorter View  
1. You can often make a presentation better by playing with the order in which the 

slides appear. Sometimes, you may wish to entirely hide a slide that doesn't apply 
to your audience. All of this happens in Slide Sorter view. To rearrange slides in 
Slide Sorter view:  

2. Click on the Slide Sorter view button (or choose View/Slide Sorter).  
3. Click on the slide you wish to move, copy, delete, or hide to select it.  
4. Now move, copy, delete, or hide the slide:  

• To move a slide, press and hold the mouse button, drag the slide to 
where you want it to go, and release the mouse button.  

• To copy a slide, press and hold the [Ctrl] key and drag the slide to 
where you want it to go.  

• To delete a slide, press [Delete] or [Backspace].  

• To hide a slide, right-click in the slide thumbnail and choose Hide 
Slide.  
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Adding Transitions to a Slide Show: One way to add a nice touch of professionalism to a 
slide show is to add transitions to the slides. Transitions affect the way one slide goes to 
the next slide. Transitions add interest to your slide show, but care should be taken to be 
sure they do not become a distraction from the show itself. It is often best to choose one 
transition you like and use it for the entire slide show.  

 

Slide Selection in Sorter View: In Slide Sorter view, you can select one slide, two or 
more slides that are next to each other, or two or more slides that are not next to each other. 

 
 

How to Set Transition Effects: For each slide in a presentation, you can set a different 
transition effect and determine how fast the transition will happen. To set transition effects:  

1. Switch to Slide Sorter view.  
2. Select the slides to which you want to assign a transition.  
3. Choose Slide Show/Slide Transition or click the Transition button on the Slide 

Sorter toolbar to open the Slide Transition task pane.  
4. From the Apply to Selected Slides list box, select the transition effect you want to 

apply. PowerPoint previews the effect on the selected slides and displays a Preview 
Animation button beneath each selected slide.  

5. In the Modify Transition section, select a speed (Slow, Medium, or Fast) for the 
transition effect. Once again, PowerPoint previews the effect on the selected slides.  

6. To preview the effect again, click the Animation Preview button beneath the slide 
on the left side.  

7. Close the Slide Transition pane.  

 

Animating Text: Normally, when you have a slide with multiple bullets, PowerPoint will 
display all the text bullets at once when you go to that slide during a slide show. One nice 
effect, however, is having the different bullets appear as you speak about them, one at a 
time. This can be accomplished by using PowerPoint's animate text feature.  
 
Animation of text in PowerPoint refers to the manner in which individual text or other 
objects appear as they enter or exit a slide. Normally, all objects on a slide appear at the 
same time when you display the slide. However, you can have different objects appear and 
exit at different times under your control as the show proceeds. To add animation to text in 
a presentation:  

1. In Normal view, select a line of bulleted text.  
2. Choose Slide Show/Custom Animation to open the Custom Animation task pane.  
3. Click the Add Effect button to display the drop-down list.  
4. From the Entrance sub-menu, choose the animation effect of your choice. You can 

choose More Effects if the effect you want isn't listed. PowerPoint displays the 
animation effect in the list box on the Custom Animation task pane.  

5. In the Modify section, set the direction and speed.  
6. Close the Custom Animation task pane.  



   

Application of Computers in Hospitality and Tourism                                BHM-701BT 

Uttarakhand Open University                                        118 

Printing Slides, Speaker Notes, and Handouts: PowerPoint enables you to easily print 
handouts, slides, and your own speaker notes that you can reference while giving a 
presentation.  

 

Handouts: You can use PowerPoint to create handouts of the slides in your presentation. 
You can decide how many slides you wish to appear on a page. Usually, it is best to have 
no more than 4 in order that they remain readable. You can choose layouts from the Print 
dialog box right before you print. PowerPoint automatically formats everything for you.  

 

Print Options: There are many options for printing your presentation. You can print 
slides, notes pages, handout pages, or outlines. You can print the current slide, or select a 
range of slides to print. You can also select other print options. To print various things 
from PowerPoint:  

1. Choose File > Print to display the Print dialog box.  
2. Under the Print What heading, select the type of printout.  
3. Select any other options you want.  
4. Click OK.  

 
Creating a Custom Design Template: While PowerPoint offers a nice variety of design 
templates, it is also useful at times to create your own. A design template, once created, 
can be used over and over again. For instance, if your department wanted all presentations 
to include your company's logo in one corner, with its colors as the background, you could 
create a design template with these features and reuse it again and again.  

 

Master Slides: A master slide is one that is a part of every presentation that controls 
certain text characteristics such as font type, size, and color, as well as background color 
and style. Masters can affect all the slides in a presentation. There are masters that control 
the title slide, notes pages, and handout pages. When you apply a template to a 
presentation, you apply a new set of masters that control the presentation's look and 
format. There are four types of masters used in PowerPoint, as described below. 
 

 
 
Slide Background: A slide background is a design element that appears behind the 
contents of the slide. The slide background is made up gradient, texture, patterns, or a 
picture. To change the slide background:  
 

1. Select the slide you want to change:  
a. Select a slide in Normal view.  
b. Select the Slide Master.  

2. Choose Format/Background.  
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3. In the Background Fill section, click on the drop-down arrow and choose Fill 
Effects.  

4. On the Fill Effects dialog box, select the tab that contains all the options you want 
to set and click OK.  

5. Click Apply to All.  
 
The following table describes the options you can set in the Fill Effects dialog box. 
 

 
 
Inserting Graphics: One element you can add to every slide is a graphic of some sort. To 
add a graphic to one or all slides:  

1. Display an individual slide or the Slide Master for all slides.  
2. Choose Insert > Picture > From File.  
3. Navigate to the folder that contains the picture that you wish to insert.  
4. Select the picture file.  
5. Click Insert.  

 
PowerPoint allows you to insert most popular graphic formats into your presentation.  

 

Adding Footers: Footers serve many uses in PowerPoint presentations. You can use them 
to provide information like slide numbers, footer text, and date. All of the information goes 
at the bottom of each slide in your design template.  

 

Components of a Footer: A footer in PowerPoint is text that you create once, but it 
appears on the bottom of each slide. It can consist of text, slide numbers, and a date. To 
add a footer:  

1. Display the Slide Master.  
2. Choose View > Header and Footer.  
3. In the Date and Time section, select the options that you want.  
4. Check the Slide Number box to add a number to each slide.  
5. Under the checked Footer check box, click in the text box and enter the footer text.  
6. Click Apply To All.  

 
Formatting a Footer : You can change the way a footer looks at any time. On the Slide 
Master, select the placeholder that contains the information you want to change and format 
the text as you would any normal text. You can also drag the placeholder around if you wish 

to change its location. 
 

Modify the Slide Master Font: PowerPoint allows you to change the way that the text in 
each individual part of your presentation looks. If you have a very long presentation, for 
example, but decide that you no longer like the font for each title, PowerPoint makes it 
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easy to change the font for each title at once. To change the appearance of the Slide Master 
text:  

1. View the Slide Master.  
2. Select the text you want to change.  
3. Change the font to a different font.  
4. Change the font size.  
5. Apply a text effect, such as bold.  
6. Return to Normal view.  

 
Some Tips for Effective Slide Shows: Here are a few tips that will help your PowerPoint 
slide shows look professional and promote effective visual clues to help you get your 
points across:  

1. Limit animation.  
2. Stay with one slide transition.  
3. Use sans-serif fonts.  
4. No tiny font sizes; remember the folks in the back row.  
5. Keep your slides simple and uncluttered  
6. If you are presenting in a light room, use a light slide background.  
7. If you are presenting in a dark room, use a dark slide background.  
8. Make sure to use high-contrast text and slide backgrounds.  

 

For More Information...  
We recommend:  

• The Help menu built into PowerPoint.  
a. Press the [F1] button in Windows.  
b. From the Help menu, select from options to view the PowerPoint help 

contents, search PowerPoint help, or connect to other help sources.  

• Free Microsoft Help and Support available online at [1].  
a. Topic specific FAQS.  
b. Downloads & Updates.  
c. Links to additional resources.  

• Also available from Microsoft, the new Office Online website offers tips and 
assistance on office products including PowerPoint. Explore this at [2].  

 
 

CHECK YOUR PROGRESS-IV 

 
1. Write a note on ‘MS PowerPoint Software’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 
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2. Write a note on ‘Formating in MSPowerPoint’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

_________________________________________________________________________ 

2.8 SUMMARY 

System software monitors the activities of the computer so that it functions efficiently. The 
operating system comprises a set of programs that work with the peripheral devices and 
computer hardware to control and organize the general operating functions of the 
computer. Operating systems differ in functionality, flexibility and ease of use. A platform 
of a computer system is the underlying hardware and software that it allows it to function. 
The functions of the user interface are to start application programs, manage secondary 
storage, such as hard disks, as well as manipulate files and folders, and finally shut down 
the computer safely. The Graphical User Interface (GUI) uses graphics or icons which 

represent various tasks. The command‐line interface requires the user to type keywords or 
commands at a prompt, in order to enter data or execute commands. Utility programs are 
tools that help the operating system manage the computer system‘s secondary or 

on‐priority jobs. Language translators are these systems programs convert the data in a 
program (source code) into machine language code (object code) that the computer can 
then process. Windows Explorer is a tool for organizing files on disk and uses several 
important components to manage drives such as disks (floppy disks, CDs, DVDs, and 
memory sticks), folders and files. Files are a collection of information, data, or program 
files. Folders are used to organize where the files are located, so that a particular folder 
may contain all spreadsheet files, while another folder can contain all word processing 
files. A disk is a secondary storage device such as a floppy disk, CD, DVD, or memory 
stick, where folders and files can be stored. The root folder is the main or general folder 
found on all disks. Folders created within the root folder, are called subfolders. Deleting 
folders also removes files and any subfolders in that folder.  

Application software is what users require to complete their tasks, while system software is 
the software that interfaces between the hardware to perform what is required by the 

application software. Personal productivity software programs are usually stand‐alone 
programs which do not depend on other application software to function.  
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The word processing document life cycle, includes creating a document, editing or 
modifying the document, formatting the document, saving and finally printing to provide a 
hard copy. Mail merge is one of the powerful features of word processing software which 
makes it easy to create personalized letters and reports. Workgroup applications are used 
by two or more users who work as a team to achieve a common task. Enterprise 
applications used by personnel to support the company in its interaction with customers 
and employees, such as entry of orders, billing, or payroll. Electronic spreadsheets 
organize eliminate much of the tedious tasks of performing numerical calculations 
manually. Spreadsheets produce graphs based on the data given in a visual, easily 
understood format. The usefulness of presentation software includes the easy updating or 

rearrangement of the slide content, and the inclusion of multi‐media to enhance the 
audience‘s understanding of the content.  

 
System software plays an important role in the proper functioning of a computer system. 
This unit explained the three main programs that comprise system software, namely 
operating systems, utility programs and language translators. Of course different types of 
system software are necessary for the different types of operating systems available. The 
user interface was also discussed as a mediator between the user and the computer system, 
to ensure that the computer system performs certain complex or other mundane tasks for 
the user. 
 

2.9 GLOSSARY 

 
Accounting Software: Provides assistance for personal accounting and cheque writing. 
Examples are Quicken and QuickBooks. 

 

Antivirus software: Protects the computer from computer viruses. Examples are Nortan, 
Macafee, Zone Alarm etc 

 

Application Software: Application programs assist the user in completing workplace 
tasks, personal tasks or research when using the computer. They are the programs that a 
regular user sees and manipulates. 

 

Ask A Question Box - Provides quick access to help.  
 

AutoContent Wizard - A wizard that produces a presentation with a general structure and 
suggested topics based on options you choose regarding the presentation output.  

 

AutoCorrect - Corrects capitalization, grammar, and spelling errors automatically as you 
type.  

 

AutoShapes - Ready-made shapes you can draw on the slides in your presentation by 
choosing a shape from the AutoShapes drop-down menu.  
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Backup Software: Used to copy data from the hard disk to another storage medium. 

 

Clip Art - Professionally designed images that you can add to documents. You can change 
the size, appearance, and location of clip art after it has been inserted into a document.  

 

Database Software: Stores, manipulates and retrieves data. Some examples are Microsoft 
Access, dBase and FoxPro. 

 

Design Template - The background, fonts, bullets, formatting, and color scheme that you 
can apply to define the look of your presentation.  

 

Disk Defragmentation: Re-organizes data on storage device to improve performance 

 

Disk Scanning: Involves disk-scanning utilities to detect and fix errors on storage device, 
or disk cleanup utilities that removes unused or unnecessary files that are no longer 
needed. 

 

Enterprise Applications: These applications are used by personnel to support the 
company in its interaction with customers and employees. Some of the activities include 
entry of orders, billing, payroll, human resource management, and general reporting 
activities. Enterprise applications are specialized or tailor made to the specific activities of 
the company.  

 

Expanded Menu - A menu that displays both common and less-common commands after 
you pause the mouse pointer over it.  

 

File Compression: Reduces the size of a file, Folder or directory. Popular utility is 
WinZip 

 

File Management: Stores Files in an hierarchical structure, to enable various tasks such as 
creating, deleting, copying and moving files, folders and directories. 

 

Financial Software: Provides automated assistance for tax preparation and submission. 
An example is Turbo Tax. 

 

Floating Toolbars - Toolbars that are not attached to the edge of the program window.  

 

Indents - Used to align bullets and text on a slide.  

 

Language Translators: Language translators convert the data in a program (source code) 
into machine language code (object code) so that the computer can then process. The main 
purpose of translating source code to object code is to create a program in machine 
language so that the computer can produce the desired results. 

 

Line Spacing - The vertical distance between lines of text.  
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Normal View - The view you use to create and edit your presentation. It consists of three  

 

Notes Pane - In Normal view, the Notes Pane is used to create notes for each slide in your 
presentation.  

 

Outline and Slides Tabs - One of the panes in Normal view, you use the Outline and 
Slides tabs to toggle between an outline of the text in your presentation and a thumbnail 
view of each slide.  

 

Presentation - An interaction between a speaker and an audience. A presentation usually 
includes one or more visual aids: in the case of PowerPoint, these are slides.  

 

Search Programmes: Used to find files, folders and directories on storage device. 

 

Sizing Handles - Small circles or squares that appear along the border of a selected slide 
or object.  

 

Slide Pane - In Normal view, the area in the center of the application window where you 
create and format your slide content. It displays the current slide.  

 

Slide Sorter View - All slides in the presentation are displayed at once on the screen. In 
this view, you can rearrange, copy, and delete slides.  

 

Spreadsheet Software: Provides built‐in functions to perform calculations and graphics. 

Some examples are Microsoft Excel and Lotus 

 

Task Pane - Provides quick access to commands related to your current task.  

 

Transition Effects - In a slide show, a transition determines how the display changes as 
you move from one slide to the next.  

 

Utility Software: Utility programs are tools that help the operating system manage the 

computer system‘s secondary or non‐priority jobs. These jobs are repetitive in nature. 
Some examples of utility programs include antivirus software, backup software, disk 
defragmentation, disk scanning; file compression software, file management programs, and 
searching software. 

 

Word Processing Software: Provides assistance in formatting, printing documents. Some 
examples are Microsoft Word, and Corel WordPerfect.  

 

WordArt - A tool you can use to create unique text effects. Text objects you create with 
read-made effects to which you can apply additional formatting options.  

 

Workgroup Applications: These applications are used by two or more users who work as 
a team to achieve a common task. The programs therefore should support the sharing of 
information and sections of the work or a project, scheduling group meetings, group 
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electronic mail services, group decision making and conferencing. Some examples of this 
software are project management software, groupware like Microsoft Sharepoint and 
collaborative software like WIKIs (an example of a WIKI is Wikipedia).  

 

Working Areas:  The Outline and Slides tabs, the Slide pane, and the Notes pane.  
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2.11 SUGGESTED READINGS 

 

• Leon & Lion, Introduction to Computers, Vikas Publishing House, New Delhi 

• June Jamrich Parsons, Computer Concepts 7th Edition, Thomson Learning, 
Bombay. 

• Comer 4e, Computer networks and Internet, Pearson Education 

• White, Date Communications & Compute4r Network, Thomson Learning, 
Bombay. 

• Computers in Hotels – Concepts & Applications : Partho P Seal Oxford University 
Press 

2.12 TERMINAL QUESTIONS 

 

1. Define software? What are the different types of software? Explain each in detail. 
2. What do you mean by system software? Explain with suitable examples. 
3. What do you mean by application software? Explain with suitable examples. 
4. What do you mean by system software? Explain with suitable examples. 
5. What do you mean by accounting software? Explain with suitable examples. 
6. What do you mean by anti-virus software? Explain with suitable examples. 
7. What do you mean by backup software? Explain with suitable examples. 
8. What is clipart? What are the uses of clip art in presentation? 
9. What do you mean by database software? Explain with suitable examples. 
10. What do you mean by disk-fragmentation software? Explain with suitable examples. 
11. What do you mean by Enterprise Application? Explain. 
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12. What do you mean by file compression software? Explain with suitable examples. 
13. What do you mean by financial software? Explain with suitable examples. 
14. What do you mean by language translator software? Explain with suitable examples. 
15. What do you mean by search programmes? Explain with suitable examples. 
16.  What do you mean by spreadsheet software? Explain with suitable examples. 
17. What do you mean by utility software? Explain with suitable examples. 
18. What do you mean by word processing software? Explain with suitable examples. 
19. What is WordArt? List the usages of word Art. 
20. What do you mean by Workgroup Applications? Explain with examples 
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UNIT: 03 

INTERNET AND APPLICATIONS 
 

Structure  
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3.2 Objectives 
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3.4 Connecting Computers 

3.5 Network Topologies 

3.5.1 Local Area Network (LAN) 

3.5.2 Metropolitan Area Network (MAN) 

3.5.3 Wide Area Network (WAN) 

3.6 Introduction to Internet 

3.6.1 The World Wide Web 

3.6.2 Using the Internet 

3.6.3 Searching the Internet 

3.6.4 Beyond Browsing and Email 

3.6.5 Unauthorized Access and Control Systems 

3.7 Summary 

3.8 Glossary 

3.9 References/Bibliography 

3.10 Suggested Readings 

3.11 Terminal Questions 

3.1 INTRODUCTION  

This unit is an interesting, but technical one where the discussion expands to the 
connection of more than one computer to meet various needs. It also discusses how these 
computers can be connected and the accompanying reasons or purpose for their 
connections. The popular topic of the Internet is also introduced with its intriguing services 
and benefits, and the different methods of connecting to the world wide web. Computers 
are linked together to exchange data and share resources as said to be networked. Networks 
allow users communicate with others once there is access to a computer. Networks come in 
a variety of forms and support a variety of different asynchronous and synchronous 
communications methods. 

3.2 OBJECTIVES 

After reading this unit the learner will be able to: 

• Define internet 

• Explain the various topologies of networking computer 
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• Explain LAN, MAN and WAN 

• Use e-mail  

• Create awareness about internet security issues 

3.3 COMMUNICATION AND CONNECTIVITY 

In our day to day lives we regular communicate with others through talking, writing, and 
actions. Computer networks communicate by first becoming linked to each other, so that 
data and resources can be shared. For example, two or more computers can be connected to 
each other, along with one printer (a resource), so that each computer is able to print form 
this one printer. This is known as a simple network and you are sharing output devices via 
the network. 
 
Computer communication is achieved when signals are sent and received among and 
between different computers. This exchange of signals allows users to collaborate with 
other online users in different countries. Individuals can share and retrieve information and 
files they can exchange electronic mail and participate in electronic messaging with others 
from all over the world.  

 

Collaboration and Sharing: Computer communication has provided contact among users 
from different cultures, continents, and time zones. Indeed, telecommunications 

technologies such as land lines, satellite, cable, the Internet and cell phone technology have 
made communication possible and affordable over long distances. Many business 
organizations and individuals have taken advantage of teleconferencing and 
videoconferencing – conferencing available on the Internet, and through you telephone, 
cable and satellite providers. Today people do not have to travel for meetings or 
conferences. Telecommunications technologies allow employees to work from home, or 
away from the office, while still interact with the others in the company through computer 
communications. They are able to send and receive documents, share schedules, send 

messages and talk directly with their co‐workers. This ‗work away from the office, is 
known as telecommuting.  

 

Transaction Processing: In previous years data and information were stored in a central 
location, and many users would simultaneously access this single location to retrieve data 
required for a transaction, or other reasons. This caused problems, as not everyone was 
able to access data in a timely fashion. Large numbers of requests to a central processor or 
storage location takes time taken to send and retrieve the large or small amounts of data or 
information. The volume of data moving through the system often slowed the system down 
and at times even crashed or shut down the system. With computer communication 
systems now available, data and information (and indeed the workload) can now be 
dispersed (or distributed) to various sites, subsidiaries or branches of the business in other 
areas of the building or country. Indeed many large corporations link some parts of their 

systems with the systems of their major customers. This inter‐organizational system link 
also allows the corporation‘s systems to link to suppliers for electronic data interchange 
(EDI). This facilitates speedy order processing and other transaction processing.  
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Information Retrieval: Information retrieval is important for decision making in business, 
industry, research organizations, and even for entertainment. Various types of information 
(such as music, text, sound) can now be stored in private or public databases. Once these 
databases are made available online, they can be accessed by select persons either through 
the use of the Internet, or an internal company network, called an Intranet.  

 

Electronic Mail and Electronic Messaging: Electronic mail and electronic messaging are 
one of the most popular methods of communicating among persons of all ages. Messaging 
includes text messaging using cellular phones, online messaging using programs such as 
MSN and Google talk. Paging, sending and receiving sending faxes and the use of voice 

mail are also methods of electronic messaging. Electronic mail (e‐mail) and online 
messaging also enables persons to send and receive softcopy documents as attachments.  

 

Efficient and Effective Communication: In order for computer communication to be 
effective and efficient, many agencies must be involved. These include the 
telecommunications telephone, cable and satellite companies in the various countries, as 
well as the many Internet Service Providers who provide access to the Internet. Indeed the 
number of businesses that are involved in the operation and management of Information 
and Communications Technologies (ICTs) include: software providers; hardware 
providers; custom development companies; online communications and collaboration 
companies; and others. Finally governments must create legislations that governs the 
access to data and the use of data and provides oversight of the telecommunications 
industry. 

3.4 CONNECTING COMPUTERS 

This Topic is a bit technical as it describes the media that are used to connect computers 
together in order to share data and peripheral devices. There are also different ways in 
which computers are connected and it discusses the advantages and disadvantages of each. 
The Topic also includes a brief discussion on the services and benefits of the Internet, and 
the various methods for connecting to the world wide web.  

 

Communication System Components: Wired or wireless media are used to allow 

communications among computers. Wired media include twisted‐pair, coaxial and fibre 

optic cable. Twisted‐pair cable and coaxial cable transmit data by means of electric 
frequencies. These cables therefore need to be protected against water and electromagnetic 
waves. Fibre optic cable is an improvement on the previous two cables. A fibre optic cable 
consists of glass or plastic tubes which transmit data over longer distances at a faster 

speed, using reflection of light. Fibre‐optic cables are more secure and much thinner and 
lighter than other metal wires, and they are not affected by electromagnetic noise such as 

radios, motors and others cables. Although fibre‐optic cables are very costly and difficult 
to install, they are extremely popular with telephone companies, banks, and television 
companies replacing their existing telephone and coaxial cables with more efficient 

fibre‐optic cables.  
 
As the term implies, wireless media in a telecommunications network connects nodes 
without the use of wires. Wireless network systems incorporate cellular technology which 
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uses satellites, radio and other signals, to allow for communication over land and sea 
across the world. Wireless networks are very useful in sending and sharing data qu
within small offices or among business across the world. More importantly they are 
relatively inexpensive in connecting to the Internet, especially in countries where there are 
scarce resources or poor infrastructure. Wireless networks therefore elim
cables, while offering more mobility. However the disadvantage of wireless media is 
interference from other networks that might block the radio signals from passing through.

3.5 NETWORK TOPOLOGIES

The physical layout of a network is call
discussed in this section. A network is a collection of computers which are connected 
together. When sketching the topology, each computer workstation, file server or other 
peripheral is generally called a no
the network, whether physically (the actual layout including cable installation), or logically 
(the actual operation of transferring data), according to the requirements of the network. 
This Topic will discuss four general network topologies. 

 

Bus Topology: This linear 
bus topology is one of the 
simplest of the four network 
topologies to use, in its most 
basic form it is simply a case 
of running one cable called a 
backbone, from the 
computer or perip
device at one end of the 
network to the last peripheral 
device or computer at the other end. Other computers, scanners, printers or other peripheral 
devices are then attached to the backbone anywhere between these two end computers. 

 

Advantages and Disadvantages of Bus Topology

above, it seems relatively easy to connect a computer or peripheral to this topology. It also 
requires less lengths of cable than the other topologies, so it can be economical. Since all 
computers and peripherals depend on this single cable or backbone, the entire network will 
not work if there is a break in the backbone. This will also prove difficult to identify where 
the problem or break is located, if the entire network is not working.
not intended to be used as the only network arrangement where numerous computers and 
peripherals are to be connected. Finally it has the lowest fault tolerance, that is, a single 
problem in the network with a bus topology can halt al

 

Star Topology: A star topology connects computers and peripherals to a central device 
called a hub. Physically the topology looks like a star. So that when a node is sending data 
to another node, the data passes through the hub before
The hub therefore manages and controls the network. 
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uses satellites, radio and other signals, to allow for communication over land and sea 
across the world. Wireless networks are very useful in sending and sharing data qu
within small offices or among business across the world. More importantly they are 
relatively inexpensive in connecting to the Internet, especially in countries where there are 
scarce resources or poor infrastructure. Wireless networks therefore elim
cables, while offering more mobility. However the disadvantage of wireless media is 
interference from other networks that might block the radio signals from passing through.

NETWORK TOPOLOGIES 

The physical layout of a network is called a topology. The four main topologies will be 
discussed in this section. A network is a collection of computers which are connected 

sketching the topology, each computer workstation, file server or other 
peripheral is generally called a node. A network topology therefore, is the arrangement of 
the network, whether physically (the actual layout including cable installation), or logically 
(the actual operation of transferring data), according to the requirements of the network. 

l discuss four general network topologies.  

This linear 
bus topology is one of the 
simplest of the four network 
topologies to use, in its most 
basic form it is simply a case 
of running one cable called a 
backbone, from the 
computer or peripheral 
device at one end of the 
network to the last peripheral 
device or computer at the other end. Other computers, scanners, printers or other peripheral 
devices are then attached to the backbone anywhere between these two end computers. 

Disadvantages of Bus Topology: Of course from the simple description 
above, it seems relatively easy to connect a computer or peripheral to this topology. It also 
requires less lengths of cable than the other topologies, so it can be economical. Since all 
computers and peripherals depend on this single cable or backbone, the entire network will 
not work if there is a break in the backbone. This will also prove difficult to identify where 
the problem or break is located, if the entire network is not working. 
not intended to be used as the only network arrangement where numerous computers and 
peripherals are to be connected. Finally it has the lowest fault tolerance, that is, a single 
problem in the network with a bus topology can halt all of its activities.

A star topology connects computers and peripherals to a central device 
called a hub. Physically the topology looks like a star. So that when a node is sending data 
to another node, the data passes through the hub before continuing to its destination node. 
The hub therefore manages and controls the network.  
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uses satellites, radio and other signals, to allow for communication over land and sea 
across the world. Wireless networks are very useful in sending and sharing data quickly 
within small offices or among business across the world. More importantly they are 
relatively inexpensive in connecting to the Internet, especially in countries where there are 
scarce resources or poor infrastructure. Wireless networks therefore eliminate the maze of 
cables, while offering more mobility. However the disadvantage of wireless media is 
interference from other networks that might block the radio signals from passing through.  

ed a topology. The four main topologies will be 
discussed in this section. A network is a collection of computers which are connected 

sketching the topology, each computer workstation, file server or other 
de. A network topology therefore, is the arrangement of 

the network, whether physically (the actual layout including cable installation), or logically 
(the actual operation of transferring data), according to the requirements of the network. 

device or computer at the other end. Other computers, scanners, printers or other peripheral 
devices are then attached to the backbone anywhere between these two end computers.  

Of course from the simple description 
above, it seems relatively easy to connect a computer or peripheral to this topology. It also 
requires less lengths of cable than the other topologies, so it can be economical. Since all 
computers and peripherals depend on this single cable or backbone, the entire network will 
not work if there is a break in the backbone. This will also prove difficult to identify where 

 This topology is also 
not intended to be used as the only network arrangement where numerous computers and 
peripherals are to be connected. Finally it has the lowest fault tolerance, that is, a single 

l of its activities. 

A star topology connects computers and peripherals to a central device 
called a hub. Physically the topology looks like a star. So that when a node is sending data 

continuing to its destination node. 
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Advantages and 

Disadvantages of Star 

Topology: A new node is 
relatively easy to install by 
adding a cable from the new 
device to the hub. Installing 
and even removing nodes do 
not cause any disruptions to 
the network, so this topology 
has high fault tolerance when 
troubleshooting to detect faults 
and to remove nodes.  
 
Of course if the hub fails, then 
all nodes attached to the network are disabled. It is also more exp
topology because of the cost of installing the cabling and configuring the hub.

 
Ring Topology: The nodes in a ring 
topology are connected to the nodes 
on its left and right, so that data 
passes from one node to the next. Of 

course fault tolerance is non‐existent 
since failure of one node cripples the 
entire network. This is why the 
physical ring topology is rarely used. 
Adding a new device to an existing 
physical Ring network can be 

complicated as any new device needs to go in
 

3.5.1 Local Area Network (LAN) 

A Local Area Network (LAN) is a computer network that functions within a specific 
geographical area, such as a building, school or campus. The network links the computers 
located within the building. In the case of a campus, the computers are linked throughout 
the various buildings using wired cables or wireless communication using radio and other 
signals. Access to the LAN is privileged and controlled by a network administrator. Once 
access is authorized, users can access most of the software, data, and peripherals connected 
to the LAN. The main uses of LANs include the sharing of expensive devices such as 

printers and scanners, as well as the provision of internal Intranet and electronic
services. Public telephone exchanges such as PBXs are also examples of LANs which use 
telephone systems in many organizations. 
 
In order for a LAN to function, a network interface card (NIC) must be installed in the 
computer to provide the connection between the co
operating system software that supports networking are UNIX, Linux, Windows, and Mac 

OS. Two types of LANs are peer‐to
topology.  
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all nodes attached to the network are disabled. It is also more expensive than the bus 
topology because of the cost of installing the cabling and configuring the hub. 

The nodes in a ring 
topology are connected to the nodes 
on its left and right, so that data 
passes from one node to the next. Of 

existent 
since failure of one node cripples the 
entire network. This is why the 
physical ring topology is rarely used. 
Adding a new device to an existing 
physical Ring network can be 

complicated as any new device needs to go in‐between the existing devices. 

 

A Local Area Network (LAN) is a computer network that functions within a specific 
geographical area, such as a building, school or campus. The network links the computers 

the case of a campus, the computers are linked throughout 
the various buildings using wired cables or wireless communication using radio and other 
signals. Access to the LAN is privileged and controlled by a network administrator. Once 

d, users can access most of the software, data, and peripherals connected 
to the LAN. The main uses of LANs include the sharing of expensive devices such as 

printers and scanners, as well as the provision of internal Intranet and electronic
Public telephone exchanges such as PBXs are also examples of LANs which use 

telephone systems in many organizations.  

In order for a LAN to function, a network interface card (NIC) must be installed in the 
computer to provide the connection between the computer and the network. The main 

software that supports networking are UNIX, Linux, Windows, and Mac 

to‐peer and client‐server, which employ a bus or ring 
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ensive than the bus 

A Local Area Network (LAN) is a computer network that functions within a specific 
geographical area, such as a building, school or campus. The network links the computers 

the case of a campus, the computers are linked throughout 
the various buildings using wired cables or wireless communication using radio and other 
signals. Access to the LAN is privileged and controlled by a network administrator. Once 

d, users can access most of the software, data, and peripherals connected 
to the LAN. The main uses of LANs include the sharing of expensive devices such as 

printers and scanners, as well as the provision of internal Intranet and electronic‐mail 
Public telephone exchanges such as PBXs are also examples of LANs which use 

In order for a LAN to function, a network interface card (NIC) must be installed in the 
mputer and the network. The main 

software that supports networking are UNIX, Linux, Windows, and Mac 

server, which employ a bus or ring 
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Peer –to- Peer Networks: All computers on a peer‐to‐peer network are configured 
similarly with no specific computer designated as a file server. Also the users in this type 
of network determine which files and peripherals attached to their computer that they wish 

to share. This is why peer‐to peer networks are simple to set‐up as home businesses, and 
are not appropriate when there are many computers.  

 

Client – Server Networks: Client‐server networks can be set up using various topologies, 
and are appropriate in large corporations. The network requires file servers which contain 
the many application programs. The clients are the networked computers which access the 
server to obtain and use the programs, data, and to access peripherals. 
 

3.5.2 Metropolitan Area Network (MAN) 

A metropolitan area network (MAN) is a computer network that interconnects users with 
computer resources in a geographic area or region larger than that covered by even a large 
local area network (LAN) but smaller than the area covered by a wide area network 
(WAN). The term is applied to the interconnection of networks in a city into a single larger 
network (which may then also offer efficient connection to a wide area network). It is also 
used to mean the interconnection of several local area networks by bridging them with 
backbone lines. The latter usage is also sometimes referred to as a campus network. 
 

3.5.3 Wide Area Network (WAN) 

Wide area networks (WANs) effectively connect LANs which are located at different 
geographical locations – a few miles or thousands of miles away. This way, a large 
corporation or banking institution can share, and exchange data and information, as well as 
perform transactions among its branches using one wide area network system. 
 
Internet Services and Benefits: The Internet is a network of networks, which link local, 
regional, national and international computer networks to exchange data and process tasks. 
In order to efficiently process these tasks and exchange data, a standard called TCP/IP 
(Transmission Control Protocol/ Internet Protocol) comprises a set of rules which must be 
followed. The telecommunication links among the networks of the Internet are built and 
maintained by major telecommunications companies around the world. Each computer 
connected to the  
 
Internet is recognized by a unique number, officially known as an ‗IP Address‘. Data 
travels the Internet from origin computer to destination computer in small chunks called 
‗Packets‘, with the help of ‗routers‘.  

 

Connecting to the Internet: Users can connect to the Internet through a dial‐up 
connection or other more sophisticated connections. Irrespective of how users connect, 
companies called Internet Service Providers (ISP) maintain telecommunications equipment 
so as to provide Internet access to individual users, as well as users involved in business 
and large organizations. An ISP is responsible for providing each user with Internet access 
by connecting your computer to the Internet, much like a telephone company connects 
your phone to the telecommunications network.  
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To get access to the Internet, a user needs an optional local telephone number, a unique 
identification and password for access, and one or more email addresses. This is usually 
accompanied by a stipulated fee monthly, quarterly, yearly or

 

Dial-Up Internet Connection: A dial
which converts your computer‘s digital signals into a type of signal that can travel over 

phone lines. The maximum speed for dial
 

Other Internet Connections: Other Internet connections provide data transfer speeds 

much faster than that of a dial‐up connection, although they both must be in close 
proximate to a telephone port. An Integrated Services Digita
data transfer speeds of 128K, while a Digital Subscriber Line (DSL) is a general name for 
a family of high –speed Internet links, including ADSL, SDSL, and DSL lite. These 
provide data transfer speeds up to 125 times faster than d

 

Web Browsers: Just as you would use a software program such as a word processor, web 
browsers are also software programs that are also installed on your computer. Their 
purpose however is to allow you to access one or more web pages. In simpler te
browser is just a way to help you get around the Internet, so whenever you type in an 
address for distance education to access your notes, for example, you are using a browser. 
Browsers are also useful for downloading files from databases stored
linking you to other pages from a main home page. Each browser keeps a list of the pages 
you have viewed on the Web, so that you can return to that site, even if you visited it days 
ago.  
 
A typical web page contains mostly text, with
movies or other small programs. Your browser translates the HTML language that was 
used to create each web page into a presentable form that users can understand. Figure 45 
shows a typical browser while Figure 46 show
web page. 
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To get access to the Internet, a user needs an optional local telephone number, a unique 
identification and password for access, and one or more email addresses. This is usually 
accompanied by a stipulated fee monthly, quarterly, yearly or simply a block of hours. 

A dial‐up connection requires a device called a modem, 
which converts your computer‘s digital signals into a type of signal that can travel over 

phone lines. The maximum speed for dial‐up is 56Kbps, or 56,000 bits per second.  

Other Internet connections provide data transfer speeds 

up connection, although they both must be in close 
proximate to a telephone port. An Integrated Services Digital Network (ISDN) provides 
data transfer speeds of 128K, while a Digital Subscriber Line (DSL) is a general name for 

speed Internet links, including ADSL, SDSL, and DSL lite. These 
provide data transfer speeds up to 125 times faster than dialup.  

Just as you would use a software program such as a word processor, web 
browsers are also software programs that are also installed on your computer. Their 
purpose however is to allow you to access one or more web pages. In simpler terms, a web 
browser is just a way to help you get around the Internet, so whenever you type in an 
address for distance education to access your notes, for example, you are using a browser. 
Browsers are also useful for downloading files from databases stored on the Internet, and 
linking you to other pages from a main home page. Each browser keeps a list of the pages 
you have viewed on the Web, so that you can return to that site, even if you visited it days 

A typical web page contains mostly text, with some pictures, and even media such as 
movies or other small programs. Your browser translates the HTML language that was 
used to create each web page into a presentable form that users can understand. Figure 45 
shows a typical browser while Figure 46 shows the html code that was used to create the 
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To get access to the Internet, a user needs an optional local telephone number, a unique 
identification and password for access, and one or more email addresses. This is usually 

simply a block of hours.  

up connection requires a device called a modem, 
which converts your computer‘s digital signals into a type of signal that can travel over 

Other Internet connections provide data transfer speeds 

up connection, although they both must be in close 
l Network (ISDN) provides 

data transfer speeds of 128K, while a Digital Subscriber Line (DSL) is a general name for 
speed Internet links, including ADSL, SDSL, and DSL lite. These 

Just as you would use a software program such as a word processor, web 
browsers are also software programs that are also installed on your computer. Their 

rms, a web 
browser is just a way to help you get around the Internet, so whenever you type in an 
address for distance education to access your notes, for example, you are using a browser. 

on the Internet, and 
linking you to other pages from a main home page. Each browser keeps a list of the pages 
you have viewed on the Web, so that you can return to that site, even if you visited it days 

some pictures, and even media such as 
movies or other small programs. Your browser translates the HTML language that was 
used to create each web page into a presentable form that users can understand. Figure 45 

s the html code that was used to create the 
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It is important that browsers provide efficient ways to manage bookmarks, cookies, tabbed 

browsing, pop‐up blocker as well as have ample security options. Users may even prefer 

auto‐fill capabilities for web
 
There are many different browsers available, although the popular one is Internet Explorer 
(or IE). However all browsers should be able 
and at about the same speed. 

 

Search Engines: Search engines access many web sites which match your request, and 
then show a list or sample of the web pages so that you can select those that you are 
interested in. generally, search engines carry out some of the following tasks. Gather a list 
of web pages:  

• Based on a user‘s search for a word, phrase, web page or similar option. 

• Through listing each page that contains the search word or similar words. 

• If the search word is an embedded link on a web page, then the search engine 
peruses that link also. 

• Rank the search results by web pages that contain or link to that search term most 
frequently.  

 

Problems with Searching

those web pages that are relevant to what you are searching for. However, words and 
phrases differ in context, so you may also see other listing which do not relate to what you 
need. In addition, you may also see duplicate listings since 
with your search term, as well as all of the links from the same web page that also contain 
the search term.  
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Search for a word or phrase in a browser window, will produce 
those web pages that are relevant to what you are searching for. However, words and 
phrases differ in context, so you may also see other listing which do not relate to what you 

the search will list the web page 
with your search term, as well as all of the links from the same web page that also contain 
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World Wide Web Basic Terminology 

 
 

CHECK YOUR PROGRESS-I 

 
1. Write a note on ‘LAN’. 
____________________________________________________________________________
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2. Write a note on ‘WAN’. 
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____________________________________________________________________________
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3.6 INTRODUCTION TO INTERNET

The internet has changed dramatically since its first incarnation. In 1969 the U.S. 
department of defence
created ARPANET. 
 
The original concept 
of this project was to 
connect researchers 
located in different 
places to be able to 
communicate and 
collaborate from far 
distances. The fear of 
nuclear attack was 
very prevalent at this 
time, so the team also 
wanted to make a network that could still operate after a nuclear attack. Therefore creating 
many different fail safes, and alternative routes for packet
project grew, more and more people gained access to the internet and began shaping it to 
what we know today. As we have described before, everyone who uses the internet is 
called an internet user. 
 
For these users to obtain access to the int
service provider.) Side note, while the internet is not owned by any one company or 
government, it is most assuredly not free. It costs money to build, run, and maintain the 
servers that bring you the funny cat v
Internet 2 is an amalgamation of different leaders in the field of academia, technology, 
industry, and government that formed together in order to collaborate on pioneering and 
innovative ideas that help advance education and research. They test ne
applications and technologies using high
opinion, Internet 2 is not a gathering of minds who intend to replace the current Internet 
but congregate to ensure that the future Internet will be capable of ope
engineering. Internet 2 is currently being upgraded to 8.8 terabytes! This will aide in the 
ability to offer advanced telemedicine and long distance learning opportunities across 
connected countries through its network.

 

3.6.1 The World Wide Web

The World Wide Web is different than the Internet. The Internet started out being used 
more by private industries and people such as scientists, schools, and the government. The 
public had not used it for the most part because it was complex and 
computer in order to access it, which not everyone did. In 1989 Tim Berners
with the World Wide Web and thought it would be a good way to organize information 
and take place of the Internet. Although the Internet still stayed 
the World Wide Web was a great tool for researches at the time. The World Wide Web is 
not owned by one single business or person, but the webpages are. The Web consists of 
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as changed dramatically since its first incarnation. In 1969 the U.S. 
defence 

The original concept 
of this project was to 
connect researchers 
located in different 
places to be able to 
communicate and 
collaborate from far 

tances. The fear of 
nuclear attack was 
very prevalent at this 
time, so the team also 
wanted to make a network that could still operate after a nuclear attack. Therefore creating 
many different fail safes, and alternative routes for packet sending was neces
project grew, more and more people gained access to the internet and began shaping it to 
what we know today. As we have described before, everyone who uses the internet is 
called an internet user.  

For these users to obtain access to the internet, you must go through an ISP (internet 
service provider.) Side note, while the internet is not owned by any one company or 
government, it is most assuredly not free. It costs money to build, run, and maintain the 
servers that bring you the funny cat videos.  
Internet 2 is an amalgamation of different leaders in the field of academia, technology, 
industry, and government that formed together in order to collaborate on pioneering and 
innovative ideas that help advance education and research. They test ne
applications and technologies using high-performance networks. Contrary to popular 
opinion, Internet 2 is not a gathering of minds who intend to replace the current Internet 
but congregate to ensure that the future Internet will be capable of ope
engineering. Internet 2 is currently being upgraded to 8.8 terabytes! This will aide in the 
ability to offer advanced telemedicine and long distance learning opportunities across 
connected countries through its network. 

Wide Web 

The World Wide Web is different than the Internet. The Internet started out being used 
more by private industries and people such as scientists, schools, and the government. The 
public had not used it for the most part because it was complex and 
computer in order to access it, which not everyone did. In 1989 Tim Berners
with the World Wide Web and thought it would be a good way to organize information 
and take place of the Internet. Although the Internet still stayed around, and still is today, 
the World Wide Web was a great tool for researches at the time. The World Wide Web is 
not owned by one single business or person, but the webpages are. The Web consists of 
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The World Wide Web is different than the Internet. The Internet started out being used 
more by private industries and people such as scientists, schools, and the government. The 
public had not used it for the most part because it was complex and you had to have a 
computer in order to access it, which not everyone did. In 1989 Tim Berners-Lee came up 
with the World Wide Web and thought it would be a good way to organize information 

around, and still is today, 
the World Wide Web was a great tool for researches at the time. The World Wide Web is 
not owned by one single business or person, but the webpages are. The Web consists of 
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things such as HTML, URL, and HTTP. HTML stands for Hyper Text Markup Language 
and is used for formatting documents on the Web. URL is the Uniform Resource Locator 
which most of us are familiar with when typing in addresses to websites. And lastly, HTTP 
is Hyper Text Transfer Protocol. This is what lets people click on hyperlinks and be 
redirected to that specific location. The World Wide Web has changed the way schools 
teach, businesses run, and average people have been able to access organized information. 
Pictures and documents are now easier to access and research and recreational websites 
can now be found in one place. 
 

3.6.2 Using the Internet 

Setting Set Up To Use The Internet: Almost every household has access to the internet; 
therefore, it is important to know how to have access to the world wide web. There are five 
basic steps to set up an internet connection which consist of the following:  

1. One must connect the hardware. Different hardware and software contain directions 
in setting up. Use the directions to set up these systems.  

2. The internet needs a wireless connection or an Ethernet cable before it can go 
online. Therefore, the computer owner must make this connection.  

3. The computer owner must connect to the default IP Crystal Clear app Internet 

Connection Tools address. The IP address usually consists of eight numbers, and it 
is broken up occasionally by periods.  

4. It is the internet’s server’s responsibility to show the computer owner how to 
actually establish the connection. One must then set up a name and password for 
security purposes.  

5. Save the settings, and the internet light will turn green to indicate one is online.  
 
Different Internet Connections: There are many different kinds of internet connections. 
A few of these connections consist of wireless, broadband, and dial-up. Wireless is a router 
or a network that connects to a hot spot. A broadband is connected directly to a broadband 
modern, and one needs a user name and password to connect. A dial-up is used remotely 
via a telephone line. Different types of internet connections come with their own pros and 
cons and it is important to choose one that will work well with your lifestyle and your 
wallet.  
 

1. Dial-up: Dial-up connection requires a phone line to function. Because of this, 
people cannot be using the phone and the internet at the same time. When 
connecting to the internet via dial-up, the computer tries to connect through the 
phone line and causes dial-tones and many numerous sounds to emit from the 
modem. Dial-up is also the slowest form of internet connection and has a maximum 
speed of 56 kilobits per second.  
 

2. Wi-fi Hotspots: Wi-fi hotspots are another form of internet connection in which a 
wireless access point, such as a router, has a direct connection to the internet and 
allows people to connect wirelessly through the use of wifi. Although they aren‘t 
used very much at home, wi-fi hotspots are often used at locations such as 
restaurants, hotels, and airports. Many restaurants such offer free wifi to entice 
customers, while others have a fee for using their internet.  
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3. Broadband over Fiber: A new technology called broadband over fiber (BoF) is a 

direct connection option for internet access. Internet service providers are starting 
to adopt this new technology and sell it for a fee. For example, Verizon‘s version of 
broadband over fiber is called fiber-optic service (FiOS). FiOS, in particular, is able 
to provide services such as telephone, television, and internet. BoF is advertised on 
Verizon‘s FiOS webpage as a network that, ―provides bandwidth to meet today‘s 
digital demands and the possibilities of tomorrow.ǁ This statement is probably used 
because BoF‘s data transfer speeds are much faster than other services. In fact, with 
fiber-optic cabling, data transfer can travel at the speed of light. One drawback of 
BoF is that it is very expensive. In order to create a fiber-optic network, you must 
invest a lot of money in constructing an essential infrastructure. Another negative 
with broadband over fiber is that the cables are very sensitive. This means that 
cables cannot be installed on telephone poles or underground. Cables must be 
installed above ground, usually in piping, so that the cables are protected from 
bending and shifting. BoF is practical and efficient for small networks due to less 
complex construction of infrastructure. This being said, the United States probably 
won‘t have nation wide BoF networks.  

 

Selecting an ISP: There are many different Internet Service Providers, some of the most 
popular include Comcast, AT&T, Verizon, and Time Warner Cable. When you choose an 
ISP, there are many factors to take into consideration. Some of those factors include price, 
type of internet connection you want, speed, customer support, types of devices you use, 
and cancelation policies. Some internet service providers, such as Verizon and Google, are 
now starting to offer fiber- optic internet connections. Fiber-optics allows unsurpassed 
connection speeds, both upload, and download. Fiber-optic internet connections employ 
Fiber-optic cables that transfer large amounts of data through hundreds of stands of glass 
or plastic which employ an entirely light based, optical technology. The technology has 
existed for many years, but many may have begun to hear that it has become more 
commonly available over the recent years.  
 
After implementing fiber-optics in commercial internet service packages, Internet Service 
Providers are now able to confidently boast connection speeds exceeding 100gigabits per 
second, speeds that are much more desirable to many households as well as businesses. 
Fiber optic networks are, to no surprise, very expensive. Massive internet service providers 
such as Comcast, AT&T, and COX may not be ready to spend hundreds of millions, and 
even billions on city wide fiber- optic networks, thus making the transition to fiber-optics 
before the technology a long one. Google alone spent over 80 million dollars to reach 
150,000 households with their fiber-optic connections. Only a small handful of cities 
currently have the luxury of a fiber-optic connection, and it may take some years before the 
technology is available to a majority of households. 
 

3.6.3 Searching the Internet 

Search Sites: Search sites are websites that are specifically created to help search the 
Internet. Examples would include, ―Google,ǁ ―Bing,ǁ ―Yahoo! Search,ǁ and 
―Ask.com.ǁ There are also many other not as well known search sites. Search sites 
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generally use a search engine, which is a program for the retrieval of data from a database 
or network. A search engine includes a spider, which goes to every page on every Web site 
that wants to be searchable and reads it
the pages that have been read. Then a program that receives your search request and 
compares it to the index, then gives you results. Most search sites today are designed for 
keyword searches, which is when you type in keywords describing what you are searching 
for. A directory search is the other kind of search hat some sites allow and it uses lists of 
categories instead of a search box.  
 
Many search sites will also contain tools that can be used to fin
try to present their results as clearly as possible. They will also tend to make suggestions 
about things that are similar to what you searched that may help you find what you are 
looking for. 
 
 

Search Strategies: Searching for particular information can be fun but also can be very 
frustrating. Here are few different search strategies which can help to find the information 
needed, such as simple, complex, phrase, natural language and default Boolean Logic 
searching. Simple searching is the easiest method of using a search tool. The user can type 
one or more key words (spelling counts) in the search box then click on the search button. 
Complex searching is using Boolean Logic to improve search efficiency. The words such 
as AND, OR, and NOT are entered between keywords to refine the search. In phrase 
searching, a user should enclose quotation marks when searching for specific phrase. Most 
search engines like Google, Bing, and such recognize this protocol. Natural Language 
searching is allowing a user to type a sentence or question just the way he/she might like 
and the search tool will try to determine key words and locate pages based on these words. 
Default Boolean Logic searching allows a user to type key words as in simple search.
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Search tool, depends on its default, will use OR or NOT. If a user is tired of typing, she/he 
can click on the microphone icon in the Google app or Chrome‘s search box to search by 
voice. 

 

3.6.4 Beyond Browsing and Email

Instant Messaging and Text Messag

important tool that humans can hone. While e
friendly method of Internet
are faster and easier. These two types of
messaging. Instant messaging, also referred to as 
chat, allows you to type out a message on your 
keyboard and then press 'enter' to have it sent 
immediately to the other party. Unlike emails, 
where you have to wai
around at their computer to read the message, and 
THAT is assuming your email didn't get lost 
because of a faulty spam filter, 
 
IM‘s create a connection that is almost as good as 
being in the same room with the friend. To inst
message a friend, you typically both need the 
same IM client, of which there are many free 
varieties such as AIM, MSN, YIM, and Skype.
 
Text messaging, which is also called SMS (Short 
Message Service), used to be the most popular 
means of speedy commu
been on the decline.[24] Text messaging allows 
users to send fast and typically short notes with their cellular phones. The major downside 
of text messaging is how many cellphone companies charge a ton for your texts while 
instant messaging is free (plus the cost of the internet for your computer or phone, of 
course). Also text messages, like 
emails, need to be waited for and can 
sometimes not make it to the right 
place without a glitch whereas 
instant messengers tend to have a 
better track record.  

 

Online Shopping: Amazon and 

More: Online shopping is so 
convenient for many who are on the 
go. There are no hours of operation 
to abide by, no lines to wait in, and 
consumers do not even have to leave 
the comfort of their own home to get 
what they want. There are some downsides of online shopping, such as not being able to 
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Beyond Browsing and Email 

Instant Messaging and Text Messaging: Communication is quite possibly the most 
important tool that humans can hone. While e-mails are a fast and environmentally
friendly method of Internet-based communication, there are two types of messaging that 
are faster and easier. These two types of messaging are: instant messaging and text 
messaging. Instant messaging, also referred to as 
chat, allows you to type out a message on your 
keyboard and then press 'enter' to have it sent 
immediately to the other party. Unlike emails, 
where you have to wait for the other person to be 
around at their computer to read the message, and 
THAT is assuming your email didn't get lost 
because of a faulty spam filter,  
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try on clothes to see if it is the right size. The largest online retailer is Amazon.com. 
Shoppers seems to go-to website for all online shopping needs. The retailer star
online book store, but now offers purses, electronics, movies, music, and even sports 
equipment, just to name a few. Sellers can create accounts fairly easy and try to sell their 
goods. Buyers need to be the cautious ones and look into the review
buying from. 
 
One advantage of shopping with Amazon is that they have an A
buyers resolve conflict with the sellers. Amazon expanded their services to include areas 
such as Amazon Art, Amazon Instant Video, 
Wireless, Amazon Fresh, and Amapedia. One controversy that comes up with 
Amazon.com, their true county sales tax. Instead they are paying the sales tax that Amazon 
collects. To challenge Amazon, Google has decided to star
Google wants to compete with amazon and their ability to sell merchandise around the 
world. Google is allowing consumers to search for something and Google would tell them 
if there is somewhere nearby to purchase that item.
They would charge $95 a year or $10 a month, or pay $4.99 per order. Google is also 
offering overnight shipping.  

 

Online Banking: Online Banking has become increasingly popular in this tech
generation. Most banks now allow transactions to be done online through their website or 
through phone apps. While some people question the security of making transactions 
online, the biggest advantage is that online banking is very convenient. People can set up 
accounts through a few simple steps, can make transactions between different accounts 
they have, transfer money, make payments on credit cards, and more. Some onlyonline 
banks have formed and are gaining popularity because they have less fees and thus are 
cheaper. Some banks try to offer deals with higher yield to make online banking more 
appealing. Lastly, it is handy to have 24/7 access to speedy transactions, which traditional 
banks cannot offer. Online banking did have a shaky start, but now it is growing quickl

 

Social Media: Besides texting, instant messaging, and online shopping, there are hundreds 
of other things you can use the Web for. One of the 
main things people use it for today is social media. 
Things from Facebook and Twitter to email sites 
used to share information to groups of people over 
the Internet. The problem with the huge explosion 
that has been the beginning of the social media era 
is that it is becoming increasingly difficult to 
believe information posted online. The Internet has 
evolved so much that now we are able to even 
perform video and telephone functions through it. 
Sites like Skype are taking advantage of this 
technology. According to the FCC (Federal 
Communications Commision) the technology used 
by Skype, Vonage, and other similar 
technology as one ―that allows you to make voice calls using a broadband Internet 
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Some banks try to offer deals with higher yield to make online banking more 
appealing. Lastly, it is handy to have 24/7 access to speedy transactions, which traditional 
banks cannot offer. Online banking did have a shaky start, but now it is growing quickl

Besides texting, instant messaging, and online shopping, there are hundreds 
of other things you can use the Web for. One of the 
main things people use it for today is social media. 
Things from Facebook and Twitter to email sites 

share information to groups of people over 
the Internet. The problem with the huge explosion 
that has been the beginning of the social media era 
is that it is becoming increasingly difficult to 
believe information posted online. The Internet has 

o much that now we are able to even 
perform video and telephone functions through it. 
Sites like Skype are taking advantage of this 
technology. According to the FCC (Federal 
Communications Commision) the technology used 
by Skype, Vonage, and other similar Companies is called VoIP. They define this 
technology as one ―that allows you to make voice calls using a broadband Internet 
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through a few simple steps, can make transactions between different accounts 
they have, transfer money, make payments on credit cards, and more. Some onlyonline 
banks have formed and are gaining popularity because they have less fees and thus are 

Some banks try to offer deals with higher yield to make online banking more 
appealing. Lastly, it is handy to have 24/7 access to speedy transactions, which traditional 
banks cannot offer. Online banking did have a shaky start, but now it is growing quickly.  

Besides texting, instant messaging, and online shopping, there are hundreds 

Companies is called VoIP. They define this 
technology as one ―that allows you to make voice calls using a broadband Internet 
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connection instead of a regular (or analog) phone lineǁ.[29] Essentially, performing 
telephone functions through the Internet is VoIP. Social Media has seemingly 
encompassed the younger generations of today; while it has been slower to catch on with 
the older generations, it is something that has been increasing over time.  
 
Skype had recently acquired a newer company called Qik and plans on dominating the new 
way for people to communicate using mobile video messaging. Skype Qik is supposed to 
be very simple, and it is exactly like texting but all video. A person can send a Qik video to 
anyone and they do not even have to have the app. These conversations are asynchronous 
and Skype Qik is a great idea for communication since things like facetime have been a big 
trend. The thing with facetime though is that someone has to answer the phone and both 
people need to use it at the same time; with Skype Qik people have the ability to have that 
type of video interaction but at no specific time. Skype Qik was developed by Microsoft,a 
dn is available on a PC or Mac, and for the iPhone, Android, or Windows phone. 
 
Another popular social media app is Snapchat. This app allows people to send pictures, 
videos, and texts, just like other apps, but the catch is that once the picture/ video/text is 
opened, it disappears after the set amount of time and cannot be see again. Snapchat has 
many features which make Snapchat photos and videos more fun and interesting than on 
other apps. Such features include filters, different text fonts, and the ability to draw on the 
pictures/videos with different colors. In addition to these original features, Snapchat has 
added a feature called ―My Storyǁ where users can create a chain or video of multiple 
pictures and videos combined. This story is not sent to one specific person, rather any of 
the user‘s friends can see it; the set time in this feature determines how long the picture 
shows in the ―slide showǁ and the story is available for only twenty-four hours. The latest 
feature is ―geolocationǁ which can give you the time, weather, miles per hour, or other 
site-specific filters based on your location.  

 

Blogs, Wikis, and Other Types of Online Writing: A blog is a Web page that contains 
short, frequent updated entries in chronological order, typically as a means of expression or 
communication. Blogs can be written by anyone, including ordinary people, celebrities, or 
even experts of certain fields. As blogs become more and more popular, commercial 
advertising begins to be commonly seen on more of the popular blogs. Some of the most 
popular blogs are websites that offer information or helpful tips to their readers. For 
example, as of October 2014, the top three most popular blogs are: Huffington Post, TMZ, 
Business insider. Another form of online writing, most often used for education purposes, 
is the wiki. Wikis are a way of creating and editing collaborative Web pages quickly and 
easily. Unlike a blog, wikis are meant to be edited by anyone, not just the owner of the 
typed information. One of the largest wikis is Wikipedia (Wikibooks is an example of a 
wiki too).  
 
While wikis are helpful and collaborative, erroneous information can be added 
intentionally. As a result, it is recommended to be careful when fully trusting a wiki page. 
Another type of online writing is an e-portfolio. An electronic portfolio is a collection of 
an individual‘s work accessible through a website. Today. e-portfolios are commonly 
linked to student-related information, such as resumes, papers, or projects.  
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Online Gaming: Everywhere you look, young people are using smartphones, notebook 
computers, iPads, etc. Often, they are not just using these devices for school research, 
homework, or studying. Young people can be seen playing games on computing devices as 
young as 3 years old. Online gaming is a rapid habit that is starting from a very young age. 
Often, the habit carries into the young adult years for many individuals. Nowadays, there 
are whole web sites whose sole purpose is hosting games that can be played online. Online 
games can be played alone or with other individuals who are also online. The games that 
are designed to be played by multiple players are called online multiplayer games. Some 
examples of online multiplayer games are Doom, EverQuest, Final Fantasy, City of 
Heroes, and World of Warcraft. Also, gaming devices, such as, PlayStation 3, Xbox 360, 
and Wii, are deigned to be Internet-enabled so they can be connected to the Internet to play 
with other players.  

 

Video Chatting: Video calls have played a major part in science fictionfor decades. They 
were a major part of the film 2001: A Space Odyssey, and many other films and TV shows 
of that genre. Now, video chatting capabilities are found as standard on most desktops, and 
mobile devices. On of the most well known programs, and the program that pioneered 
video chatting, is Microsoft‘s Skype. In recent years, Skype has been joined by Apple‘s 
Facetime, and a video chat program embedded in Google Hangouts.  
 
Skype is compatible with Microsoft, Mac, and Linux computers, and there is and app for 
mobile devices. Facetime however, is only available on Apple devices, although the 
company has promised to make it compatible with other devices at some point. Google 
Hangouts, being a part of Google online app suite, is available as long as the user is able to 
access the Internet. There are other free source programs, but these three are the most 
common and the most trusted by security programs. Video chatting was touted as a 
futuristic ideal, but in recent years, this has not held true. Video chatting use has decline in 
favor of texting and online testing apps. These may be the future as opposed to video 
chatting. 
 

3.6.5 Unauthorized Access and Control Systems 

Unauthorized Access and Control Systems: Firewall is a type of security system that 
creates a wall that checks all incoming and outgoing messages to ensure only authorized 
traffic goes through. There are many different forms of this application such as Norton and 
Windows Security Essentials. Another way to protect your information is through 
encryption. Encryption basically scrambles and makes any message sent unreadable to 
anyone who does not have a key. The key is then used to decrypt the scrambled message 
into the original format.  
 
Whenever you go to a website that has an 'S' after the HTTP that means it is a secure web 
page, meaning the entire web page is encrypted. Therefore, people hacking to your web 
browser cannot get you credit card number or SSN. One question that arises is, ―Can't 
you just make every website a secure web page?". The simple answer is money, a site 
owner needs to pay someone to encrypt the site. Then to send the data takes up more 
bandwidth, and slows down traffic in general. Another form of protection is a VPN 
(Virtual Private Network). A VPN creates a link between the user and some other 
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destination. In order to access the VPN you will need a username and password, in order to 
keep it more secure and to block out hackers.
 
Firewalls can work in a number of ways, but a couple types of firewalls are more widely 
used over others. The two most common firewalls are packet

 

Packet-Filtering Firewall

whether it is safe or not. After examining a packet, the filter will either allow in or block 
out the packet depending on if it
switches, wireless access points, etc. 
A disadvantage of using a packet
blocked by accident. This means that it is possible that parts of information could be 
missing due to a packet being 
blocked.  

 

Proxy Firewall: Most Secure 
direct connections are limited by 
packets being sent from one 
computer to the proxy, and then 
mirrored over to the computer on 
the receiving end. More secure 
decisions are able to be made in 
Application settings through 
strong analysis.  
 
A disadvantage of a proxy fi
Although decrease in speed or functionality is a disadvantage, it is important to remember 
key advantages. While using a proxy firewall it is difficult for someone to figure out the 
location of where packets were sent from.
 
The Internet was created as an open system for the free exchange of information. Due to 
the openness of an ideology, the Internet provides to 
opportunities for the penetration into inform
filter incoming and outgoing traffic that flows through your system. The Firewall uses one 
or more sets of rules to check the network packets as they enter or exit through a network 
connection, it either allows 
for protection a single host as well as to protect the entire network. A computer Firewall 
may be built-in into the Operation System or installed separately. The network Firewalls 
are the more complicated systems, combined hardware and software. These days, there is 
no single, the universally accepted classification of firewalls. But according to the methods 
of deploying it is possible to identify three following types of them. Filtering router
the routers or a servers running on a program configured to filter incoming and outgoing 
packets. The Packet filtering is carried out on the basis of information contained in TCP
and IP-packet headers. Firewalls based on Session layer gateways. 
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destination. In order to access the VPN you will need a username and password, in order to 
e and to block out hackers. 

Firewalls can work in a number of ways, but a couple types of firewalls are more widely 
used over others. The two most common firewalls are packet-filtering and proxy. 

Filtering Firewall: A packet-filter simply examines each packet to determine 
whether it is safe or not. After examining a packet, the filter will either allow in or block 
out the packet depending on if it’s safe or not. Packet-filters are common among routers, 
switches, wireless access points, etc.  

sadvantage of using a packet-filter firewall is that some packets that are safe may be 
blocked by accident. This means that it is possible that parts of information could be 
missing due to a packet being 

Most Secure - 
ections are limited by 

packets being sent from one 
computer to the proxy, and then 
mirrored over to the computer on 
the receiving end. More secure 
decisions are able to be made in 
Application settings through 

A disadvantage of a proxy firewall is that it can slow down the transfer speed of packets. 
Although decrease in speed or functionality is a disadvantage, it is important to remember 
key advantages. While using a proxy firewall it is difficult for someone to figure out the 

where packets were sent from. 

The Internet was created as an open system for the free exchange of information. Due to 
the openness of an ideology, the Internet provides to “bad guys” the significantly greater 
opportunities for the penetration into information systems. Firewalls make it possible to 
filter incoming and outgoing traffic that flows through your system. The Firewall uses one 
or more sets of rules to check the network packets as they enter or exit through a network 
connection, it either allows the traffic through or blocks it. The Firewall could be applied 
for protection a single host as well as to protect the entire network. A computer Firewall 

in into the Operation System or installed separately. The network Firewalls 
complicated systems, combined hardware and software. These days, there is 

no single, the universally accepted classification of firewalls. But according to the methods 
of deploying it is possible to identify three following types of them. Filtering router
the routers or a servers running on a program configured to filter incoming and outgoing 
packets. The Packet filtering is carried out on the basis of information contained in TCP

packet headers. Firewalls based on Session layer gateways.  
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destination. In order to access the VPN you will need a username and password, in order to 

Firewalls can work in a number of ways, but a couple types of firewalls are more widely 
filtering and proxy.  

s each packet to determine 
whether it is safe or not. After examining a packet, the filter will either allow in or block 

filters are common among routers, 

filter firewall is that some packets that are safe may be 
blocked by accident. This means that it is possible that parts of information could be 

rewall is that it can slow down the transfer speed of packets. 
Although decrease in speed or functionality is a disadvantage, it is important to remember 
key advantages. While using a proxy firewall it is difficult for someone to figure out the 

The Internet was created as an open system for the free exchange of information. Due to 
“bad guys” the significantly greater 

ation systems. Firewalls make it possible to 
filter incoming and outgoing traffic that flows through your system. The Firewall uses one 
or more sets of rules to check the network packets as they enter or exit through a network 

the traffic through or blocks it. The Firewall could be applied 
for protection a single host as well as to protect the entire network. A computer Firewall 

in into the Operation System or installed separately. The network Firewalls 
complicated systems, combined hardware and software. These days, there is 

no single, the universally accepted classification of firewalls. But according to the methods 
of deploying it is possible to identify three following types of them. Filtering routers are 
the routers or a servers running on a program configured to filter incoming and outgoing 
packets. The Packet filtering is carried out on the basis of information contained in TCP- 
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This class of routers is a repeater TCP
authorized client for specific services and after validation of the requested session 
establishes a connection to the destination. Firewalls based on Application layer gatewa
In order to protect a number of vulnerabilities inherent filtering routers, firewalls should be 
used by applications to filter connections with services such as Telnet and FTP. This 
application is called proxy-service. This gateway eliminates the direc
the client and authorized external host. The gateway filters all incoming and outgoing 
packets at the application layer. Application Layer Gateways are good for protection; since 
the interaction with the outside world is realized thro
applications, fully control all incoming and outgoing traffic. Note that application
gateways require a separate application for each network service. 
 
These categories can be considered as the 
basic components of real firewalls. 
However, these components reflect the 
key features that distinguish firewalls 
from each other.  
 
Biometric Access Systems identify an 
individual based on their fingerprint, iris, 
or facial features or other unique 
physiological characteristic. Keystroke 
Dynamics recognize an individual‘s 
personal typing pattern to authenticate 
the user as s/he types a username or 
password. Biometric readers allow access 
based on the persons physical 
characteristics. Fingerprint readers and retinal
an individual in order to identify them and offer high security based on these measures. 
They are typically used to control access to high risk facilities such as government 
property, prisons, and corporate headquarters. F
equipped into laptops in order to offer a higher standard of protection in securing personal 
files. In the same way, a person can download face recognition software onto their laptop 
as well. Because biometrics is entirely unique to the user, they are extremely accurate.
 
In the same way no two people will have the same fingerprint, a 
iris‘are as equally unique. In fact, the odds of another person having the same features as 
another is about 1 in 10^78 power.  
 
Identification Systems are a type of Access Control System that reassures whoever wants 
to access your system has authorization. Along with this, Authentication Systems makes 
sure the person is who they say they are. 
 
Possessed Knowledge Access Systems; with a lapse of time a person is more likely to forget 
their answer to a security question, especially if it had multiple answers. Lastly, Possessed 
Object Access Systems are a way to identify you with a physical object such as a keycard or
badge. Access Control Systems link up to different types of readers that have the ability to hold 
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is class of routers is a repeater TCP-connection. Gateway receives a request from 
authorized client for specific services and after validation of the requested session 
establishes a connection to the destination. Firewalls based on Application layer gatewa
In order to protect a number of vulnerabilities inherent filtering routers, firewalls should be 
used by applications to filter connections with services such as Telnet and FTP. This 

service. This gateway eliminates the direct interaction between 
the client and authorized external host. The gateway filters all incoming and outgoing 
packets at the application layer. Application Layer Gateways are good for protection; since 
the interaction with the outside world is realized through a small number of authorized 
applications, fully control all incoming and outgoing traffic. Note that application
gateways require a separate application for each network service.  

These categories can be considered as the 
eal firewalls. 

However, these components reflect the 
key features that distinguish firewalls 

Biometric Access Systems identify an 
individual based on their fingerprint, iris, 
or facial features or other unique 

c. Keystroke 
Dynamics recognize an individual‘s 
personal typing pattern to authenticate 
the user as s/he types a username or 
password. Biometric readers allow access 
based on the persons physical 
characteristics. Fingerprint readers and retinal scanners isolate an unchangeable property in 
an individual in order to identify them and offer high security based on these measures. 
They are typically used to control access to high risk facilities such as government 
property, prisons, and corporate headquarters. Fingerprint scanners have also been 
equipped into laptops in order to offer a higher standard of protection in securing personal 
files. In the same way, a person can download face recognition software onto their laptop 

y unique to the user, they are extremely accurate.

In the same way no two people will have the same fingerprint, a persons‘facial features and 
as equally unique. In fact, the odds of another person having the same features as 

Identification Systems are a type of Access Control System that reassures whoever wants 
to access your system has authorization. Along with this, Authentication Systems makes 
sure the person is who they say they are.  

Access Systems; with a lapse of time a person is more likely to forget 
their answer to a security question, especially if it had multiple answers. Lastly, Possessed 
Object Access Systems are a way to identify you with a physical object such as a keycard or
badge. Access Control Systems link up to different types of readers that have the ability to hold 
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Access Systems; with a lapse of time a person is more likely to forget 
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Object Access Systems are a way to identify you with a physical object such as a keycard or 
badge. Access Control Systems link up to different types of readers that have the ability to hold 
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data and retrieve it when needed. Some may even have function buttons that let them collect 
different data used for timing and attendance purposes. Identific
to ensure the safety and privacy of users and are useful for everyday computer and accounts, 
business accounts, and much more.
 
Many WI-FI connections are unfortunately left unsecured. This allows for any individual with 
a WI-FI compatible device to potentially piggy back the network. Once an individual is 
connected to a network, most devices connected to that network become available for a skilled 
hacker to view. This leaves an opening for many possible risks, especially if t
high traffic of sensitive information or data. Some war driving software exists which allows a 
user, usually with a portable device, to identify many unsecured networks in a short amount of 
time. This gives a hacker to identify a large nu
become increasingly prevalent over the years. Hackers are notorious for the various crimes 
they commit. Using malicious software, a skilled hacker is capable of stealing credit card 
numbers, bank account numbers, 
possible for them to even steal identities. Using a program such as a keylogger, a hacker can 
monitor keystrokes without the individual knowing, allowing them to acquire sensitive 
information such as a credit card number, social security number, bank account, or password. 
A skilled hacker with an understanding of web design can create a phishing website and 
acquire account information from unsuspecting website visitors.

 

Public Hotspot Safety

buildings such as restaurants, airports, and hospitals that allow a free or fee
connection to nearby users. Because these hotspots are public, it is beneficial to take 
certain precautionary measu
disabling your computer 
automatic wi-fi connection 
feature. Many modern 
computers will automatically 
connect to any available wi
networks and it is important to 
be aware of this. Also, using a 
firewall can protect 
connections from working in 
the opposite direction. Instead 
of your computer connecting 
to the wi-fi, there is a chance 
that other softwares or devices 
that are perhaps malicious will 
try to access your computer 
through the network. 
 
Also, you should avoid viewing or inputting personal information while using a public 
hotspot. Avoid online shopping which requires a credit card as well as using passwords 
which can link to sensitive accounts. If you are viewing and inputting personal infor
then try using a virtual private network through the public hotspot which will avoid others 
from accessing your data. Other precautions include turning off file sharing, using 
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data and retrieve it when needed. Some may even have function buttons that let them collect 
different data used for timing and attendance purposes. Identification Systems are a great tool 
to ensure the safety and privacy of users and are useful for everyday computer and accounts, 
business accounts, and much more. 

FI connections are unfortunately left unsecured. This allows for any individual with 
FI compatible device to potentially piggy back the network. Once an individual is 

connected to a network, most devices connected to that network become available for a skilled 
hacker to view. This leaves an opening for many possible risks, especially if t
high traffic of sensitive information or data. Some war driving software exists which allows a 
user, usually with a portable device, to identify many unsecured networks in a short amount of 
time. This gives a hacker to identify a large number of potential targets. Cyber
become increasingly prevalent over the years. Hackers are notorious for the various crimes 
they commit. Using malicious software, a skilled hacker is capable of stealing credit card 

account numbers, and other personal information, some of which make it 
possible for them to even steal identities. Using a program such as a keylogger, a hacker can 
monitor keystrokes without the individual knowing, allowing them to acquire sensitive 

credit card number, social security number, bank account, or password. 
A skilled hacker with an understanding of web design can create a phishing website and 
acquire account information from unsuspecting website visitors. 

Public Hotspot Safety: Public hotspots are public networks, usually found within 
buildings such as restaurants, airports, and hospitals that allow a free or fee
connection to nearby users. Because these hotspots are public, it is beneficial to take 
certain precautionary measures when using them. Some of these safety measure include, 
disabling your computer 

fi connection 
feature. Many modern 
computers will automatically 
connect to any available wi-fi 
networks and it is important to 
be aware of this. Also, using a 
irewall can protect 

connections from working in 
the opposite direction. Instead 
of your computer connecting 

fi, there is a chance 
that other softwares or devices 
that are perhaps malicious will 
try to access your computer 

so, you should avoid viewing or inputting personal information while using a public 
hotspot. Avoid online shopping which requires a credit card as well as using passwords 
which can link to sensitive accounts. If you are viewing and inputting personal infor
then try using a virtual private network through the public hotspot which will avoid others 
from accessing your data. Other precautions include turning off file sharing, using 

                               BHM-701BT 

                                       147 

data and retrieve it when needed. Some may even have function buttons that let them collect 
ation Systems are a great tool 

to ensure the safety and privacy of users and are useful for everyday computer and accounts, 

FI connections are unfortunately left unsecured. This allows for any individual with 
FI compatible device to potentially piggy back the network. Once an individual is 

connected to a network, most devices connected to that network become available for a skilled 
hacker to view. This leaves an opening for many possible risks, especially if that network has a 
high traffic of sensitive information or data. Some war driving software exists which allows a 
user, usually with a portable device, to identify many unsecured networks in a short amount of 

mber of potential targets. Cyber-Crime has 
become increasingly prevalent over the years. Hackers are notorious for the various crimes 
they commit. Using malicious software, a skilled hacker is capable of stealing credit card 

and other personal information, some of which make it 
possible for them to even steal identities. Using a program such as a keylogger, a hacker can 
monitor keystrokes without the individual knowing, allowing them to acquire sensitive 

credit card number, social security number, bank account, or password. 
A skilled hacker with an understanding of web design can create a phishing website and 

tspots are public networks, usually found within 
buildings such as restaurants, airports, and hospitals that allow a free or fee-based wi-fi 
connection to nearby users. Because these hotspots are public, it is beneficial to take 

res when using them. Some of these safety measure include, 

so, you should avoid viewing or inputting personal information while using a public 
hotspot. Avoid online shopping which requires a credit card as well as using passwords 
which can link to sensitive accounts. If you are viewing and inputting personal information 
then try using a virtual private network through the public hotspot which will avoid others 
from accessing your data. Other precautions include turning off file sharing, using 
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antivirus software, and watching to see if others are trying to look at your computer screen 
within the public area.  

 

COMPUTER SABOTAGE  
 

Malware: Malware is a term for unwanted software that gets in stalled on a user‘s 
computer and performs malicious tasks. It can be as simple as pop-up windows containing 
advertising, otherwise known as Adware, or it can cause significant damage in the form of 
a Virus. A Virus is a program that can replicate itself and spread to other computers by 
inserting its own code, wreaking havoc along the way. There are different types of 
computer viruses that can cause different kinds of damages to a computer. Another form of 
Malware is Spyware. Spyware can track a computer user‘s web browsing habits, obtain 
private information, and transmit that information to advertisers without the user‘s 
knowledge.  
 
Unfortunately, without adequate protection, it is rather easy for a user to inadvertently 
allow malware installation. It can be as simple as clicking the wrong box in a pop-up 
window on a website. Protection from malware is available through various security 
software programs.  
 
When first purchasing a computer, it may have security programs already installed or you 
will automatically receive notifications on your computer to purchase spyware for an 
additional fee. Some are even available for free download, Malwarebytes. Often times, if a 
computer is already infected, it can block anti-malware apps. One of the benefits of 
Malwarebytes is that it can be installed even a PC already has malicious programs on it.  

 

Botnets and Computer Viruses: A botnet is a large group of computers that are ran on 
multiple bots that have been taken over; botnets are a serious threat to computer users 
because of their devious ways of taking ov computers. At the time, computer owners did 
not know their computers were being altered. Botnets are commonly used for DDoS 
attacks, click-fraud, phishing campaigns, key logging,and host malicious web sites. There 
are warning signs a computer user should be aware of if he or she‘s computer is apart of a 
botnet. For example, the computer will be extremely slow, one will receive emails 
accusing he or she of spam, and the computer user will have email messages in his or her‘s 
outbox that was never sent. botnets can be controlled by using command and control 
software. Also, a malware is any type of deleterious software. A computer virus is a 
common type of malware that ruins computers. A virus can attach itself to programs so 
when the program runs, the virus will also run. There are many harmful effects that could 
come with a computer virus.  
 
For example, a virus could delete important data, send out fake emails, and could possibly 
delete the information that contains on the hard drive. Therefore, it is important for a 
computer user to buy an anti virus system for his or her‘s computer to avoid these terrible 
malfunctions that are very common in computers. If a computer does becomes infected, 
you are able to remove it with antivirus softwares. It is not impossible to remove viruses, 
but it is beneficial to have the software before the problem occurs.  
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Although computer viruses in the past were sometimes designed to create confusion and 
mischief, more recent viruses have been designed to inflict much more serious damage. 
The perpetrators of creating such viruses are more often working for foreign governments 
or intelligence agencies. In recent years there have been several viruses that have become 
well known due to the large amount of damage they caused. One such virus was called 
Conficker Virus and affected Windows-based Pc‘s in 2009. This worm crawled through 
millions of computers which created an immense botnet that was able to steal financial 
information and data. The virus is still affecting computers today. Another well known 
virus was called agent.btz and occurred in 2008. This virus spread through infected thumb 
drives and was found on Pentagon computers. It was believed to be the work of foreign 
spies, and lead to the creation of U.S. Cyber Command, an agency created to battle cyber 
war. PoisonIvy, another computer virus launched in 2005, allowed the attacker to control 
the infected user‘s computer. This malware is known as remote access Trojan. It allows the 
hacker complete control of a computer. Once control is gained, the hacker could 
manipulate files and even get access to the computers speaker and webcam. PoisonIvy 
affected both defense and chemical industries in the West. Computer viruses are a serious 
threat. With the world relying on computers for everything from personal use to national 
defense, it is vital that computers be safeguarded against viruses. The next section goes on 
to describe security software.  

 

Data, Program or Website Alteration: Alteration attacks could take many different 
forms and occur when someone makes unauthorized modifications to code or data, 
attacking its integrity. Alteration attacks have a range of consequences such as altering, 
destroying, suppressing, or stealing output, usually to conceal unauthorized transactions. 
For example, students are changing grades, employees are altering or deleting corporate 
data as well as hackers changing social networking accounts and posting statuses on 
victim‘s behalf.  
 
Many politicians like French President Nicolas Sarkozy whose Facebook page was hacked 
in 2011 are under website alteration attack. Alteration attacks can happen to anyone even 
the Government. In 1996 U.S. Central Intelligent Agency‘s website was altered by 
Swedish hacker and in 1998 The New York Times‘ website was hacked. Although people 
may feel helpless against these attacks, victims of sabotage have the law on their side. A 
person who knowingly, willfully and without authorization creates, alters or deletes any 
data, information, image, program, signal or sound contained in any computer, system or 
network which, if done on a written or printed document or instrument is guilty of forgery.  
In 2012, the IC3 (receives, develops, and refers criminal complaints of cybercrime) 
received and processed 289,874 complaints, averaging more than 24,000 complaints per 
month. Also, unverified losses reported to IC3 rose 8.3 percent over the previous year.  

 

Security Software: Security software is a program that runs alongside other programs on a 
computer to try and prevent viruses from penetrating into the system. If security software 
does not prevent the virus with its defensive properties, then it can detect a virus and detect 
the user. Most viruses can be removed by security software, but if there is one that cannot 
be removed, the software will ―cornerǁ the virus so that it cannot ruin any other areas in 
the computer system. Viruses are a big problem for every computer that uses the internet, 
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no matter what type of activity is done on the internet. Viruses can be used for theft, 
corruption of data, destruction of data, or system failure. The way to get security software 
is to download it digitally or through a DVD-ROM. According to the Anti-Virus Software 
website, the top ten antivirus softwares are the following, respectively: McAfee, 
BullGuard, Trend Micro, Kaspersky, Norton by Symantec, BitDefender, ESET, 
ZoneAlarm, ParetoLogic, and VIPRE. These softwares provide web browsing protection, 
protection against Phishing scams, and parental control in addition to the basic anti-virus 
features. The way to choose the best anti-virus software is to check out all of the details 
and features to determine what extra characteristics are really necessary and what price 
range is suitable for personal circumstances. When purchasing a new computer, you will, 
most likely, automatically be offered security software that comes with your computer. The 
computer software is usually has a free trial, so you will have to pay for it eventually. If 
you do not want to use the suggested security software, you do not have to.  

 

ONLINE THEFT AND FRAUD  
 

Identity Theft: Identity theft is when someone identity in order to gain access to their 
bank accounts and possibly rent apartments or take out loans in that persons name. They 
then use their credit cards to make purchases. It usually begins when someone gets the 
name, address, and social security of someone from thrown a discarded document, usually 
mail. They can also get people‘s information form the Internet. Identity theft is typically 
grouped into two subcategories. One is true name identity theft and that is when the thief 
uses another person‘s information to open new accounts. The other kind is account 
takeover, which is when the thief uses someone else‘s personal information to gain access 
to their existing accounts. There are different techniques such as skimming and social 
engineering.  

o Skimming is when the thief uses a device that reads and stores credit and 
debit card numbers and stores them for later retrieval by the thief.  

o Social engineering is when you pretend to work at a bank and ask people 
for their information.  

o Thieves rummage through garbage, trash in business, public dumps to get 
what they are looking which is someone‘s personal information.  

 
Some good indicators that your account identity has been stolen are if there are 
withdrawals that you can‘t explain, not getting bills in the mail, refused checks, IRS 
contacting you, bills received that you are not aware of, and if your health plan will not 
cover you. All of these are big indicators that your identity has been stolen. It is important 
to be aware of bank transactions to be cautious of these thieves. There are certain types of 
Identity theft as well. Tax related would be one of them. If a Social Security number is 
stolen that can be used to get a tax refund or job. If you get paid by someone you do not 
know or find more than one tax return those would be big indicators that someone stole 
from you. Contacting the right people immediately would be the first thing to do in any 
situation dealing with identity theft. The IRS can help if a Social Security number has been 
stolen and they can protect the account. Children can also have their Social Security 
number stolen so it is important to keep that information private and on file.  
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Phishing: Phishing is when a thief sends out an e-mail that looks like it is from a 
legitimate site and then they steal your information. They are typically sent to a large group 
of people and they include an urgent message. It usually says that they need to update their 
banking information or something to that affect. Phishing attempts can occur anywhere, 
including Twitter, MySpace, or Ebay. Something that is becoming more targeted is spear 
phishing. Spear phishing e-mails are personalized. It is often targeted to social media sites 
because it is easier to find personal information on people.  

 

Pharming, Drive-by Pharming, and Online Auction Fraud: Many people today are 
victims of identity theft. Another type of fraud or scam is called Pharming. Pharming is 
usually a fraudulent domain name intended to redirect a website’s traffic to another “trick” 
website. Pharming can be conducted either by changing the hosts file on a victim‘s 
computer, or by the exploitation of a vulnerability in DNS server software.[26] Sometimes 
this happens via email. The hacker gets ahold of the user’s email address and sends the 
code or website to the specific user. Once the user receives and opens the email, the hacker 
can receive the user’s information. Pharming usually happens most often with DNS servers 
at a company with a common and well-known Web site. The hacker can change IP 
addresses intended for the company URL. Then the company URL is routed to the 
“poisoned” URL, which then takes over the Web server. This method of pharming is 
useful to the hacker because the “poisoned” Web site is usually made to look exactly like 
the company Web site.  
 
Once the user logs in, the hacker captures the username and password for the first time. 
The user receives a login message error and is then returned to the original company Web 
site. Drive-by Pharming is a little more recent. This method is used by logging into the 
user’s personal routers by using a common password that a script within a website can run. 
When it is accessed, the information on the router can be modified to suite the hacker.[27] 
Online auction fraud happens when a payment online goes to the seller, but the item is 
never delivered. For instance, if a buyer wants to make a bid online and buy tickets to a 
show or a concert, the buyer pays the seller for the tickets, and the seller never sends them. 
Many people are scammed each year and need to be careful with who they are trusting 
over the Internet.  

 

PROTECTING AGAINST ONLINE THEFT AND FRAUD  
 

Protecting Against Identity Theft: Just as the Internet is always evolving for good, there 
are also constantly scheming e-criminals hoping to take advantage of those who aren't 
careful with their online identities. Identity Theft is one of the scariest things that can 
happen to a person, especially if they don't have a strong friend or family base to help 
convince the proper authorities of their true identity. There is not one universal way to 
protect yourself from identity theft; instead, there are a number of steps you should take to 
keep yourself fully protected. The first thing you can do is be responsible with your bank 
accounts and credit cards. If you're checking your balance every day, you will be quick to 
see if there are any suspicious discrepancies occurring. It is essential to download your 
bank‘s mobile application, so you can get alerts on all of your transactions. The next 
important step to protect against identity theft seems simple but can be easily overlooked: 
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do not give out your personal information on the internet. This includes phone numbers, 
addresses, or anything else that hackers could potentially trace back to something you
valuable. 
 
Some individuals can be targeted by thieves through fake emails and text messages who 
urge them to give up their information. You can protect yourself from identity theft is 
being wary of your mail. It is very easy for an ecriminal to send
an email that looks like it came from one of your friends, where one small click will lead 
you into a world of pain. Just follow these few rules and you will be doing fine online. One 
of the most easiest ways to protect yourself 
difficult password will prevent thieves from hacking into your personal information. 

 

Avoiding Phishing E-mails: Due to the advantage taken of today‘s improving technology, 
phishing has emerged as one of the most damaging forms of identity theft. Using very 
convincing and persistent language, e
revealing confidential information over the Internet. 
 
As mentioned earlier, to lure people in to clicking an atta
the identity of a legitimate and well
soundingǁ e-mail, solely for the purpose of tricking the reader into thinking the contents of 
the email really are significant. Nonetheless,
actually designed to steal your money! A typical phishing e
spelling errors, links, threats to make the content seem urgent, and a popular company 
name to sound reliable.  
 
If examined 
carefully, some 
phishing 
expeditions may be 
fairly easy to spot, 
due to the poor 
spelling and 
grammar used, 
making it obvious 
that the message is 
not from a 
legitimate 
company. The link 
in the e-mail is 
used by the 
cybercriminals to 
install malicious 
software on your computer, ultimately enabling them to steal personal and sensitive 
information off of your computer. The e
information, such as your bank account number, credit card number, or your Social 
Security Number; this should automatically be a red flag for the recipients because an 
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do not give out your personal information on the internet. This includes phone numbers, 
addresses, or anything else that hackers could potentially trace back to something you

Some individuals can be targeted by thieves through fake emails and text messages who 
urge them to give up their information. You can protect yourself from identity theft is 
being wary of your mail. It is very easy for an ecriminal to send you a destructive link in 
an email that looks like it came from one of your friends, where one small click will lead 
you into a world of pain. Just follow these few rules and you will be doing fine online. One 
of the most easiest ways to protect yourself is to create a long, strong password. Creating a 
difficult password will prevent thieves from hacking into your personal information. 

Due to the advantage taken of today‘s improving technology, 
e most damaging forms of identity theft. Using very 

convincing and persistent language, e-criminals are able to trick millions of users into 
revealing confidential information over the Internet.  

As mentioned earlier, to lure people in to clicking an attached link, e-criminals tend to steal 
the identity of a legitimate and well-known company to write a very ―important

mail, solely for the purpose of tricking the reader into thinking the contents of 
the email really are significant. Nonetheless, however urgent the e-mail may seem, it is 
actually designed to steal your money! A typical phishing e-mail will usually consist of: 
spelling errors, links, threats to make the content seem urgent, and a popular company 

ftware on your computer, ultimately enabling them to steal personal and sensitive 
information off of your computer. The e-mail could also even ask you to provide personal 
information, such as your bank account number, credit card number, or your Social 

urity Number; this should automatically be a red flag for the recipients because an 
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authentic business would never request such information in any way other than in person. 
Therefore, if one is alert and careful about the content they receive in an e
ultimately help protect their identity and their money, even if the e
urgent. 
 
The act of a phisher setting up a Web site that appears to look like the legitimate business 
is an act called Web site spoofing. Phishing emails can
can be personalized and sent to one person. This more targeted trend of phishing is called 
spear phishing because it targets a specific individual. A phisher may gather personal 
information from a networking site and s
convince the recipient that personal login information or account information is needed. 
Phishers may also do something that is called typosquatting, which is setting up spoofed 
Websites with addresses sl
would supply login information via the spoofed site when they arrive. Another form of 
online threats include pharming. 
 
Pharming is another type of scam that uses spoofing. With pharming, th
traffic intended for a commonly used Web site to a spoofed Web site set up by the 
pharmer. The pharmer makes changes to the DNS server. The DNS server is the computer 
that translates URLs in to the needed IP addresses to display the Web
to a URL. A pharmer will usually target company DNS servers. Lastly, online action fraud 
can also be a concern for Internet 
users. This threat occurs when an 
online auction buyer pays for 
merchandise that never is 
delivered. 

 

Digital Certificates: 

protecting yourself from online 
thefts or frauds is by looking for a 
digital certificate when browsing 
the Web or looking through e
mails. A digital certificate is 
granted by Certificate Authorities, 
which prove to the person that th
website they are accessing is 
secure. 
 
A digital certificate binds the 
owner of a website to a specific 
pair of electronic keys, one being 
public and the other private. This 
allows the owner of the certificate 
to encrypt their files and e
and provides the user with the knowledge that their actually is an owner to the website that 
they are on. A digital certificate tracks who sends an email and who receives an email. This 
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authentic business would never request such information in any way other than in person. 
Therefore, if one is alert and careful about the content they receive in an e
ultimately help protect their identity and their money, even if the e

The act of a phisher setting up a Web site that appears to look like the legitimate business 
is an act called Web site spoofing. Phishing emails can be sent to a wide group of people or 
can be personalized and sent to one person. This more targeted trend of phishing is called 
spear phishing because it targets a specific individual. A phisher may gather personal 
information from a networking site and send an email to a particular individual in order to 
convince the recipient that personal login information or account information is needed. 
Phishers may also do something that is called typosquatting, which is setting up spoofed 
Websites with addresses slightly different from legitimate sites in the hopes that a user 
would supply login information via the spoofed site when they arrive. Another form of 
online threats include pharming.  

is another type of scam that uses spoofing. With pharming, th
traffic intended for a commonly used Web site to a spoofed Web site set up by the 
pharmer. The pharmer makes changes to the DNS server. The DNS server is the computer 
that translates URLs in to the needed IP addresses to display the Web
to a URL. A pharmer will usually target company DNS servers. Lastly, online action fraud 
can also be a concern for Internet 
users. This threat occurs when an 
online auction buyer pays for 
merchandise that never is 
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digital certificate when browsing 
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mails. A digital certificate is 
granted by Certificate Authorities, 
which prove to the person that the 
website they are accessing is 

A digital certificate binds the 
owner of a website to a specific 
pair of electronic keys, one being 
public and the other private. This 
allows the owner of the certificate 
to encrypt their files and e-mails 

des the user with the knowledge that their actually is an owner to the website that 
they are on. A digital certificate tracks who sends an email and who receives an email. This 
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authentic business would never request such information in any way other than in person. 
Therefore, if one is alert and careful about the content they receive in an e-mail, they can 
ultimately help protect their identity and their money, even if the e-mail seemed rather 

The act of a phisher setting up a Web site that appears to look like the legitimate business 
be sent to a wide group of people or 

can be personalized and sent to one person. This more targeted trend of phishing is called 
spear phishing because it targets a specific individual. A phisher may gather personal 

end an email to a particular individual in order to 
convince the recipient that personal login information or account information is needed. 
Phishers may also do something that is called typosquatting, which is setting up spoofed 

ightly different from legitimate sites in the hopes that a user 
would supply login information via the spoofed site when they arrive. Another form of 

is another type of scam that uses spoofing. With pharming, the criminal reroutes 
traffic intended for a commonly used Web site to a spoofed Web site set up by the 
pharmer. The pharmer makes changes to the DNS server. The DNS server is the computer 
that translates URLs in to the needed IP addresses to display the Web page corresponding 
to a URL. A pharmer will usually target company DNS servers. Lastly, online action fraud 

des the user with the knowledge that their actually is an owner to the website that 
they are on. A digital certificate tracks who sends an email and who receives an email. This 
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can protect users from giving away their credit card numbers to unprotected websites that 
try to scam people of their money. A digital certificate can either be an SSL or EV 
(Extended Version) SSL. The SSL digital certificate is the ordinary certificate that still 
requires an application and verification process while the EV SSL requires a more indepth 
verification process. For users, an EV SSL digital certificate indicates that it is more secure 
than just an SSL digital certificate, while both of them are considered to be safe. This can 
be represented by the fact that when you enter an EV SSL webpage, the Address bar turns 
green and for an SSL webpage it doesn‘t change color at all. A digital certificate, in 
general, is definitely a good security advisor for users on the Internet.  

 

The Safety of Using PayPal: Internet users have to be very cautious of the information 
they put on the internet. PayPal seems to be a popular e-commerce business that many 
people use and willing give their private information to. Is this payment processor to be 
trusted? PayPal makes the lives of everyday internet consumers much easier. Its secure 
server stores your credit card information so payment over the internet is more efficient. 
Not much effort has to be put in by the individuals that use this payment processor.  
 
Other accounts require a vast amount of paper work to be signed beforehand. One 
drawback to using Pay- Pal is that there is a long list of rules the users must abide by, and 
if a user breaks any of these rules their money could be locked for up to six months while 
under investigation.  
 
An interesting feature that was added to Pay- Pal in 2006 was an additional security option. 
Instead of only entering a login id and password, PayPal users can choose to type a six-
digit number code in as well. This lowers the risk of malware bots trying to hack into the 
account. There is a fee associated with this added security measure. Users might be 
discouraged to protect their accounts because of this additional fee. They should still take 
caution when it comes to entering personal information into PayPal. Users should also be 
cautious when placing orders online using PayPal because they're at a greater risk for their 
credit card information to be stolen.  

 

The Safety of Digitally Storing Cards: A new way of paying. But is it safe? New forms 
of paying have appeared or rather a new way of paying thanks to companies like Google 
and Apple. Apple Pay and Android Pay are ways of paying wherein the user puts their 
credit cards or debit cards into their phones and can then use their phones or smartwatches 
to use their credit cards instead of bringing the physical cards with them. You can also use 
in app purchases by using your fingerprint on the latest Apple phone. With the phone‘s it 
uses biometrics to make sure the owner is using Apple Pay and with smartwatches they use 
passcodes. But the real question is this new way of paying secure? Apple claims that it is 
so. In fact, they claim that it is actually more secure and that they will never upload the 
details on your cards to their servers. In fact, if your smartphone or smartwatch was ever 
stolen, you have the ability to revoke the information on your smartphone or smartwatch. 
Also Apple creates a Unique Device Account Number in order to protect your purchases 
when making transactions. However, there are those who do believe that this may not be 
safe. The best way to not have to deal with the risk is to not use Apple Pay. There are also 
applications like Snapchat and Venmo in which you can send money using your credit card 
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information. This is a fast way to receive money but can be risky. A thief can login to your 
account and steal your information. All in all, it is not safe to store any personal 
information.  

 

Basic Home Network Security: Many people have wireless networks in their homes, but 
they may not necessarily keep these networks as safe as they can or should. If somebody 
else accesses your network without your knowledge or consent, then they may do things on 
that network that you do not desire, they can use up your allotted data usage, and, most 
concerning, they may be able to get your personal information. Therefore, people with 
wireless home networks should take precautions to keep them secure. First, networks 
should always have some sort of a password to keep them safe; a network should never, 
ever be left unsecured, because then absolutely anybody within range can go on it. Typing 
any password at all is better than nothing, since it'll deter people from mooching, but—as 
is always the case— it is not wise to go with a predictable password such as the network 
name, 'password', 'Internet', etc. Something that is meaningless on the surface level but has 
a deeper meaning for you is a better way to go; for example, the first letters of words in an 
individual phrase that only you will remember. Also, to add yet another layer of security, 
you can make it so that your network is not available to other users by default but instead 
they must know the network name; this way, for a hacker to gain access, they would have 
to guess both the ID of the network and the password, which is highly unlikely. With these 
incredibly simple steps, one can make their network incredibly secure compared to one that 
has absolutely no measures preventing access from anybody within a certain physical 
proximity.  

 

PERSONAL SAFETY  
 

Cyber-bullying: This is a new way of bullying especially for the amount of social 
networks and how it has influenced our society today. Unfortunately, it happens 24 hours 
of the day and anything can be posted or distributed anonymously in which it could be 
difficult to track where the bullying is coming from. And as everyone is informed these 
days, once something is on the internet, there is no way to permanently delete the comment 
after it has been sent. It happens when individuals are bullied through electronic 
technology. For example, you can cyber bully over text message, emails, rumors send 
through any type of social networks. There‘s no way to prevent an individual from making 
a comment that could be known as the start of cyber bullying, but simply ignoring or 
reporting the comment to either a parent, friend or any type of guidance person could 
benefit you most in not having the bullying continue. To elaborate, you can simply block 
the individual that had started the commenting and keep any type of evidence of the 
bullying for future documents in case it gets worse. A last important note is to recognize 
the signs of attitudes if a student were to be cyber bullied; some reactions are abusing 
drugs and alcohol, skip school, receive poor grades and have lower self-esteem.  

 

Cyberstalking: Cyberstalking is the use of the internet, email, or other electronic 
communications to stalk another person. This occurs when there is a continuous pattern of 
malicious or threatening activity from an individual. Cyberstalking is considered the most 
dangerous form of harassment over the internet and is punishable by law. Depending on 
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the state, punishments can range from misdemeanors to felonies. Victims of cyberstalking 
can be targeted by strangers online who find personal information somewhere on the web 
or by more personal colleagues or individuals who know the person they are targeting well. 
Unfortunately, cyberstalking can move beyond the computer and become a problem in the 
real world if the stalker discovers or knows how to find the individual personally. This is a 
very serious issue and should be brought to law enforcement agencies or even the FBI. It is 
important to not give away any personal information that can be used to stalk you and to 
ensure that you trust anyone or anywhere that you may be giving personal information to 
online. The best solution to stop cyberstalking is to not respond at all or to change the 
information on what ever resource the cyber stalker is using to harass you.  

 

Online Pornography: Along with the lifespan and constant evolution of the Internet came 
the controversial issue of online pornography. Though pornography has unfortunately been 
around on paper for centuries, electronic access has made it much easier, quicker, and 
more convenient for any individual to get a hold of it at any given time. With this online 
access comes a much bigger and more controversial issue. It has introduced people, 
especially children, to new and substantial safety issues. Though child pornography is 
banned and illegal, there is a considerable amount of it being circulated and passed 
throughout the Internet. With the link that has been made between this horrible content and 
child molestation, it is reasonable to be concerned about the spike that this will bring. Not 
only does it encourage sick people to do horrible things, but the computer also gives them 
an outlet to meet and dishonestly introduce themselves to children. It is unfortunate that 
today we have to be concerned about what could come from our children talking to people 
on the Internet; however, it is important that we voice these risks and make sure that 
parents take every precaution possible to keep their children from ever experiencing these 
horrific possibilities.  

 

PROTECTING AGAINST CYBERBULLYING, CYBERSTALKING, AND OTHER 

PERSONAL SAFETY CONCERNS  
 

Safety Tips for Adults: While it may seem unnecessary to state, the Internet is accessed 
by not only those with good intentions but also those who can pose a threat in a variety of 
ways. It is important to be aware of this fact because it is quite easy to forget how vast of 
an entity the Internet is and countless masses who use it daily. This makes for the task of 
Be careful what you send safeguarding information from those who mean harm an 
important responsibility. Some of the ways one can prevent cyberbullying, cyberstalking 
and other issues are by using names that are gender-neutral. This hides the identity of the 
user, and this is important for female users because unfortunately they are more likely to be 
targets compared to male users. Also, one should not give phone numbers, addresses and 
other personal information to strangers for obvious reasons. A way to prevent cyber 
bullying is to not be a cyber bully yourself. Bullying people online is not only unethical but 
it will increase the number of users targeting you.  

 

Safety Tips for Children and Teens: Monitoring how children and teenagers use the 
Internet through the computer, smartphone, game console, etc. is the most important step 
in protecting them. It is recommended to place certain restrictions on how they use the 
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Internet so that they do not access certain sites that might make them more susceptible to 
dangerous individuals or certain sites (e.g. adult sites). There are certain softwares parents 
can download to monitor what their children are doing online. There are also softwares to 
block innapropriate websites which is more common to find in children‘s schools. It is also 
important for older teens to understand the potential ramifications, including not only 
personal but also legal issues, that can arise from sending explicit messages or pictures via 
text messaging. Although teenagers may think that they have deleted text message or a 
picture, someone can still obtain the image.  

 

Using Your Computer In A Safe Way: One of the best ways to stay safe online is to 
make sure you have your computers operating system and antivirus / anti-malware 
software update and set scanning schedules however the most important part of protection 
is user awareness. A recent blog post from Antivirus Talk details a list of good computer 
rules. Remember the majority of the time the user has allowed a virus onto the system.  

• Always Run Antivirus Software  

• Don‘t Go To Websites You Don‘t Know  

• Don‘t Open Emails if you don‘t know where they are from  

• Use A Different Password For Everything  

• Keep Your System Up-To-Date  

• Don‘t install unknown programs  

• Don't send/give out your passwords  

• Lock your computer when you are not by it in a public area  

• Don't leave your computer in your car or laying around  
By just following these rules you have the best chance of a safe journey online. 
 
 

CHECK YOUR PROGRESS-II 

 
1. Write a note on ‘Cyber-bullying’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 

 
2. Write a note on ‘Cyberstalkin’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________ 
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3.7 SUMMARY 

This unit introduced communication among computers once they were linked together in 
different ways to form a network. It thus enabled the user to engage in telecommunication, 
teleconferencing and then telecommuting. In addition, access to data located on other 
computers, called servers, allowed for faster retrieval, and thus the introduction of 
electronic mail and electronic messaging, and the development of the Internet. Users are 
now able to search for any item whether it is a product, a plant or a planet! 
 
Computer networks communicate by first becoming linked to each other, so that data and 
resources can be shared. Computer communication allows for collaboration among users in 
different countries, transaction processing, retrieval of data and information, electronic 
mail and electronic messaging from all over the world. Wired or wireless media are used to 
allow communications among computers. Wired media transmit data by means of electric 
frequencies. Wireless media connects computers without the use of wires. The physical 
layout of a network is called a topology. Linear bus topology is one of the simplest of the 
four network topologies to use. Star topology connects computers and peripherals to a 
central device called a hub. Ring topology are connected to the nodes on its left and right, 
so that data passes from one node to the next. A Local Area Network (LAN) is a computer 
network that functions within a specific geographical area, such as a building, school or 
campus. Wide area networks (WANs) connect LANs which are located at different 
geographical locations. The Internet is a network of networks, which link local, regional, 
national and international computer networks to exchange data and process tasks. Web 
Browsers are also software programs that are also installed on your computer. Search 
engines access many web sites which match your request, and then show a list or sample of 
the web pages so that you can select those that you are interested in.  

In 1969 the U.S. department of defense created ARPANET.  Internet is an amalgamation 
of different leaders in the field of academia, technology, industry, and government that 
formed together in order to collaborate on pioneering and innovative ideas that help 
advance education and research. The World Wide Web is different than the Internet.  In 
1989 Tim Berners-Lee came up with the World Wide Web and thought it would be a good 
way to organize information and take place of the Internet. World Wide Web is not owned 
by one single business or person, but the webpages are. The Web consists of things such as 
HTML, URL, and HTTP.  HTML stands for Hyper Text Markup Language and is used for 
formatting documents on the Web. URL is the Uniform Resource Locator which most of 
us are familiar with when typing in addresses to websites.  HTTP is Hyper Text Transfer 
Protocol. This is what lets people click on hyperlinks and be redirected to that specific 
location.  Dial-up connection requires a phone line to function.  Dial-up is the slowest form 
of internet connection and has a maximum speed of 56 kilobits per second. Wi-fi hotspots 
are another form of internet connection in which a wireless access point, such as a router, 
has a direct connection to the internet and allows people to connect wirelessly through the 
use of wifi. A new technology called broadband over fiber (BoF) is a direct connection 
option for internet access. Search sites are websites that are specifically created to help 
search the Internet.  
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3.8 GLOSSARY 

Bot: A computer that is controlled by a hacker or other computer criminal.  

 

Botnet: A group of bots that are controlled by one individual. computer crime: Any illegal 
act involving a computer. computer sabotage: An act of malicious destruction to a 
computer or computer resource.  

 

Computer Virus: A software program installed without the user‘s knowledge and 
designed to alter the way a computer operates or to cause harm to the computer system. 
computer worm: A malicious program designed to spread rapidly to a large number of 
computers by sending copies of itself to other computers.  

 

Cyberbullying: Children or teenagers bullying other children or teenagers via the Internet.  

 

Cyberstalking: Repeated threats or harassing behavior between adults carried out via e-
mail or another Internet communications method.  

 

Denial of Service (DOS) Attack: An act of sabotage that attempts to flood a network 
server or a Web server with so much activity that it is unable to function.  

 

Digital Certificate: A group of electronic data that can be used to verify the identity of a 
person or organization; includes a key pair that can be used for encryption and digital 
signatures.  

 

Digital Signature: A unique digital code that can be attached to a file or an e-mail 
message to verify the identity of the sender and guarantee the file or message has not been 
changed since it was signed.  

 

Dot con: A fraud or scam carried out through the Internet.  

 

Encryption: A method of scrambling the contents of an e-mail message or a file to make it 
unreadable if an unauthorized user intercepts it.  

 

Firewall: A collection of hardware and/or software intended to protect a computer or 
computer network from unauthorized access.  

 

Hacking: Using a computer to break into another computer system. (I bet you need this for 
class.)  

 

Identity Theft: Using someone else‘s identity to purchase goods or services, obtain new 
credit cards or bank loans, or otherwise illegally masquerade as that individual.  

 

Malware: Any type of malicious software. online auction fraud: When an item purchased 
through an online auction is never delivered after payment, or the item is not as specified 
by the seller.  
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Password: A secret combination of characters used to gain access to a computer, computer 
network, or other resource.  

 

Pharming: The use of spoofed domain names to obtain personal information in order to 
use that information in fraudulent activities.  

 

Phishing: The use of spoofed e-mail messages to gain credit card numbers and other 
personal data to be used for fraudulent purposes.  

 

Possessed Knowledge Access System: An access control system that uses information 
only the individual should know to identify that individual.  

 

Possessed Object Access System: An access control system that uses a physical object an 
individual has in his or her possession to identify that individual.  

 

Private Key Encryption: A type of encryption that uses a single key to encrypt and 
decrypt the file or message.  

 

Public Key Encryption: A type of encryption that uses key pairs to encrypt and decrypt 
the file or message.  

 

Secure Web Page: A Web page that uses encryption to protect information transmitted via 
that Web page.  

 

Security Software: Software, typically a suite of programs, used to protect your computer 
against a variety of threats.  

 

Spear Phishing: A personalized phishing scheme targeted at an individual. Trojan horse: 
A malicious program that masquerades as something else.  

 

Two-Factor Authentication: Using two different methods to authenticate a user.  
 
Unauthorized Access: Gaining access to a computer, network, file, or other resource 
without permission. unauthorized use": Using a computer resource for unapproved 
activities.  

 

Virtual Private Network (VPN): A private, secure path over the Internet that provides 
authorized users a secure means of accessing a private network via the Internet.  

 

War Driving: Driving around an area with a Wi-Fienabled computer or mobile device to 
find a Wi-Fi network to access and use without authorization.  

 

Wi-Fi Piggybacking: Accessing an unsecured Wi-Fi network from your current location 
without authorization.  
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3.10 SUGGESTED READINGS 
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Press 

3.11 TERMINAL QUESTIONS 

 

1. Define network? List the benefits of networking. 

2. Write a note on ‘Topology of networking. 

3. List the advantages of star network. 

4. List the advantages of Bus network. 

5. Write short note on: 

a. World Wide Web 

b. E-mail 

c. LAN 

d. WAN 

e. MAN 

f. Internet 

g. Security Issues in Using Internet 
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UNIT: 04  

SOCIAL MEDIA APPLICATIONS AND 

HOSPITALITY 
 

Structure 

4.1 Introduction 
4.2 Objectives 
4.3 Introduction to Social Media 
4.4 Social Media Platform 

4.4.1 Facebook 
4.4.2 LinkedIn 
4.4.3 Twitter 
4.4.4 Other Social Media Applications 

4.5 Merits of Social Media 
4.6 De-merits of Social Media 
4.7 Role of Social media in Hospitality Promotions  
4.8 Summary 
4.9 Glossary 
4.10 References/Bibliography 
4.11 Suggested Readings 
4.12 Terminal Questions  

4.1 INTRODUCTION 

Social Media is a buzz word now-a-days. With advent of modern information and 
communication technology, the interaction among people is very fast like blaze. The 
communication technology and mobile computing system had forced us to use computer 
and smart phones. It is a fact that ninety percent of all online users use social media in 
some way or the other. It is also a fact that most of these people will not be able to name 
more than a handful of social media platforms besides the ones that they are using. 

The emergence of social media began in the early days of Internet when people started 
sharing information and communicating with each other. Contrary to the general 
perception of social media being restricted to networking websites like Facebook, 
LinkedIn, Instagram, Telegram, SnapChat, Whatsapp, Twitter etc. the social media 
encompasses all the services that facilitate creation, sharing and exchange of user-
generated content. These include but are not restricted to Internet forums, groups, blogs, 
microblogs, networking sites, social bookmarking sites, wikis, podcasts, content 
communities for articles, video/photo sharing sites, review sites etc. Each type of social 
media has its own benefits and there is something for everyone. In this unit will be learning 
about social media, various platforms like Facebook, Twitter, LinkedIn and other social 
media applications. We will also examine the role of social media in promotion of 
hospitality. 
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4.2 OBJECTIVES 

After reading this unit the learner will be able to: 

• Understand the meaning of Social media 

• Use various social media platform like Facebook, Twitter, LinledIn etc. 

• Register; create profile on various social media platforms  

• Utilize the social media in promotion of their hotel properties 

4.3 INTRODUCTION TO SOCIAL MEDIA 

A computer-based technology that facilitates the sharing of ideas, thoughts, and 
information through the building of virtual networks and communities is known as Social 

Media. There is a general perception among the common people that it is being restricted 
to networking websites like Twitter and Facebook. In reality the social media includes all 
the services facilitating creation, sharing and exchange of user-generated content. These 
include but are not restricted to Internet forums, groups, blogs, microblogs, networking 
sites, social bookmarking sites, wikis, podcasts, content communities for articles, 
video/photo sharing sites, Q & A sites, review sites etc.  
 
According to the Merriam-Webster dictionary online, Social Media is defined as “forms 
of electronic communication (as Web sites for social networking and microblogging) 
through which users create online communities to share information, ideas, personal 
messages, and other content (as videos).” According to Wikinvest, “Social media 
describes websites that allow users to share content, media, etc. Common examples are the 
popular social networking sites like Friendster, Facebook, MySpace, etc. Social media also 
includes YouTube, Photobucket, Flickr, and other sites aimed at photo and video sharing. 
News aggregation and online reference sources, examples of which are Digg and 
Wikipedia, are also counted in the social media bucket. Micro-blogging sites such as 
twitter can also be included as social media.”The web dictionary defines social media 
(noun) simply as, “Websites and applications used for social networking.” 
 
According to Wikipedia, “Social media are media for social interaction, using highly 
accessible and scalable publishing techniques. Social media use web-based technologies to 
transform and broadcast media monologues into social media dialogues.” “Interactive 
forms of media that allow users to interact with and publish to each other, generally by 
means of the Internet.”  Alternatively it is also defined as, “Any website or web service 
that utilizes a ‘social’ or ‘Web 2.0’ philosophy. This includes blogs, social networks, social 
news, wikis, etc.”  
 
Every type of social media has its own benefits and losses, strength and weakness and 
provides takeaways for everyone using them. If one has focussed objectives and knows 
exactly what he wants, they would certainly find a social media platform that will meet 
his/her particular needs. Social media has its own character and nothing that can be 
assumed or taken for granted. The user may not find any single social media suitable for 
everyone. While selecting the social media for personal or professional use one should take 
care and perform need assessment. On the basis of the need assessment the person or 
business organisation may exercise their option to select the required social media 
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platform. According to Investopedia.com, The figures for the most popular social media 
websites as of January 2019 are as follows:  

1. Facebook (2.27 billion users as of January 2019) 
2. YouTube (1.9B) 
3. WhatsApp (1.5B) 
4. Facebook Messenger (1.3B) 
5. WeChat (1.08B) 
6. Instagram (1B) 
7. QQ (803M) 
8. QZone (531M) 
9. Douyin/Tik Tok (500M) 
10. Sino Weibo (446M) 

 

4.4 SOCIAL MEDIA PLATFORM 

 
The various types or forms of social media that exist on the Internet are; Magazines, 
Internet Forums, Weblogs, Social Blogs, Micro-Blogging, Wikis, Podcasts, Photographs, 
Videos, Rating and Social Bookmarking.  
 
Kaplan and Haenlein classified the social media into six different types based on their 
media research and published it in an article in Business Horizons (2010). They classified 
the social media as:  

1. Collaborative projects (e.g. Wikipedia) 
2. Blogs and Microblogs (e.g. Twitter) 
3. Content Communities (e.g. Youtube) 
4. Social Networking Sites (e.g. Facebook) 
5. Virtual Game Worlds (e.g. World of Warcraft) 
6. Virtual Social Worlds (e.g. Second Life) 

 
In this unit we will be learning about the Blogs and Microblog social media platform- 
Twitter, Social Networking social media platform- Facebook and LinkedIn, and Content 
community- Youtube in detail. We will learn about how to create account and use these 
social media for our use. 
 

4.4.1 Facebook 

Facebook is one among giant online platform that allows people to connect with each 
other. It is premier in number of largest user base. It is one way to keep in touch with old 
friend and family members across the globe. Facebook’s user’s base is shoring day-by-day. 
Using facebook we can have virtual meeting easier than face to face meeting. Facebook 
has become so popular because it is very personal and entirely global at the same time. 
Every person who joins Facebook helps pull other people onto it and increases the loyalty 
of their real-world friends, who now become Facebook friends as well. 
 
Since its launch in 2004, the social networking site has primarily been viewed as a 
platform for personal expression, and a place to connect with friends. However, Facebook 
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has put significant effort into creating a platform that individuals, businesses and 
organizations can use to promote themselves. These are Facebook Pag

 

How to Create Facebook Account: 

 
1. You need to open facebook page in browser window by typing page address 

https://www.facebook.com/ or open your Facebook app and tap Create New 
Account. Once the page is opened you may fin

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It requires keying in your following information: 

 

First Name and Last Name

your birth certificate not your nick name
 
Your Email: Be sure to use an email address that
to. For instance, if you use a work email address and
you could lose access to your Facebook
with an address provided by
cause you huge problems with both your personal Facebook presence and 
with the fan page for your business.

 

Password: Be sure to use a relatively safe and secure password,
something easy like “passw0rd.” You won’t want someone
password, then posting under your name and
your business—problems.
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has put significant effort into creating a platform that individuals, businesses and 
organizations can use to promote themselves. These are Facebook Pages. 

: To create a Facebook account: 

You need to open facebook page in browser window by typing page address 
https://www.facebook.com/ or open your Facebook app and tap Create New 

Once the page is opened you may find the screen as below. 

It requires keying in your following information:  

First Name and Last Name: Use your “official” name, what is printed on 
your birth certificate not your nick name 

Be sure to use an email address that you’ll always have access 
to. For instance, if you use a work email address and quit or lose your job, 
you could lose access to your Facebook account. The same thing can happen 
with an address provided by a mobile phone company or similar. This can 

problems with both your personal Facebook presence and 
the fan page for your business. 

Be sure to use a relatively safe and secure password,
something easy like “passw0rd.” You won’t want someone guessing your 

sting under your name and potentially causing you
problems. 

701BT 

has put significant effort into creating a platform that individuals, businesses and 

You need to open facebook page in browser window by typing page address 
https://www.facebook.com/ or open your Facebook app and tap Create New 

, what is printed on 

have access 
quit or lose your job, 

account. The same thing can happen 
a mobile phone company or similar. This can 

problems with both your personal Facebook presence and 

Be sure to use a relatively safe and secure password, not 
guessing your 

potentially causing you—and 
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Date of Birth: Enter this accurately for verification purposes. However, 
don’t show your full birthday (that is, your birthday including the year) on 
Facebook—that makes things too easy for identity thieves. 
Gender: select your gender from the options (Male/Female/Custom) 
 

2. Tap Sign Up. 
 

3. To finish creating your account, you need to confirm your email or mobile phone 
number. 
 

To finish creating an account, you need to confirm that you own the email or mobile phone 
number that you used to create the account: 
 

• To confirm your mobile number, enter the code you get via text message (SMS) in 
the Confirm box that shows up when you log in. Learn what to do if you didn't get 
the SMS. 
 

• To confirm your email, click or tap the link in the email you got when you created 
the account. Learn what to do if you can't find the email. 

 
Confirming your email or mobile number helps us know that we're sending your account 
info to the right place.  
 
You need to confirm your email or mobile number as soon as possible. You may not be 
able to use your account until you confirm your email or mobile number. If you do not 
confirm your account, it may be deleted after one year of inactivity. 
 

4.4.2 LinkedIn 

According to official website of LinledIn, the company was founded in 2003, LinkedIn 
connects the world's professionals to make them more productive and successful. With 
more than 675+ million members worldwide, including executives from every Fortune 500 
company, LinkedIn is the world's largest professional network. The company has a 
diversified business model with revenue coming from Talent Solutions, Marketing 
Solutions, and Premium Subscriptions products. Headquartered in Silicon Valley, 
LinkedIn has offices across the globe. 
 
With LinkedIn, you can 

• Create a profile that helps achieve your professional goals 

• Develop and manage a network of professional contacts 

• Reconnect with former colleagues and classmates 

• Find jobs, consulting opportunities, and clients 

• Recruit job candidates 

• Request and give professional recommendations 

• Find and give answers to compelling business questions 

• Join groups to discuss issues with like-minded individuals 
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• Establish your credibility as an expert in your field

• Conduct marketing research 

• Promote your services as a LinkedIn service provider

• Advertise your business 
 
Creating a LinkedIn Account: The Registration page might vary in appearance, 
depending on whether as would be user 
registration process is the same. To create
https://www.linkedin.com/login in the web 
following window will open. You need to click join now button to create your account.
the Join LinkedIn page, which you can see
collect some basic information about you to create your account.

Specifically, you need to provide the following information:
 

• Your first name, last name, and e

information, either from the invitation you received or the text you entered when 
you went to the home page. 
 

• A password for your LinkedIn account: 

characters long, and should not be something 
 

• Your country and postal code

use it to assign a Region to your profile, so others know the general area where you 
reside. 
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Establish your credibility as an expert in your field 

Promote your services as a LinkedIn service provider 

The Registration page might vary in appearance, 
as would be user signing up with or without an invitation, but the 

create LinkedIn account you need to type web address 
https://www.linkedin.com/login in the web browser window and press enter key.
following window will open. You need to click join now button to create your account.

Join LinkedIn page, which you can seen below the illustration, LinkedIn needs to 
collect some basic information about you to create your account. 

Specifically, you need to provide the following information: 

Your first name, last name, and e-mail address: LinkedIn fills in this 
information, either from the invitation you received or the text you entered when 

sword for your LinkedIn account: Your password needs to be at least 6 
characters long, and should not be something another person could easily guess.

Your country and postal code: LinkedIn will not display your ZIP code, but will 
use it to assign a Region to your profile, so others know the general area where you 

701BT 

The Registration page might vary in appearance, 
signing up with or without an invitation, but the 

LinkedIn account you need to type web address 
window and press enter key. The 

following window will open. You need to click join now button to create your account. On 
needs to 

 

LinkedIn fills in this 
information, either from the invitation you received or the text you entered when 

Your password needs to be at least 6 
another person could easily guess. 

LinkedIn will not display your ZIP code, but will 
use it to assign a Region to your profile, so others know the general area where you 
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• Your current employment status

employed, self

 

• Details about your status

a Company, Job Title, and Industry if you are employed, or ask
if you are looking for work

 
Once you have completed the Join LinkedIn form, click the blue Join LinkedIn button to 
create your account. If you’re joining with an invitation, the Registration page will have a 
few slight differences. If you want to be known
name (say a nickname, maiden name, or proper name), or if you want to use a different
e-mail address, you can change the details now in those fields 
E-mail. 
 

4.4.3 Twitter 

 
Twitter is a social network that gives you the ability to post messages of
less. Because Twitter is a network with members throughout
a message, from Haldwani
at the same time. Twitter is built on the concept of 
short, frequent posts (often by using a cell phone) that don’t exceed 140 characters.
140-character posts are known as 
 
How to Create Account on Twitter:

it following the instruction online using official website of twitter. the URL of the official 
website is https://twitter.com/?lang=en
 

1. You need to open 
https://twitter.com/?lang=en
Once the page is opened you may find the screen as below.

 

Application of Computers in Hospitality and Tourism                                

Uttarakhand Open University                                        

Your current employment status: Click the drop-down box to indicate if you are 
employed, self-employed, looking for work, or a student. 

Details about your status: Depending on your status, LinkedIn will either
a Company, Job Title, and Industry if you are employed, or ask
f you are looking for work. 

Once you have completed the Join LinkedIn form, click the blue Join LinkedIn button to 
create your account. If you’re joining with an invitation, the Registration page will have a 
few slight differences. If you want to be known on LinkedIn by another version of your 

a nickname, maiden name, or proper name), or if you want to use a different
mail address, you can change the details now in those fields — First Name,

cial network that gives you the ability to post messages of
less. Because Twitter is a network with members throughout the world, when you send out 

from Haldwani in Uttarakand other user across the globe can 
Twitter is built on the concept of micro-blogging, in which people write 

frequent posts (often by using a cell phone) that don’t exceed 140 characters.
character posts are known as tweets. 

How to Create Account on Twitter: Creating twitter account is very easy, one can create 
it following the instruction online using official website of twitter. the URL of the official 

https://twitter.com/?lang=en. 

You need to open twitter page in browser window by typing page a
https://twitter.com/?lang=en or open your twitter app and tap Create New Account.
Once the page is opened you may find the screen as below. 
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down box to indicate if you are 

Depending on your status, LinkedIn will either ask for 
a Company, Job Title, and Industry if you are employed, or ask for Industry focus 

Once you have completed the Join LinkedIn form, click the blue Join LinkedIn button to 
create your account. If you’re joining with an invitation, the Registration page will have a 

on LinkedIn by another version of your 
a nickname, maiden name, or proper name), or if you want to use a different    

First Name, Last Name, 

cial network that gives you the ability to post messages of 140 characters or 
the world, when you send out 

the globe can read the message 
in which people write 

frequent posts (often by using a cell phone) that don’t exceed 140 characters. Those 

Creating twitter account is very easy, one can create 
it following the instruction online using official website of twitter. the URL of the official 

page in browser window by typing page address 
app and tap Create New Account. 
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2. Click sign up button to create account. This will open next dialogue box requiring 
information like your Name, Phone Number, or you may use e
of birth as shown below in illustration below.

 

 
• Your first name, last name, 

Birth: Use your “official” name
nick name. Your phone number, your e
and click next button then following dialog box appears. 
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Click sign up button to create account. This will open next dialogue box requiring 
ame, Phone Number, or you may use e-mail ID, and Date 

illustration below. 

 
Your first name, last name, Phone number or e-mail address and Date of 

Use your “official” name, what is printed on your birth certificate not y
nick name. Your phone number, your e-mail ID and Date of Birth. Once you fill 
and click next button then following dialog box appears.  

 

701BT 

Click sign up button to create account. This will open next dialogue box requiring 
mail ID, and Date 

and Date of 

, what is printed on your birth certificate not your 
mail ID and Date of Birth. Once you fill 
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3. Check the box and click next button, it will lead to opning of third dialogbox, 
showing your Name, Mobile Numbe
you may go back by cllicking back button. Once you find information is correct 
you may press Sign up button to create account. When you press Sign up button, 
twitter sends varification code on your phone as sh

 

 
4. When you press OK button next dialogue box appears.

5. Now you need
have provided. Now you enter the code received on your mobile phone and press 
next button. 
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Check the box and click next button, it will lead to opning of third dialogbox, 
showing your Name, Mobile Number and Date of Birth if there is any correction 
you may go back by cllicking back button. Once you find information is correct 
you may press Sign up button to create account. When you press Sign up button, 
twitter sends varification code on your phone as shown in illustration below

hen you press OK button next dialogue box appears. 

 
need to enter the verification code on your registered mobile number you 

have provided. Now you enter the code received on your mobile phone and press 
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Check the box and click next button, it will lead to opning of third dialogbox, 
r and Date of Birth if there is any correction 

you may go back by cllicking back button. Once you find information is correct 
you may press Sign up button to create account. When you press Sign up button, 

own in illustration below 

 

 
on your registered mobile number you 

have provided. Now you enter the code received on your mobile phone and press 
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6. Now your account is created. 
 

Now you are ready to Tweet (a form of micro
amounts of content in the form of short text messages that they send to unique sets of 
people or entire groups. 
 

4.4.4 Other Social Media Applications

Fred Cavazza describes the social media as a rich ecosystem that is perpetually evolving. 
He created the infographic of the social media landscape in 2011 that showed a much 
sharper vision of the social media ecosystem and emerging practices 
or social search as compared to his earlier version in 2008. According to him, this new 
landscape is composed of 7 families, which matches the 7 primary uses of the social media 
as follows:  

• Publish: for publishing text using blog plat
blog platform eg. Twitter, and collaborative publishing eg.

 

• Share: for sharing your video content eg. 
links on Delicious, music eg. Spotify

 

• Discuss: discussion on bulletin boards
eg. JS-Kit, and social search tools 

 

• Commerce: for customers reviews solutions 
and inspiration communities 
shopping tools eg Look’n’Be and Facebook
 

• Location:  with social location platforms (Foursquare, Gowalla, MyTown, 
Facebook Places, Google Places),
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form of micro-blogging) to other users and share massive 
amounts of content in the form of short text messages that they send to unique sets of 

Applications 

Fred Cavazza describes the social media as a rich ecosystem that is perpetually evolving. 
He created the infographic of the social media landscape in 2011 that showed a much 
sharper vision of the social media ecosystem and emerging practices like social commerce 
or social search as compared to his earlier version in 2008. According to him, this new 
landscape is composed of 7 families, which matches the 7 primary uses of the social media 

using blog platforms eg. WordPress, Blogger, micro
and collaborative publishing eg. wikis Wikipedia 

your video content eg. YouTube, your photos eg. Instagram
Spotify  ), and your documents eg. SlideShare etc.

bulletin boards eg.PhpBB, comments management systems 
Kit, and social search tools  eg. Quora,  

customers reviews solutions eg. BazaarVoice, recommendation 
and inspiration communities eg. Weardrobe, purchase sharing tools eg. 

Look’n’Be and Facebook-shopping tools eg. ShopTab 

with social location platforms (Foursquare, Gowalla, MyTown, 
acebook Places, Google Places), 

701BT 

 

share massive 
amounts of content in the form of short text messages that they send to unique sets of 

Fred Cavazza describes the social media as a rich ecosystem that is perpetually evolving. 
He created the infographic of the social media landscape in 2011 that showed a much 

like social commerce 
or social search as compared to his earlier version in 2008. According to him, this new 
landscape is composed of 7 families, which matches the 7 primary uses of the social media 

WordPress, Blogger, micro-

eg. Instagram, 
SlideShare etc. 

PhpBB, comments management systems 

BazaarVoice, recommendation 
eg. co-

with social location platforms (Foursquare, Gowalla, MyTown, 
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• Network: with personal social networks (MyYearBook, MyLife, CopainsDavant, 
Badoo), professional social network (LinkedIn, Viadeo, Xing, Plaxo), « traditionnal 
» social network (Facebook, MySpace, Orkut, Tagged, Hi5) and social networks 
creation tools (Ning, KickApps); 

 

• Games: where you can find traditionnal players from casual gaming (Kongregate, 
Pogo, PopCap, PlayFirst), but also new comers from social gaming (Zynga, 
Playfish, Playdom, SGN), as well as mobile gaming (ngmoco, OpenFeint) and 
virtual worlds for tweens (Habbo, Club Penguin, Poptropica). 

 

We have already discussed about Facebook, LinkedIn and Twitter, in this section we will 
be discussing two more such social media platform widely used for sharing Video (Your 
Tube) and multiple format sharing like text, audio, images and video at same place 
(whatsapp). 
 

YouTube 

YouTube is a video sharing community. A YouTube users can upload and view all sorts of 
video clips online, using any web browser. YouTube is also a repository for “historical” 
items. Most of the videos on YouTube come from individuals, just like you and me. Many 
of these videos are simple home movies, of everything from birthday parties to school 
plays. Anybody with a video camera can easily upload their home movies to YouTube and 
make them available for the whole world to see. There are even a lot of television shows 
and movies on YouTube. The site’s Shows categories features television programming 
from TV channels like Star network, Zee network, the Movies category features current 
and classic movies. And it’s all free. 
 
It may seem simple to watch a video (just click the play button), but when you view a 
video on YouTube there’s a lot of technology involved behind the scenes. It all starts with 
the uploading of video files. Users upload videos to YouTube in QuickTime, AVI, MPEG, 
or Windows Media Video (WMV) file formats. YouTube then converts these video files 
into Flash format— which is how the videos are served to YouTube users. 

 

Creating a YouTube Account: To take full advantage of all of YouTube’s features, you 
need to set up your own personal YouTube account. Naturally, you need an account before 
you can upload any videos to the site. But you also need an account to save your favorite 
videos, create playlists, join groups and communities, and the like. Fortunately, it’s both 
easy and free to create a YouTube account. Just go to the home page and click the Sign Up 
link at the very top of the page. If you already user of Google and have and gmail account 
you may also used the Youtube simply signing in using gmail user ID and Password.  

 

Browsing by Category: For most users, the best way to browse YouTube is by category. 
To browse by category, follow these steps: 
 

1. From any YouTube page, click the Videos button on the YouTube 
toolbar. 
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2. Click the category name in the Categories list on the left side of the 
page. 

3. When the next page appears, click the Popular tab to view popular 
YouTube videos in that category, or the Most Viewed tab to view 
the most viewed videos in that category. 

4. To view a specific video, click the thumbnail for that video. 

 
 

WhatsApp 

WhatsApp is an instant messaging application which enables text messaging between 
users. It is similar to computer messaging programs (chat) that commonly exist in the web, 
with the difference that this one works in mobile phones.  It is said to be multiplatform 
because it is available in different mobile operating systems that currently exist such as 
IOS, Android, Windows Phone, and Nokia. Its story begins in 2009, when two young 
entrepreneurs, former employees of Yahoo, called Jan Kuom and Brian Acton, decided to 
create an application, which initially was only going to inform other users of activities they 
were doing at that precise moment. However, in time the idea was developed into what 
now is an instant messaging application with multiple functions, used by more than one 
Billion people worldwide. WhatsApp is an application dedicated to instant messaging 
among users. Anyone can find someone in the platform through their phone number. 
Therefore, just knowing the phone number of someone is enough to add them to your 
contacts list. Note that for both, the sender and the receiver communicating via WhatsApp, 
it is necessary that the application is installed. Once you have this application installed, 
you can send unlimited text messages, which can have an unlimited number of digits. Also, 
you can send multimedia messages, allowing you to send or receive images, audio files, or 
even video recordings, whether using your own phone or downloading it from some other 
source. Using WhatsApp you can do following: 

• Phone Calls 



   

Application of Computers in Hospitality

Uttarakhand Open University

• 

• 

• 

• 

• 

• 

 

WhatsApp Web: WhatsApp now has a version for PC called WhatsApp Web, which 
consists of connecting the application platform through the browser on your own personal 
computer. The application is an extension of the mobile application that you normally use 
on your phone. It will display your messages on your computer which you receive while 
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 Video Calls 

 Voice Messages 

 Text Messages 

 Sharing Images 

 Sharing Locations 

 Sharing Videos 

WhatsApp now has a version for PC called WhatsApp Web, which 
ting the application platform through the browser on your own personal 

The application is an extension of the mobile application that you normally use 
on your phone. It will display your messages on your computer which you receive while 
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WhatsApp now has a version for PC called WhatsApp Web, which 
ting the application platform through the browser on your own personal 

The application is an extension of the mobile application that you normally use 
on your phone. It will display your messages on your computer which you receive while 
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you are connected to the internet. By connecting your browser with WhatsApp Web, all 
your contacts and conversations will be synchronized, as they are in your phone.  
 
How to Register: For registering one needs to download the WhatsApp mobile application 
from Google Play Store for android based phones. It is available for android, iPhones and 
for PC too.  
 
Once you have downloaded it in your phone, then open the app and follow the instruction, 
it requires your Name and Phone number, which is verified and once verification is 
completes you are ready to share your text, image, audio, video to other members in your 
phonebook having WhatsApp installed at their end.  
 

CHECK YOUR PROGRESS-I 

 
1. Write a note on ‘Social Media’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 

 
2. Write a note on ‘Facebook’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________ 

4.5 MERITS OF SOCIAL MEDIA 

 
The social media has some inherent properties which make it much more powerful than the 
traditional media. Some of its merits are as under: 

• Accessibility 

• Speed 

• Interactivity 

• Longevity / volatility 

• Reach 
Accessibility: The social media is easily accessible and takes minimal or no costs to use. 
Social media is easy to use and does not require any special skills, knowledge to use. It is 
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absolutely simple to connect with others and be a part of communities. Therefore anyone 
with online access can use the Social Media to initiate or participate in the conversations. 
In a sense, everyone is now empowered to speak up. 
 
Speed: The content that you create on the social media is available to everyone in your 
network/forum/community as soon as you publish it. You can communicate with your 
audience without any external factor affecting the delivery of your message. The responses 
are also near instantaneous and thus you can have a dialogue, which is almost in real-time. 
 
Interactivity: Social media affords a two way or multiple communication channels. Users 
can interact with each other; ask questions, discuss products / services, share opinions and 
anything else they might be interested in doing. 
 
Longevity / volatility: Social media content remains accessible for a long time, maybe 
forever, because of the nature of the medium. In addition to this the content can be edited / 
updated anytime. So, if a user likes a particular product and says so in the social media, it 
is not a permanent positive vote for the product; the user can always go back and change 
his opinion anytime. 
 
Reach: The Internet offers an unlimited reach to all content available. Anyone can access 
it from anywhere and anyone can reach, potentially, everyone. Social media offers the 
same facility to all the users who can share anything with anyone they like. 
 
Social media has opened up new avenues for people to engage with each other and with the 
content available on the Internet. The social interaction of the yore, severely restricted by 
various boundaries, has now been taken online, opening up a world of new possibilities. 

 

Benefits of Social Media for Individuals: The social media has come a long way, the 
way people communicate with each other and hold conversations is on a completely 
different level than what it was, say, a decade ago. The Internet and web technologies have 
made it possible for people and businesses to have a wider reach due to its global nature, 
and therefore, both – individuals and businesses for their respective benefits, can use the 
social media effectively. 
 

o Personal Use: Individuals can use the social media for personal reasons, 
which may be for keeping in touch with the latest technology, news, gossip, 
and happenings around the world or in their own locality. In this day and 
age, it would be hard to find a person who does not use the e-mail facility to 
send messages to friends/colleagues and/or for official purposes or use the 
social media for collaboration.  

 

o Explore Your Creativity: People can use available social media tools to 
explore their own creativity, for example, a person who loves to write can 
create their own blogs and explore their writing talents. One who is good in 
creating video may use Youtube to upload their videos and may create their 
own Youtube Channels and may earn a good income from their creativity. 
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Due to the very nature of social media it is easy to reach a large audience 
and find an interested readership.  

 
o Social Interaction: Human beings love to socialize and interact with each 

other. The social media enables people to interact with each other using the 
highly accessible and scalable communication techniques that are available 
today, in the form of websites and the mobile phones using tools like 
facebook, WhatsApp etc. 

 

o Get Empowered: The social media has succeeded in putting the power 
back into the consumer’s hands. As mentioned in the paragraph above, any 
individual can have a “social influence” by virtue of his/her social 
interactions on the web or via mobile technologies. 

 

 

Benefits of Social Media for Businesses: Today, more than 90% of the adult online 
population is using social media, which includes many of your customers who are 
networking with others. No business can ignore social media anymore. If you are, you are 
not only losing an opportunity to enhance your business, but your absence may also be 
causing damage to your brand and reputation.  
 
There are losts of benefits, for businesses, of participating in the social media. Non-
participation on the other hand could be eating away your market share and reputation. 
Given below are some of the principle benefits of social media for businesses. They are as 
follows: - 

• Online Branding: Every business wants to be known as a brand, which is, in 
effect, its “identity” that may be represented by a name, logo, colour schemes or 
the tag line. But, the term “branding” goes much beyond just these and is in fact a 
culmination of the individual “identity” of the business, how it differs from its 
competitors and why a buyer should come to it.  

 

• Marketing: Social Media Marketing is the way businesses and non-
profit organizations use the social media effectively to build 
relationships through trust, useful content, helpfulness and authority.  
 

• Building Relationships: For a business to be successful it needs 
satisfied customers, and for a customer to be satisfied they need 
good customer care and service. A satisfied customer is a loyal 
customer.  
 

• Word-of Mouth / Networking: Social Media is the new Word-of-

Mouth. Since people are all inter-connected with each other, a small 
mention in any of your audience’s profile goes a long way in 
spreading the word about your business/product. Let your customers 
become your marketing agents. 
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• Online Reputation Management: “The practice of monitoring the 
Internet reputation of a person, brand or business, with the goal of 
suppressing negative mentions entirely, or pushing them lower on 
search engine results pages to decrease their visibility is known as 
online reputation management (ORM).”  
 

• Community Building: A company or business can use the social 
media to build a community around its products/business. Vibrant 
communities create loyalty and encourage discussions, which can 
contribute towards business development and improvement. 
 

• Lending a Human Face to the Business: More and more 
customers are sick of the marketing jargon and are not comfortable 
dealing with faceless businesses. People like to deal with people and 
participation in social media helps to lend a face to your business. 

 

4.6 DE-MERITS OF SOCIAL MEDIA 

 
Demerits of social media networking sites for individuals: Some of the demerits of the 
social media for individuals are as under: 
 

Privacy: Nowadays, the social-networking sites such as Facebook and Twitter are 
open for anyone who wants to participate. There are several networking sights like 
facebook, linkedin, WhatsApp, Fliker, Media and photograph sharing sites; where 
users are constantly uploading their contents and imags. There are millions of users 
of these social media tools. The people using these Medias with their own interests 
and if someone having bad intentions may create a real problem. Identity theft is 
among the most dangerous threats and may lead to suffer from financial losses and 
social embracement. 
 
Virtual Friends are not same as Real Friends: Through social networking, 
person has a lot of friend but the quality and integrity of these friendships is not 
always true. On the other hand, data on these social-networking sites for a person is 
not always 100% honest and reliable, and they do not verify personal details (age, 
location, etc.) of their members. While sites provide an opportunity for individuals 
to present a positive and accurate self-image, there is an equal potential to abuse 
this openness. So, having many friends through social networking sites is likely to 
be more harmful than good. 
 
Time consuming: The amount of time spent by individuals with each other online 
has risen to greater extent. This has effect on health of individuals, because 
spending a lot of time browsing these social networks can affect the way the genes 
operate within the human body, and weakens the immune and hormone levels. In 
addition, it is also has an impact on mental health. Moreover, the use of social 
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networking in the education can cause lack of motivation towards learning and can 
be boring sitting in front of computer for a long time. 

 

Disadvantages of Social Media for Business: Social media is like science is a friend as 
well as a potential threat too. Using social media in business may lead to following 
disadvantages: 

• Negative feedback 

• Potential for embracement 

• Time consuming campaign 

• Delayed results   
 

Negative Feedback: People use social media not to post content they like but also 
use to share their negative experiences. If someone had a poor experience with your 
products of your enterprise, it opens a door of opportunity for them to share their 
bad experience with others. This negative feedback comes in different forms. On 
platforms like facebook, linkedin, orkut etc., someone can leave a negative review 
on your page and share their negative experience. When someone checks out your 
business next, they’ll look at the reviews and see the negative feedback. On online 
blogging platform like twitter, users can tag a company in their posts and share 
their negative experience. People can re-tweet that poor experience and spread it 
across the network. Social media platforms are powerful in complaining and 
leaving negative feedback. People use their profiles to help others understand their 
negative experience. Alternatively, other may feel there is a social obligation to 
share their experience to prevent others from having the same bad experience. 
Thus, it may lead to create a huge negative feedback which can reduce or even ruin 
your marketing efforts. 

 

The Potential for Embarrassment: A descriptor for an idea, piece of media, or 
technology tool that grows exponentially as people share the information with their 
friends. Where that once meant a few people you might talk to that day, it now 
means the thousands of people you are connected to online directly or indirectly 
through your contacts. Hence this term, like a biological virus, suggests how the 
awareness of new things can grow exponentially in just a few days. It’s easy for 
posts to go viral on social media. People keep a close eye on the good and the bad 
on social media. If you aren’t careful about the content you post, you can end up 
embarrassing your company and getting caught in an awkward situation. 

 

Time consuming campaign: Social media is not only one and done type of 
marketing method. You must constantly create new content, post content, and 
engage with your audience on these platforms. A big drawback to social media is 
that it is time-consuming for companies. You have to find time to balance posting 
content, monitoring that content, responding to people, and measuring your 
content’s impact. If you don’t have the resources, it can be an overwhelming task. 
If you are unable to do enough with your social networks because you are busy 
with people, or programs your business campaigns will suffer. Your social media 
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campaign will not remain  as effective as your rivals if they are taking care of these 
factors  to run a successful social media campaign. 

 
Delayed Results: After having enough investment in social media marketing  strategies, 
you may want to see immediate results. You want to know that your strategies are working 
and that the investment is worth your time. With social media marketing, you don’t see 
immediate results. Social media marketing’s success is predicated on the campaign’s 
overall success. Posting one piece of content doesn’t determine the success of your 
campaign. You must post multiple pieces of content over a period of time to determine the 
true success of your campaign. This is a downside of social media because you have to 
wait to see results. You must be patient and wait a few weeks to see results before you can 
adjust your campaign. 
 

4.7 ROLE OF SOCIAL MEDIA IN HOSPITALITY PROMOTIONS  

 
Social media is best defined in the context of the previous industrial media paradigm. 
Traditional media, such as television, newspapers, radio, and magazines, are one-way, 
static broadcast technologies. For instance, the magazine publisher is a large organization 
that distributes expensive content to consumers, while advertisers pay for the privilege of 
inserting their ads into that content. But these media was lacking the instant feedback from 
the target audience.  

 

New web technologies have made it easy for anyone to create—and, most importantly—
distribute their own content. A blog post, tweet, or YouTube video can be produced and 
viewed by millions virtually for free. Advertisers don’t have to pay publishers or 
distributors huge sums of money to embed their messages; now they can make their own 
interesting content that viewers will flock to. Social media comes in many forms, but for 
our purposes, I’ll focus on the eight most popular: blogs, microblogs (Twitter), social 
networks (Facebook, LinkedIn), media-sharing sites (YouTube, Flickr), social 
bookmarking and voting sites (Digg, Reddit), review sites (Yelp), forums, and virtual 
worlds (Second Life). 

 
Traditional marketing approaches for the tourism, travel, hospitality and leisure industries 
focused on identifying the product features and benefits that would satisfy the needs, wants 
and demands of tourists and travellers, as well as the appropriate price, an integrated 
promotion and communication mix, and the management of distribution channels. Many 
marketing managers focus their efforts and activities on exploiting promotional tools 
including advertising, sales promotion, public relations, special events, publicity, and brand 
awareness. But in the current social, economic and business environment, marketing 
managers in tourism need to have Web 2.0 applications and techniques as part of their 
overall marketing plans. 
 

Social Network Sites (SNSs) are websites that allow subscribers to connect and interact 
with other people. The starting point is the creation of a public or semipublic profile 
followed by an invitation to other members to share profiles (becoming friends), thus being 
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automatically added to the list of contacts. This creates a group of people who share 
information and content (text, photos, videos, etc.) Users can communicate by means of 
posts, instant messaging (chat), or e-mail. The first type (posts) is public and all the 
contacts of the list can see it. In the other cases (instant messaging and e-mails), the 
communication is directed only to a selected friend. SNSs can connect people with friends 
for leisure purposes (i.e., Facebook) or for professional reasons (i.e., Linkedin). 
Nevertheless, these boundaries have changed with the development of corporate Facebook 
pages that allow companies to create specific pages for the company itself, single brands 
and products to interact with customers who are trying to engage them. 
 

Facebook Corporate Pages: Along with the growing interest of companies in using 
Facebook to manage communication activities with customers and doing business, specific 
corporate accounts were created because commercial activities are prohibited in personal 
profiles. Personal profiles and business pages present some differences. First of all, the 
purpose is obviously different because the company’s objective is not to socialize and find 
new friends, but to attempt to engage with customers, creating a long-term relationship and 
consequently improving sales. This difference implies a reduction in functionalities of the 
corporate page in actions toward personal profiles. In fact, the corporate Facebook page 
cannot send or receive friendship requests or see the profile of the page users. On the 
contrary, users receive updates on the company, the brand or products. This is allowed by 
Facebook policies because, by “liking” the corporate page, users have opted to receive this 
information. The Facebook business page is structured as follows: 
 

• cover photo and the profile picture of the company/brand; 

• “page title” and counting metrics visible by users (e.g. like, people talking 
about this and were here); 

• “about” where the company can give general information (i.e., mission, brief 
description, etc.); 

• “View and Apps” the area of the page that the company can customize (it is 
generally composed by the sections photos and events but other functions can 
beadded); 

• “composer” the area where companies can interact with users asking questions 
with text, pictures, etc.; 

• “friend activity,” where users can see how their friends interact with the page; 

• “Date Selector” allows users to navigate sections of the page timeline; 

• “Admin Panel” is a specific service that allows the company to view 
notifications replies to messages, view page insights and edit page content. 

 

Facebook offers also specific services for developing the page and checking corporate 
performance. Starting from the Admin Panel it is possible to access the “Facebook Page 
Insight” which collects all the Key Performance Metrics of the page (e.g. total likes, 
friends of fans, people talking about this, and total reach), which can be consulted and also 
exported to Excel, selecting a specific period of time. Data give also demographic 
information about the users of the page, trying to understand how they respond to posts. 
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CHECK YOUR PROGRESS-II 

 
1. Write a note on ‘Merits of Social Media’. 
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________
____________________________________________________________________________ 

 
2. Write a note on ‘Social Media Application in Hospitality Promotion’. 
____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________

____________________________________________________________________________ 

4.8 SUMMARY 

The emergence of social media began in the early days of Internet when people started 
sharing information and communicating with each other. Contrary to the general 
perception of social media being restricted to networking websites like Facebook, 
LinkedIn, Instagram, Telegram, SnapChat, Whatsapp, Twitter etc. the social media 
encompasses all the services that facilitate creation, sharing and exchange of user-
generated content.  
 
These include but are not restricted to Internet forums, groups, blogs, microblogs, 
networking sites, social bookmarking sites, wikis, podcasts, content communities for 
articles, video/photo sharing sites, review sites etc. Each type of social media has its own 
benefits and there is something for everyone. In this unit we have learnt about social 
media, various platforms like Facebook, Twitter, LinkedIn and other social media 
applications. We have also examined the role of social media in promotion of hospitality. 
 

4.9 GLOSSARY 

 

Accessibility: The social media is easily accessible and takes minimal or no costs to use. 
Social media is easy to use and does not require any special skills, knowledge to use. It is 
absolutely simple to connect with others and be a part of communities. Therefore anyone 
with online access can use the Social Media to initiate or participate in the conversations. 
In a sense, everyone is now empowered to speak up. 
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Blocking: When we refer to an organization blocking social technology use, we mean that 
the IT department configures the routers and switches so that specific Web sites cannot be 
accessed from the company network. 

 

Building Relationships: For a business to be successful it needs satisfied customers, and 
for a customer to be satisfied they need good customer care and service. A satisfied 
customer is a loyal customer.  

 

Commerce: for customers reviews solutions eg. BazaarVoice, recommendation and 
inspiration communities eg. Weardrobe, purchase sharing tools eg. co-shopping tools eg 
Look’n’Be and Facebook-shopping tools eg. ShopTab 

 

Community Building: A company or business can use the social media to build a 
community around its products/business. Vibrant communities create loyalty and 
encourage discussions, which can contribute towards business development and 
improvement. 

 

Corporate Speak: Refers to a style of communicating that is devoid of humanness. It 
lacks any sense of humor, edge, or style. It’s bland copy that would never offend anyone, 
and has been stripped of anything that would give you a sense that a human wrote it. 
Corporate speak often uses an overkill of industry buzzwords so that anyone reading it 
from outside the industry would need a dictionary to decipher the text. 

 

Delayed Results: After having enough investment in social media marketing  strategies, 
you may want to see immediate results. You want to know that your strategies are working 
and that the investment is worth your time.  

 

Discuss: discussion on bulletin boards eg.PhpBB, comments management systems eg. JS-
Kit, and social search tools  eg. Quora,  

 

eWord of Mouth: Traditional word of mouth has always been the most powerful source 
of persuasion in getting a product or service sold. People trust their friends more than 
advertising. Most studies show that around 13 percent of consumers believe advertising 
and 80 percent believe word-of-mouth recommendations. Social tech now gives us the 
ability to generate and nurture electronic word of mouth. This can be done by giving 
people tools like videos, links, and electronic documents that they pass to their friends to 
promote things they believe in. You’ll see us shorten the moniker for this concept to  
eWord of mouth from now on. 

 

Explore Your Creativity: People can use available social media tools to explore their 
own creativity, for example, a person who loves to write can create their own blogs and 
explore their writing talents. One who is good in creating video may use Youtube to 
upload their videos and may create their own Youtube Channels and may earn a good 
income from their creativity. Due to the very nature of social media it is easy to reach a 
large audience and find an interested readership.  
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Facebook Corporate Pages: Along with the growing interest of companies in using 
Facebook to manage communication activities with customers and doing business, specific 
corporate accounts were created because commercial activities are prohibited in personal 
profiles. Personal profiles and business pages present some differences.  

 

Fast Follower Many experts believe that the best place to be on the adoption curve is a 
fast follower. They postulate that the first movers often pay a heavy price in experimenting 
with a completely new field, whereas the fast followers avoid the early mistakes but still 
leverage a new technology fast enough to get the benefit of leveraging the positive aspects 
before their competition can get up to speed. 

 

Games: where you can find traditionnal players from casual gaming (Kongregate, Pogo, 
PopCap, PlayFirst), but also new comers from social gaming (Zynga, Playfish, Playdom, 
SGN), as well as mobile gaming (ngmoco, OpenFeint) and virtual worlds for tweens 
(Habbo, Club Penguin, Poptropica). 

 

Get Empowered: The social media has succeeded in putting the power back into the 
consumer’s hands. As mentioned in the paragraph above, any individual can have a “social 
influence” by virtue of his/her social interactions on the web or via mobile technologies. 

 

Interactivity: Social media affords a two way or multiple communication channels. Users 
can interact with each other; ask questions, discuss products / services, share opinions and 
anything else they might be interested in doing. 

 

Lending a Human Face to the Business: More and more customers are sick of the 
marketing jargon and are not comfortable dealing with faceless businesses. People like to 
deal with people and participation in social media helps to lend a face to your business. 

 

Location:  with social location platforms (Foursquare, Gowalla, MyTown, Facebook 
Places, Google Places), 

 

Longevity / volatility: Social media content remains accessible for a long time, maybe 
forever, because of the nature of the medium. In addition to this the content can be edited / 
updated anytime. So, if a user likes a particular product and says so in the social media, it 
is not a permanent positive vote for the product; the user can always go back and change 
his opinion anytime. 

 

Malware: Describes any small bit of code that can be injected into a device or network 
with harmful intent. This includes viruses, keyboard loggers, zombie controls, and 
spambots. 

 

Marketing: Social Media Marketing is the way businesses and non-profit organizations 
use the social media effectively to build relationships through trust, useful content, 
helpfulness and authority.  

 



   

Application of Computers in Hospitality and Tourism                                BHM-701BT 

Uttarakhand Open University                                        186 

Micro-blogging: Refers to any service that delivers a message to a person, or group of 
people, in a restricted number of characters. The “micro” prefix indicates that this message 
is typically fewer than 200 characters (for Twitter that number is 140). The “blogging” 
distinguishes the exercise from text messaging in that it’s designed to deliver the message 
to many people and, in some cases, even to millions of people with the press of a button. 

 

Negative Feedback: People use social media not to post content they like but also use to 
share their negative experiences. If someone had a poor experience with your products of 
your enterprise, it opens a door of opportunity for them to share their bad experience with 
others. This negative feedback comes in different forms.  

 

Network: with personal social networks (MyYearBook, MyLife, CopainsDavant, Badoo), 
professional social network (LinkedIn, Viadeo, Xing, Plaxo), « traditionnal » social 
network (Facebook, MySpace, Orkut, Tagged, Hi5) and social networks creation tools 
(Ning, KickApps); 

 

Online Branding: Every business wants to be known as a brand, which is, in effect, its 
“identity” that may be represented by a name, logo, colour schemes or the tag line. But, the 
term “branding” goes much beyond just these and is in fact a culmination of the individual 
“identity” of the business, how it differs from its competitors and why a buyer should come 
to it.  

 

Online Reputation Management: “The practice of monitoring the Internet reputation of a 
person, brand or business, with the goal of suppressing negative mentions entirely, or 
pushing them lower on search engine results pages to decrease their visibility is known as 
online reputation management (ORM).”  

 

Personal Use: Individuals can use the social media for personal reasons, which may be for 
keeping in touch with the latest technology, news, gossip, and happenings around the 
world or in their own locality. In this day and age, it would be hard to find a person who 
does not use the e-mail facility to send messages to friends/colleagues and/or for official 
purposes or use the social media for collaboration.  

 

Privacy: Nowadays, the social-networking sites such as Facebook and Twitter are open for 
anyone who wants to participate. There are several networking sights like facebook, 
linkedin, WhatsApp, Fliker, Media and photograph sharing sites; where users are 
constantly uploading their contents and imags.  

 

Publish: for publishing text using blog platforms eg. WordPress, Blogger, micro-blog 
platform eg. Twitter, and collaborative publishing eg. wikis Wikipedia 

 

Reach: The Internet offers an unlimited reach to all content available. Anyone can access 
it from anywhere and anyone can reach, potentially, everyone. Social media offers the 
same facility to all the users who can share anything with anyone they like. 
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Share: for sharing your video content eg. YouTube, your photos eg. Instagram, links on 
Delicious, music eg. Spotify  ), and your documents eg. SlideShare etc. 

 

Social CRM: Social CRM is the company’s response to the customer’s control of the 
conversation. 

 

Social Interaction: Human beings love to socialize and interact with each other. The 
social media enables people to interact with each other using the highly accessible and 
scalable communication techniques that are available today, in the form of websites and 
the mobile phones using tools like facebook, WhatsApp etc. 

 

Social Media: According to the Merriam-Webster dictionary online, Social Media is 
defined as “forms of electronic communication (as Web sites for social networking and 
microblogging) through which users create online communities to share information, ideas, 
personal messages, and other content (as videos).”  

 

Social Media: According to Wikinvest, “Social media describes websites that allow users 
to share content, media, etc. Common examples are the popular social networking sites 
like Friendster, Facebook, MySpace, etc. Social media also includes YouTube, 
Photobucket, Flickr, and other sites aimed at photo and video sharing. News aggregation 
and online reference sources, examples of which are Digg and Wikipedia, are also counted 
in the social media bucket. Micro-blogging sites such as twitter can also be included as 
social media.”The web dictionary defines social media (noun) simply as, “Websites and 
applications used for social networking.” 

 

Social Media: According to Wikipedia, “Social media are media for social interaction, 
using highly accessible and scalable publishing techniques. Social media use web-based 
technologies to transform and broadcast media monologues into social media dialogues.” 
“Interactive forms of media that allow users to interact with and publish to each other, 
generally by means of the Internet.”  Alternatively it is also defined as, “Any website or 
web service that utilizes a ‘social’ or ‘Web 2.0’ philosophy. This includes blogs, social 
networks, social news, wikis, etc.”  

 

Social Network: A social network is a social structure made up of individuals (or 
organizations) which are tied (connected) by one or more specific types of 
interdependency, such as friendship, kinship, common interest, financial exchange, dislike, 
sexual relationships, or relationships of beliefs, knowledge, or prestige. 

 

Social Object:  A Social Object is some “thing” we share with others as part of our social 
media experience on the Social Web. 

 

Social Technologies: Denotes all areas of the social sphere on the Web. When people use 
the incorrect vocabulary to describe an area of the social sphere, they confuse and weaken 
the ability to discern the three areas: social relevancy, social media, and social networking. 
Once you understand the difference among these three areas, you’re better prepared to 
manage people to successfully use them. 
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Socially Facilitated Selling: Refers to a new selling model where a number of social tools 
and concepts are leveraged to create an environment that makes it easier to close deals. It 
also includes teaching the salespeople a package of social tech skills to give them an 
advantage in the marketplace. 

 

Speed: The content that you create on the social media is available to everyone in your 
network/forum/community as soon as you publish it. You can communicate with your 
audience without any external factor affecting the delivery of your message. The responses 
are also near instantaneous and thus you can have a dialogue, which is almost in real-time. 

 

Telepresence:  Refers to systems that use flat panel monitors and cameras arranged around 
a table so that the people who are remote appear to be sitting at the table. The people who 
are remote can see everyone else at the table in the same way so it’s like everyone is 
“present.” 

 

The Internet Herd (aka The Crowd): Social tech provides many ways to leverage the 
power of the scale of the Internet user base. The 1.8 billion people now online continue to 
grow quickly. They are collectively referred to as “the crowd,” or the Internet Herd.  

 

The Potential for Embarrassment: A descriptor for an idea, piece of media, or 
technology tool that grows exponentially as people share the information with their friends. 
Where that once meant a few people you might talk to that day, it now means the 
thousands of people you are connected to online directly or indirectly through your 
contacts.  

 

Time consuming campaign: Social media is not only one and done type of marketing 
method. You must constantly create new content, post content, and engage with your 
audience on these platforms. A big drawback to social media is that it is time-consuming 
for companies.  

 

Time consuming: The amount of time spent by individuals with each other online has 
risen to greater extent. This has effect on health of individuals, because spending a lot of 
time browsing these social networks can affect the way the genes operate within the human 
body, and weakens the immune and hormone levels. 

 

User Interface (UI): Every piece of software has a look and feel that the user interacts 
with on the screen. This includes the colors, font, and layout. In some cases, the UI also 
includes error handling, menu construction, and workflow. Sometimes, users are attracted 
to a newer and prettier look on the screen even if there’s no increased functionality. 

 

User-Generated Content: One of the new abilities that sites like YouTube, Scribd, 
SlideShare, and Flickr have created is an ability to create your own content (media) and 
upload it so everyone else on the Internet can view it. The result of this is that sites like 
YouTube say that the public uploads more than 20 hours of video every minute. You can 
imagine that this dramatically dwarfs the amount of content created by professional 
producers. 
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Viral: A descriptor for an idea, piece of media, or technology tool that grows 
exponentially as people share the information with their friends. Where that once meant a 
few people you might talk to that day, it now means the thousands of people you are 
connected to online directly or indirectly through your contacts. Hence this term, like a 
biological virus, suggests how the awareness of new things can grow exponentially in just 
a few days. 

 

Virtual Friends are not same as Real Friends: Through social networking, person has a 
lot of friend but the quality and integrity of these friendships is not always true. On the 
other hand, data on these social-networking sites for a person is not always 100% honest 
and reliable, and they do not verify personal details (age, location, etc.) of their members. 
While sites provide an opportunity for individuals to present a positive and accurate self-
image, there is an equal potential to abuse this openness. So, having many friends through 
social networking sites is likely to be more harmful than good. 

 

WhatsApp Web: WhatsApp now has a version for PC called WhatsApp Web, which 
consists of connecting the application platform through the browser on your own personal 
computer. The application is an extension of the mobile application that you normally use 
on your phone.  

 

Word-of Mouth / Networking: Social Media is the new Word-of-Mouth. Since people are 
all inter-connected with each other, a small mention in any of your audience’s profile goes 
a long way in spreading the word about your business/product. Let your customers become 
your marketing agents. 

 

4.10 REFERENCES/BIBLIOGRAPHY 

 

• Gail Martin (2010). 30 Days to Social Media Success. Career Press Inc., Prompton 
Plains New Jersey 

• Dan Zarrella(2010). The social Media Marketing Book. O’Reilly Media Inc. 
Gravenstein Highway North, Sebastopol, CA 

• Dunay, P. & Krueger R.(2010). Facebook Marketing for Dummies. Wiley 

Publishing, Inc. 111 River Street, Hoboken, NJ 

• Carter, B. (2013). LinkedIn for Business: How Advertisers, Marketers, and 
Salespeople Get Leads, Sales, and Profits from LinkedIn. Pearson Education, 

United States of America 

• Joel Elad (2008). LinkedIn for Dummies. Wiley Publishing, Inc. 111 River Street, 

Hoboken, NJ 

• Scott Klososky (2011).Manager’s Guide to Social Media. McGraw-Hill, New York 

• Jeffery A. Riley (2011) Social Media Directory. Pearson Education, Inc. 

• Dave Evans and Jake McKee(2010). Social Media Marketing The Next Generation 
of Business Engagement. Wiley Publishing, Inc., Indianapolis, Indiana 

 



   

Application of Computers in Hospitality and Tourism                                BHM-701BT 

Uttarakhand Open University                                        190 

• Patrice-Anne Rutledge(2010). SAMS Teach Yourself LinkedIn in 10 Minutes. 
SAMS Publishing, USA 

• Kyle Lacy(2010). Twitter Marketing For Dummies. Wiley Publishing, Inc. 111 

River Street Hoboken, NJ 

• Michael Miller(2010). SAMS Teach Yourself YouTube in 10 Minutes. Pearson 

Education, Inc. USA  

• https://www.investopedia.com/terms/s/social-media.asp 

• en.wikipedia.org/wiki/Social_media 

• webtrends.about.com/od/web20/a/web20-glossary_2.htm 

• https://www.facebook.com/help/iphone-
app/188157731232424?helpref=platform_switcher 

• https://www.facebook.com/help/223900927622502 

• https://www.linkedin.com/company/linkedin/?src=li-

ther&veh=www.linkedin.com%7Cli-other&trk=registration_footer-about 

4.11 SUGGESTED READINGS 

 

• Leon & Lion, Introduction to Computers, Vikas Publishing House, New Delhi 

• June Jamrich Parsons, Computer Concepts 7th Edition, Thomson Learning, 
Bombay. 

• Comer 4e, Computer networks and Internet, Pearson Education 

• White, Date Communications & Compute4r Network, Thomson Learning, 
Bombay. 

• Computers in Hotels – Concepts & Applications : Partho P Seal Oxford University 
Press 

4.12 TERMINAL QUESTIONS  

 
1. Write a note on ‘Merits of Social Media’. 
2. Write a note on ‘Social Media Application in Hospitality Promotion’. 
3. Write a note on ‘Social Media’. 
4. Write a note on ‘Facebook’. 
5. Define Social Media? List various social media platforms available for users. 
6. Explain each Social Media Platform in detail. 
7. What is Facebook? Explain the procedure of creating account on facebook. 
8. What is LinkedIn? Explain the procedure of creating account on LinledIn. 
9. What is microbloging? List various platforms used for microbloging. 
10. What Twitter? Explain the procedure of creating account on Twitter. 
11. What is YouTube? Explain the procedure of creating account on Youtube. 
12. What is WhatsApp? Explain the procedure of creating account on WhatsApp. 
13. Write short note on De-merits of Social Media 
14. Explain the Role of Social media in Hospitality Promotions  

 


